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1 Getting started

Welcome to MON2020—a menu-driven, Windows-based software program designed to
remotely operate and monitor the Daniel® Danalyzer™ XA series and the Rosemount®

Analytical XA series of gas chromatographs.

MON2020 operates on an IBM-compatible personal computer (PC) running the Windows
XP operating system or later.

MON2020 can initiate or control the following gas chromatograph (GC) functions:

• Alarm parameters

• Alarm and event processing

• Analog scale adjustments

• Analyses

• Baseline runs

• Calculation assignments and configurations

• Calibrations

• Component assignments and configurations

• Diagnostics

• Event sequences

• Halt operations

• Stream assignments and sequences

• Valve activations

• Timing adjustments

MON2020 can generate the following reports:

• 24-Hour Averages

• Analysis (GPA)

• Analysis (ISO)

• Calibration

• Final Calibration

• Validation

• Final Validation

• Hourly Averages

• Monthly Averages

• GC Configuration

• Raw Data

• Variable Averages

• Weekly Averages
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• Dew Temperature Calculation (optional)

MON2020 can access and display the following GC-generated logs:

• Alarm Log

• Event Log

• Parameter List

• Maintenance Log

1.1 MON2000 and MON2020
Users familiar with MON2000 or MON2000 Plus will find a few changes when using
MON2020:

• Login security is at the gas chromatograph level instead of at the software level. This
means that you no longer have to log in after starting MON2020—but you do have
to log in to the gas chromatograph to which you are trying to connect. For more
information, see Section 1.2.12.

• An “administrator” role has been added to the list of user roles. This new role has the
highest level of authority and is the only role that can create or delete all other roles.
For more information, see Section 7.3.

• Multiple users can connect to the same gas chromatograph simultaneously. By
default, the first user to log in to the GC with “supervisor” authority will have read/
write access; all other users, including other supervisor-level users, will have read
access only. This configuration can be changed so that all supervisor-level users have
read/write access regardless of who logs in first. For more information, see 
Section 4.1.

• Users can display multiple windows within MON2020.

• Automatic re-connection. If MON2020 loses its connection with the GC, it
automatically attempts to reconnect.

• Users can view multiple instances of certain windows. To aid in data processing or
troubleshooting, MON2020 is capable of displaying more than one instance of
certain data-heavy windows such as the Chromatogram Viewer and the Trend Data
window.

• Enhanced Chromatogram Viewer. The following enhancements have been made to
the Chromatogram Viewer:

- Users can view an unlimited number of chromatograms, in any configuration. For
example, a user can view an archived chromatogram and a live chromatogram.
For more information, see Section 2.1.

- The “Keep Last CGM” option. Upon starting a new run, MON2020 can keep the
most recently completed chromatogram on the graph for reference.

- Overview window. When zoomed in to a smaller section of a chromatogram, the
user can open a miniature ‘overview’ window that displays the entire
chromatogram, for reference. For more information, see Section 2.3.2.
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- Older chromatograms available. MON2020 has access to archived
chromatograms as old as four or five days. For more information, see 
Section 2.1.3.

- Full screen mode. For more information, see Section 2.2.

- Protected chromatograms. Chromatograms that you designate as “protected”
will not be deleted. For more information, see Section 2.1.4.

• The “Invert Polarity “option. This feature reverses a device’s effect. For more
information, see Section 3.2.4 and Section 3.5.4.

• Streamlined variables-picking menu. The method for selecting variables for
calculations and other purposes is contained within one simple, self-contained
menu. For more information, see Section 1.11.

• GC Time. The GC Status Bar displays the date and time based on the GC’s physical
location, which may be different than the PC’s location. For more information, see 
Section 2.6.

• Daylight savings time. You have option of enabling a GC’s daylight savings time
feature. Also, there are two options for setting the start and end times for daylight
savings time on the GC. For more information, see Section 2.6.1.

• Baseline offsetting. In some situations that involve TCD detectors the baseline may
be displayed either too high on the graph, in which case the tops of the peaks are
cut off, or too low on the graph, so that the bases of the peaks are cut off. If this
occurs it is possible to offset the baseline either up or down so that the entire peak
can be displayed on the graph. This offset will be applied to all traces—live, archived
and saved—that are displayed thereafter. For more information, see Section 2.5.7.

• Microsoft Excel-based Parameter List. The Parameter List has been expanded to offer
seven pages of information, and is Microsoft® Excel-based to allow for access
outside of MON2020. The document can be imported to and exported from GCs.
For more information, see Section 5.3.

• Optional FOUNDATION fieldbus variables. If your GC is installed with a Foundation
fieldbus, you can map up to 64 GC variables to monitor using the AMS Suite. For
more information, see Section 4.14.

• Optional local operator interface (LOI) variables. If your GC is installed with an LOI,
you can configure up to 25 GC parameters to monitor using the LOI’s Display mode.
For more information, see Section 4.13.

• Access to GC-related drawings such as flow diagrams, assembly drawings, and
electrical diagrams.

• Validation runs. During a validation run, the GC performs a test analysis to verify that
it is working properly. For more information, see Section 4.4 and Section 6.4.

1.2 Getting started with MON2020
This section covers such issues as installing, registering and setting up the software, as well
as configuring MON2020 to meet your specific needs.
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1.2.1 System requirements
To achieve maximum performance when running MON2020, ensure your PC meets the
following specifications:

Compatible
operating systems

Windows® XP (Service Pack 2 or later), Windows® Vista, or
Windows® 7.

Compatible
browser

Internet Explorer® 6.0 or later.

Minimum
hardware
specifications

A PC with a 400 MHz Pentium or higher processor.
At least 256 MB of RAM.
At least 100 MB of available hard disk space. On Windows XP, if NET
2.0 is not installed, an additional 280 MB of hard disk space will be
needed.
A Super VGA monitor with at least 1024 x 768 resolution.
One Ethernet port for connecting remotely or locally to the gas
chromatograph.

1.2.2 Install MON2020
You must install MON2020 from the CD-ROM onto your hard drive; you cannot run the
program from the CD-ROM.

Double-click the Setup file and follow the on-screen installation instructions.

Upon successful installation, MON2020 creates a shortcut icon on the computer’s
desktop.

Note
MON2020 is not an upgrade to MON2000; therefore, MON2020 should be installed to its own
directory, separate from the MON2000 directory.

Note
You must be logged onto the computer as an administrator to install MON2020. Windows® Vista
and Windows® 7 users, even with administrator privileges, will be prompted by the operating
system’s User Account Control feature to allow or cancel the installation.

1.2.3 Start MON2020
To launch MON2020, double-click its desktop icon or click the Start button and select
Emerson Process Management → MON2020.

1.2.4 Register MON2020
Each time you start MON2020 it will prompt you to register if you have not already done
so. You can also register by selecting Register MON2020... from the Help menu.
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Registering your copy of MON2020 allows you to receive information about free updates
and related products.

1. Complete the appropriate fields on the Register MON2020 window.

Note
The software's serial number is located on the back of its CD case.

2. Click Next to continue.

3. Choose the desired registration method by clicking the corresponding checkbox.

4. Click Finish.

1.2.5 Set up the data folder
The data folder stores GC-specific files such as reports and chromatograms. The default
location for the data folder is C:\Users\user_account_name\Documents\GCXA Data. If
you want MON2020 to store its data in a different location—on a network drive, for
instance—do the following:

1. Move the data folder to its new location.

2. Select Program Settings... from the File menu.

3. The current location of the data folder displays in the Data Folder field.

To change the data folder’s location, click on the Browse button that is located to
the right of the Data Folder field.

4. Use the Browse for Folder window to navigate to the GCXP Data folder’s new location
and click OK.

Note
Another method for changing the folder location is to type the folder’s location into the Data
Folder field and press ENTER. When the “Create the folder?” message appears, click Yes.

5. The Data Folder field updates to display the new location.

1.2.6 Set up MON2020 to connect to a gas chromatograph
To configure MON2020 to connect to a GC, do the following:

1. Select GC Directory... from the File menu.

If this is the first time that this option was selected, you will get the following error
message:
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“GC directory file not found” messageFigure 1-1:   

If you get the “GC directory file not found” message, click OK. The GC Directory
window appears and displays a table containing an inventory of the GCs to which
MON2020 can connect.

2. If you are configuring the first GC connection for MON2020, there will be only one
generic GC record listed in the window. To add another record, select Add from the
GC Directory window’s File menu. A new row will be added to the bottom of the
table.

3. Click in the GC Name field and enter the name for the GC to which you want to
connect.

4. Optionally, you can click in the Short Desc field and enter pertinent information
about the GC to which you want to connect, such as its location. You can enter up to
100 characters in this field.

5. Click Ethernet. The Ethernet Connection Properties for New GC window appears.

6. In the IP address field, enter the IP address of the GC to which you want to connect.

Note
The default address for the GC's RJ-45 port in DHCP mode is 192.168.135.100.

Note
If you type in an invalid IP address, you will get an error message when MON2020 attempts to
connect to the GC.

7. Click OK. When the Save changes? message appears, click Yes.

8. Repeat steps 2 through 7 for any other GCs to which you want to connect.

9. To delete a GC from the table, select the GC and then select Delete from the File
menu.

10. To copy a GC's configuration information into a new row, select the row to be copied
and then select Insert Duplicate from the File menu.

11. To insert a row below a GC, select the GC and then select Insert from the File menu.

12. To sort the table alphabetically, select Sort from the Table menu or click Sort from
the GC Directory window.

13. To copy the list of GCs to the clipboard to be pasted into another application, select
Copy Table to Clipboard from the Table menu.
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14. To print the list of GCs, select Print Table... from the Table menu.

15. To save the changes and keep the window open click Save from the GC Directory
window. To save the changes and close the window, click OK. When the Save
changes? message appears, click Yes.

For more details about configuring MON2020 connections, see Section 4.12.

1.2.7 Export a GC directory
The GC Directory, which contains the list of networked GCs that are currently configured for
your copy of MON2020, can be saved as a DAT file to a PC or other storage media such as a
compact disk or flash drive.

To save the GC Directory to the PC, do the following:

1. Click Export.

The Export GC Directory window displays.

2. Select the checkbox for each gas chromatograph whose information you want to
save.

Note
If you want to save the entire list, click Select All.

3. Click OK.

The Export GC Directory File save as dialog displays.

4. Choose a save location.

The default location is C:\Users\user_account_name\Documents\GCXA Data.

Note
The file is automatically given the name of GC_DIRECTORY_EXPORT.DAT. If you prefer a
different name, type it into the File name field.

5. Click Save.

1.2.8 Import a GC Directory file
A GC Directory file can be used to restore GC directory information to your copy of
MON2020, or it can be used to quickly and easily supply other copies of MON2020 that are
installed on other computers with the profiles of the GCs that are in your network.

To import a GC Directory file, do the following:

1. Select GC Directory... from the File menu.

If this is the first time that this option was selected, you will get the following error
message:
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“GC directory file not found” messageFigure 1-2:   

If you get the “GC directory file not found” message, click OK. The GC Directory
window appears

2. Click Import.

The Import GC Directory File dialog displays.

3. Locate the GC directory file and select it.

4. Click Open.

The newly configured GC Directory window reappears with the list of networked GCs
displayed in the GC Directory table.

1.2.9 Launch MON2020 from the SNAP-ON for DeltaV
This section assumes that DeltaV is installed on the PC along with MON2020.

Note
To successfully use MON2020 SNAP-ON for DeltaV, you must be familiar with using the DeltaV
digital automation system.

To start MON2020, do the following:

1. Start the DeltaV Explorer by clicking on its desktop icon or by clicking the Start
button and selecting DeltaV → Engineering → DeltaV Explorer.

2. In the Device Connection View, open device icons by clicking once on each icon.
Follow the path of connections until you locate the desired gas chromatograph icon.

3. Right-click on a connected gas chromatograph icon to display the context menu.

4. Select SNAP-ON/Linked Apps → Launch MON2020.

MON2020 starts and connects automatically to the GC.

1.2.10 Launch MON2020 from the AMS Device Manager
This section assumes that DeltaV and AMS are installed on the PC along with MON2020.

To start MON2020, do the following:
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1. Start the AMS Device Manager by clicking on its desktop icon or by clicking the Start
button and selecting AMS Device Manager → AMS Device Manager.

2. In the Device Connection View, open device icons by clicking once on each icon.
Follow the path of connections until you locate the desired gas chromatograph icon.

3. Right-click on a connected gas chromatograph icon to display the context menu.

4. Select SNAP-ON/Linked Apps → Launch MON2020.

MON2020 starts and connects automatically to the GC.

1.2.11 The MON2020 user interface
MON2020 has two areas of interaction: the Control Area, at the top of the program’s main
window, and the GC Status Bar, located at the bottom of the program’s main window.

The MON2020 windowFigure 1-3:   

A. Control Area
B. GC Status Bar

The main user interface

The main user interface of the main window contains the menus and icons that allow you
to control MON2020 and the GC to which MON2020 is connected.
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The Control AreaFigure 1-4:   

A. Title bar
B. Toolbar
C. Menu bar
D. Dialog Control Tabs

• Title bar - The Title bar displays the name of the program, as well as the program’s
connection status. MON2020 has the following three overall status modes:

- Not connected - If MON2020 is not connected to a GC, then “MON2020”
displays in the Title bar.

- Connected - If MON2020 is connected to a GC, then “MON2020 - Connected to”
and the name of the GC and the connection type displays in the Title bar.

- Offline Edit - If MON2020 is in offline edit mode, then “MON2020 - Offline Edit
<filename>” displays in the Title bar.

• Menu bar - The Menu bar contains the commands that allow you to control and
monitor gas chromatographs.

• Toolbar - The Toolbar contains shortcut icons for the most important and/or most
often used MON2020 commands. From the Toolbar you can do such things as
connect to and disconnect from a GC, view chromatographs, and view help files.

Connect to a gas chromatograph.

Disconnect from a gas chromatograph.

Open a configuration file.

Print a GC configuration report.

View the Timed Events window.

View the Component Data window.

Clear or acknowledge alarms.

Open the CGM Viewer window.
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Begin auto sequencing.

Halt auto sequencing.

Open the About MON2020 window.

• Dialog Control Tabs bar - The Dialog Control Tabs bar contains four buttons that
allow you to manage the behavior of all windows that are open in the main window.
The four buttons are Minimize All, Maximize All, Restore All, and Close All. The
bar also displays a button for each open window that allows you to select or deselect
that window.

You can hide or display the Toolbar and the Dialog Control Tabs bar by clicking the
appropriate option from the View menu.

The GC Status Bar

The GC Status Bar of the main window displays useful information about the status and
functioning of the gas chromatograph to which MON2020 is connected.

The GC Status Bar contains the following sections:

GC The first row displays the name of the GC to which MON2020 is connected.
If MON2020 is not connected to a GC, “Not Connected” displays in this
row. If MON2020 loses its connection to the GC, “Comm Fail” displays in
this row, and the program will automatically try to reconnect. The second
row displays status flags such as active alarms (with red background),
unacknowledged alarms (with yellow background), or File Edit modes.

Det # A GC can have a maximum of two detectors.

Mode Potential modes are: Idle, Warmstart Mode, Manual Anly, Manual Cal,
Manual Validation, Auto Anly, Auto Cal, Auto Validation, Auto Valve
Timing, Module Validation, CV Check, Manual Purge, Auto Purge, and
Actuation Purge.

Stream The current stream being analyzed.

Next The next stream to be analyzed.

Anly The analysis time.

Cycle The total cycle time, in seconds, between successive analyses.

Run The amount of time, in seconds, that has elapsed since the current cycle
began.

GC System Displays the date and time according to the GC to which MON2020 is
connected. The date and time displayed may be different from the user’s
date and time, depending on the physical location of the GC.
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FID Flame
Status

Displays the status of the FID flame. Options are OFF with red background,
ON with green background, and OVER TEMP with red background. The FID
Flame Status indicator only displays on the GC Status Bar when the GC to
which MON2020 is connected has an FID detector.

You can hide or display the GC Status Bar by clicking GC Status Bar from the View menu.

1.2.12 Connect to a gas chromatograph
Before connecting to a GC you must create a profile for the it on MON2020. See 
Section 1.2.6 to learn how to do this.

Also, to connect to a gas chromatograph you must log on to it first. Most of MON2020’s
menus and options are inactive until you have logged on to a GC.

To connect to a GC, do the following:

1. There are two ways to start the process:

a.

On the Toolbar, click .

b. Select Connect... from the Chromatograph menu.

The Connect to GC dialog, which displays a list of all the GCs to which you can
connect, appears.

Note
If you want to edit the connection parameters for one or all GCs listed in the Connect to GC
window, click Edit Directory. The GC Directory window will appear. See Section 1.2.6 for more
information.

2. Click the Ethernet button beside the GC to which you want to connect.

The Login dialog appears.

3. Enter a user name and user PIN and click OK.

Once connected, the name of the GC appears under the GC column in the GC Status
Bar.

Note
All GCs are shipped with a default user name: emerson. A user password is not required when
using this administrator-level user name. To add a user password to either of these user
names or for information about creating and edit user names in general, see Section 7.3.

Note
If you enter an invalid user name or password, the Login dialog will close without connecting
to the GC.
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1.2.13 Disconnect from a gas chromatograph
Disconnecting from a GC will automatically log you off of the GC.

To disconnect from a gas chromatograph, do one of the following:

•
On the Toolbar, click .

• Select Disconnect from the Chromatograph menu.

Note
If you are connected to a GC and want to connect to a different GC, it is not necessary to disconnect
first; simply connect to the second GC, and in the process MON2020 will disconnect from the first
GC.

1.3 Keyboard commands
You can use the following keyboard keystrokes throughout the program:

Arrow
keys

Moves cursor:

• Left or right in a data field.

• Up or down in a menu or combo box.

• Up or down (column), left or right (row) through displayed data
entries.

Delete • Deletes the character after cursor.

• Deletes selected rows from a table or return row values to the default
settings.

Enter Activates the default control element (e.g., the OK button) in current
window.

Esc Exits application or active window without saving data.

F1 Accesses context-sensitive help topics.

Insert • Toggles between insert and type-over mode in selected cell.

• Inserts a new row above the highlighted row.

Tab Moves to the next control element (e.g., button) in the window; to use Tab
key to move to next data field, select Program Settings... from the File
menu and clear the Tab from spreadsheet to next control check box.

Shift+Tab Moves to previous control element (e.g., button) or data field in window;
see Tab description.

Space Toggles settings (via radio buttons or check boxes).

You can use the following function keys from the main window:

F2 Starts the Auto-Sequencing function. See Section 6.1 for more information.
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F3 Halts the GC (e.g., an analysis run) at the end of the current cycle. See Section 6.1 for
more information.

F5 Displays the Timed Events table per specified stream. See Section 4.3 for more
information.

F6 Displays the Component Data table per specified stream. See Section 4.2 for more
information.

F7 Displays the chromatogram for the sample stream being analyzed. See Section 2.1.2
for more information.

F8 Displays any chromatogram stored in the GC Controller. See Section 2.1.3 for more
information.

1.4 Procedures guide
Use the following table to look up the related manual section, menu path and, if
appropriate, the keystroke for a given procedure.

MON2020 Task ListTable 1-1:   

Task or Data Item Section(s) Menu Path [Keystroke]

24-hour average, component(s)
measured

Section 4.5.2 Application → Calculations → Aver-
ages...

Add a gas chromatograph Section 1.2.6 File → GC Directory

Alarms, related components Section 4.2

Section 4.7

Section 3.5

Application → Component Data...
[F6]

Application → Limit Alarms → User...

Hardware → Discrete Outputs...

Alarms, stream number(s) pro-
grammed

Section 4.7 Application → Limit Alarms → User...

Analysis Report (on/off) Section 5.7.3 Logs/Reports → Printer Control...

Analysis time Section 4.3.4 Application → Timed Events... [F5]

Starting or ending auto-calibra-
tion

Section 4.9 Application → Streams...

Auto-calibration interval Section 4.9 Application → Streams...

Auto-calibration start time Section 4.9 Application → Streams...

Autocal time Section 4.9 Application → Streams...

Baseline Section 4.9 Application → Streams...

Base pressure used for calcula-
tions

Section 4.9 Application → Streams...

Calibration concentration Section 4.2 Application → Component Data...
[F6]

Calibration cycle time Section 4.3.4 Application → Timed Events... [F5]
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MON2020 Task List (continued)Table 1-1:   

Task or Data Item Section(s) Menu Path [Keystroke]

Calibration runs, number aver-
aged

Section 4.9 Application → Streams...

Calibration runs, number of Section 4.9 Application → Streams...

Calibration stream number Section 4.9 Application → Streams...

Change the default C6+ mixture
ratio

Section 4.2.6 Application → Compnent Data Ta-
ble...

Communications Section 4.11 Application → Communication...

Application → Ethernet Ports...

Component code and name Section 4.2 Application → Component Data...
[F6]

Component full scale (for output) Section 4.1

Section 3.7

Application → System...

Hardware → Analog Outputs...

Component(s) programmed for
input

Section 3.6

Section 3.4

Application → Analog Inputs...

Application → Discrete Inputs...

Component(s) programmed for
output

Section 4.7

Section 3.7

Section 3.5

Application → Limit Alarms → User...

Hardware → Analog Outputs...

Hardware → Discrete Outputs...

Component, retention time Section 4.2 Application → Component Data...
[F6]

Component zero (for output) Section 3.7 Hardware → Analog Outputs...

Compressibility (on/off) Section 4.5.1 Application → Calculations → Con-
trol...

Configure the valve timing Section 6.5 Control → Auto Valve Timing...

Current date Section 2.6 Chromatograph → View/Set GC
Time...

Current time Section 2.6 Chromatograph → View/Set GC
Time...

Cycle time Section 4.3.4 Application → Timed Events... [F5]

Delete alarms Section 4.7

Section 5.1

Application → Limit Alarms...

Logs/Reports → Alarms → Alarm
Log...

Delete component from compo-
nent list

Section 4.2 Application → Component Data...
[F6]

Delete inhibit, integration, peak
width

Section 4.2 Application → Timed Events... [F5]

Delete output(s) Section 3.7

Section 3.5

Hardware → Analog Outputs...

Hardware → Discrete Outputs...

Enable or disable multi-user write Section 4.1 Application → System...

Existing alarm(s) Section 5.1 Logs/Reports → Alarms → Alarm
Log...
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MON2020 Task List (continued)Table 1-1:   

Task or Data Item Section(s) Menu Path [Keystroke]

Full-scale value (for input) Section 3.6 Hardware → Analog Inputs...

Generate a repeatability certifi-
cate

Section 5.12 Logs/Reports → Repeatability Certif-
icate...

GPM liquid equivalent (on/off) Section 4.5.1 Application → Calculations → Con-
trol...

Height or area measurement
method

Section 4.2 Application → Component Data...
[F6]

High alarm Section 4.7 Application → Limit Alarms → User...

(Analyzer) I.D. Section 4.1 Application → System...

Inhibit on-off times Section 4.3.4 Application → Timed Events... [F5]

Input(s) being used Section 3.6

Section 3.4

Hardware → Analog Inputs...

Hardware → Discrete Inputs...

Integration on-off times Section 4.3.4 Application → Timed Events... [F5]

Low alarm Section 4.7 Application → Limit Alarms → User...

Manage the GC's pressure Section 3.3 Hardware → EPC...

Mole percent (on/off) Section 4.5.1 Application → Calculations → Con-
trol...

Normalization (on/off) Section 4.5.1 Application → Calculations → Con-
trol...

Outputs being used Section 4.7

Section 3.7

Section 3.5

Application → Limit Alarms → User...

Hardware → Analog Outputs...

Hardware → Discrete Outputs...

Peak width, on time Section 4.3.4 Application → Timed Events... [F5]

Relative density (on/off) Section 4.5.1 Application → Calculations → Con-
trol...

Response factor Section 4.2 Application → Component Data...
[F6]

Response factor, percent devia-
tion

Section 4.2 Application → Component Data...
[F6]

Retention time, percent deviation Section 4.2 Application → Component Data...
[F6]

Spectrum gain Section 4.3.3 Application → Timed Events... [F5]

Stream number(s) (for output) Section 4.7

Section 3.7

Section 3.5

Application → Limit Alarms → User...

Hardware → Analog Outputs...

Hardware → Discrete Outputs...

Stream sequences skipped, num-
ber

Section 4.1

Section 4.9

Application → System...

Application → Streams...

Streams analyzed, number Section 4.1

Section 4.9

Application → System...

Application → Streams...
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MON2020 Task List (continued)Table 1-1:   

Task or Data Item Section(s) Menu Path [Keystroke]

Streams analyzed, sequence Section 4.1

Section 4.9

Application → System...

Application → Streams...

Valve on/off times Section 4.3.1 Application → Timed Events... [F5]

Weight percent (on/off) Section 4.5.1 Application → Calculations → Con-
trol...

Wobbe value (on/off) Section 4.5.1 Application → Calculations → Con-
trol...

Zero value (for input) Section 3.6 Hardware → Analog Inputs...

1.5 Configuration files
Use the File menu to edit, save, and restore configuration files.

1.5.1 Edit a configuration file
To edit a configuration file, do the following:

1. Disconnect from the GC.

2. Select Open Configuration File... from the File menu.

The Open dialog displays. Configuration files are saved with the .xcfg extension.

3. Locate and select the configuration file that you want to edit and click Open.

MON2020 opens the file in offline edit mode.

4. Use the Application and Hardware menu commands to edit the configuration file.
For more information on these commands, see Chapter 3 and Chapter 4.

5.
When finished editing the configuration file, click  to save the changes to the
configuration file and to leave offline edit mode.

1.5.2 Save the current configuration
Configuration files are saved with the .xcfg extension. To save a GC’s current configuration
to a PC, do the following:

1. Select Save Configuration (to PC)... from the File menu.

The Save as dialog displays.

2. Give the file a descriptive name or use the pre-generated file name and navigate to
the folder to which you want to save the file.
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3. Click Save.

1.5.3 Import a configuration file

CAUTION!

The current configuration will be overwritten, so be sure to save it before importing a new or
previous configuration. See Section 1.5.2 to learn how to save a configuration.

CAUTION!

The GC must be in Idle mode while performing this task.

To import a configuration into a GC, do the following:

1. Select Restore Configuration (to GC)... from the File menu.

The Open dialog displays. Configuration files are saved with the .xcfg extension.

2. Locate and select the configuration file that you want to import and click Open.

The file’s data is loaded into the GC.

1.5.4 Restore the GC's factory settings
The GC’s default timed event, component data and validation data tables are created at
the factory and are not accessible by users. To restore these tables to their default values,
do the following:

CAUTION!

The GC must be in Idle mode while performing this task.

1. Select Restore to Factory Settings... from the File menu.

The following warning message displays:

Restore to Factory Settings warning messageFigure 1-5:   
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2. Click Yes.

MON2020 restores the default values to the GC’s data tables. When the process is
completed, a confirmation message displays.

3. Click OK.

1.6 Configure your printer
Select Print Setup... from the File menu to configure the settings for the printer
connected to your PC. These settings will apply to any print job queued from MON2020,
such as the reports that are configured by the Printer Control. See Section 5.7.3 for
information.

The settings available depend on the printer model. Refer to the printer manufacture’s
user manual for more information.

Note
Your new configuration will be cleared, i.e., the settings will return to the default values, when you
exit MON2020.

1.7 Online help
Currently, the online help feature contains all user information and instructions for each
MON2020 function as well as the MON2020 system.

To access the online help, do one of the following:

• Press F1 to view help topics related to the currently active dialog or function.

• Select Help Topics from the Help menu to view the help contents dialog.

1.8 Operating modes for MON2020
The GC supports two different operating modes. Each mode allows the GC to analyze data
from a given number of detectors, streams, and methods, as detailed in below.

Operating Modes for MON2020Table 1-2:   

Mode ID Number Detectors Supported Streams Supported Methods Supported

0 1 1 1

1 2 1 1
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1.9 The Physical Name column
Most MON2020 hardware windows, such as the analog inputs or the valves, contain a
hidden column called Physical Name that lists the default name of the associated GC
device. It might be useful to know a device’s physical name while troubleshooting.

To view the hidden column, do the following:

1. Select Program Settings... from the File menu.

The Program Settings window displays.

2. Select the Show Physical Names checkbox.

3. Click OK.

The Physical Name column now will be visible on all windows that have the column,
such as the Heater window or the Valves window.

1.10 Select the GC’s networking protocol
MON2020 can connect to the GC using one of two networking protocols: PPP or SLIP. If the
version level of the GC’s firmware is 1.2 or lower, MON2020 should be configured to use
the SLIP protocol; otherwise, the PPP protocol should be used.

To select the GC’s networking protocol, do the following:

1. Select Program Settings... from the File menu.

The Program Settings window displays.

2. To use the PPP protocol, make sure the Use PPP protocol for serial connection (use SLIP
if unchecked) checkbox is selected; to use the SLIP protocol, make sure the Use PPP
protocol for serial connection (use SLIP if unchecked) checkbox is not selected.

3. Click OK.

1.11 The context-sensitive variable selector
The MON2020 method for selecting variables for calculations and other purposes is based
on a simple, self-contained system.
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Example of a context-sensitive variable selectorFigure 1-6:   

The context-sensitive variable selector consists of a first-level element, called the context
element, that is followed by a series of tiered, drop-down lists. The options available from
the drop-down lists depend upon the context element.

The following example explains how to use the context-sensitive variable selector to select
a user alarm variable:

1. Click on the second-level drop-down list.

The full list of available streams displays.

2. Select the stream you want to use for the alarm.

3. Click the third-level drop-down list.

The full list of available user alarm variables displays.

4. Select the variable you want to use for the alarm.

If there are components associated with the variable, the fourth-level drop-down
list will display.

5. If displayed, click the fourth-level drop-down list.

The full list of available components displays.

6. Select the component you want to use for the alarm.

7. Click [Done].

The context-sensitive variable selector closes and the variable displays in the Variable
field.
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2 Chromatograph

When it comes to viewing and managing chromatograms, MON2020 is flexible and
straightforward. This chapter shows you how to access the Chromatogram Viewer, as well
as how to use the viewer to display, print, and manipulate live, archived, or saved
chromatograms. There is no limit to the number of archived and saved chromatograms
that can be displayed at once. The Chromatogram Viewer can display all three types of
chromatograms together, alone, or in any combination.

The Chromatogram ViewerFigure 2-1:   

A. Chromatogram window
B. Time events table
C. Component data table

A chromatogram displays in the chromatogram window. If the chromatogram contains one
trace, the Det1 checkbox is automatically checked; if the chromatogram contains two
traces, the Det1 and Det2 checkboxes are automatically checked. To remove a trace,
uncheck its detector checkbox.

Each trace that displays is color-coded; use the Chromatogram pull-down menu to select a
specific trace.
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Chromatogram pull-down menuFigure 2-2:   

The list of GC events associated with the production of the chromatogram, along with
each event’s status and time, displays in the Timed Events table to the right of the
chromatogram display window. The Component Data table, to the lower right of the
chromatogram display window, lists the components measured during the analysis. These
tables are updated in real-time, just as the chromatogram is.

Note
By default, the timed events and component data tables are configured to scroll to and highlight the
next occurring event in the analysis cycle. To disable this feature, right-click on one of the tables and
uncheck the Auto Scroll option on the pop-up menu.

2.1 The Chromatogram Viewer
Use the Chromatogram Viewer to display and print live, archived, or saved
chromatograms. There is no limit to the number of archived and saved chromatograms
that can be displayed at once; however, to maximize performance, the number of
chromatograms displayed should be limited to 25 or less. The Chromatogram Viewer can
display all three types of chromatograms together, alone, or in any combination.

The Chromatogram Viewer contains a host of information about both current and past GC
analyses, and it contains just as many ways of editing and manipulating that data.

Chromatograph
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2.1.1 Data displayed in the chromatogram window

The chromatogram windowFigure 2-3:   

A. Retention time
B. Peak detection marker
C. Timed event marker

The following elements are displayed in the chromatogram window:

The
chromatogram

A trace is the graphical representation of the detector output from a
single detector; a chromatogram is the collection of all traces and
associated data that are generated by a gas chromatograph’s
detector or detectors. Each trace displays in a different color.

Retention times The retention time, which displays above each component's peak,
is the time that elapses between the start of an analysis and the
sensing of the maximum concentration of that component by the
detector.

Baselines The baseline extends from the beginning to the end of a peak. You
can turn the baseline on or off by clicking Baselines.

Timed event
markers

These markers, which correspond to events from the Timed Events
table, display on the chromatogram as black vertical lines below the
trace-line. There are three types of timed event markers:

• Valve events display as long vertical lines.

• Integration events display as medium vertical lines.
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• Spectrum gain events display as short vertical lines.

Peak detection
markers

These markers display on the chromatogram as black vertical lines
above the trace-line. Each peak has two peak detection markers:
one at its beginning and one at its end.

2.1.2 Display a live chromatogram
To view a live chromatogram, do the following:

1. Connect to the GC.

2. Select Chromatogram Viewer... from the Chromatograph menu.

Note

Another way to display the Chromatogram Viewer is to click , which is located on the
Toolbar.

3. From the Chromatogram Viewer window, select the View current CGM check box.

2.1.3 Display an archived chromatogram
Archived chromatograms are stored on the GC, so you must be logged in to access them.

Archived chromatograms are sorted and displayed on four tabbed panes:

Chromatograms This view displays all chromatogram types sorted by time so that
the newest file is always listed first. This view can be further
configured to display only the files from the last five runs for each
stream, or to display all the files that are stored on the GC.

Protected
chromatograms

Protected chromatograms are never deleted from the GC. To
protect a chromatogram, see Section 2.1.4.

Note

Protected chromatogram files have a “lock” icon ( ) displayed beside
them.

Final Calibration
chromatograms

As long as there is space, MON2020 will store all final calibration
chromatograms; once space runs out, MON2020 will delete the
oldest non-protected final calibration chromatogram for each new
final calibration chromatogram that is created. If multiple final
calibration chromatograms are created on the same day, the last
chromatogram created is archived, unless MON2020 has been
configured to archive all final calibration chromatograms.
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Note
See Section 4.1 to learn how to configure MON2020’s archiving behavior.

Final Validation
chromatograms

These chromatograms are treated in the same manner as final
calibration chromatogram files.

-

To view one or more archived chromatograms, do the following:

1. Click GC Archive.

The Select archive file(s) window appears. The files can be sorted by date, file name,
analysis type, time, or stream number by clicking the appropriate column header. By
default, they are sorted by date, with the newest file listed first.

Note
By default, only recent chromatograms—that is, the last five runs for each stream—are
displayed. To view all archived chromatograms, click All. To return to viewing only recent
chromatograms, click Recent.

2. Select one or more archive files by clicking them.

Use the SHIFT and CTRL keys to make multiple selections.

Note
To save the selected files to the PC without displaying them first, select the Download and
save selected chromatograms check box and click Download & Save.

3. Click Download & Show.

The Select window displays for each chromatogram that contains data from more
than one detector.

The Select windowFigure 2-4:   

4. For each chromatogram, double-click either “Detector 1”, “Detector 2”, or “Both”
from the Select window.

MON2020 plots the archived chromatogram(s) and the corresponding data displays
in the timed event and component data tables.
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2.1.4 Protected chromatograms
By default, archived chromatograms are not saved indefinitely. Once the GC’s storage
capacity for archived chromatograms has been reached, the oldest archived
chromatograms are deleted to make room for the newest archived chromatograms.

If you have a chromatogram that you would like to preserve, it is possible to "protect" it.
Protected chromatograms will not be deleted to accommodate newer chromatograms. To
delete a protected chromatogram, it must first be unprotected. See 
Unprotect a protected chromatogramfor more information. MON2020 will save up to 100
protected chromatograms.

Note

Protected chromatograms have a “lock” icon ( ) displayed beside them.

Note
To protect an archived chromatogram you must be logged in as a supervisor or administrator.
To protect a chromatogram, do the following:

1. Click GC Archive.

The Select Archive File(s) window appears. The chromatograms can be sorted by
date, file name, analysis type, time, or stream number by clicking the appropriate
column header. By default, they are sorted by date, with the newest chromatogram
listed first.

Note
By default, only recent chromatograms—that is, the last five runs for each stream—are
displayed. To view all archived chromatograms, click All. To return to viewing only recent
chromatograms, click Recent.

2. Make sure the Chromatogram tab is selected and then select the appropriate
archived chromatogram by clicking it. Use the SHIFT or CTRL key to make multiple
selections.

3. Click Protect.

The Edit Description window displays.

4. Enter any information that you would like to have associated with the
chromatogram and then click OK. If you do not want to enter any information, click
Cancel.

MON2020 will place a “lock” icon ( ) beside the selected chromatogram to verify
its protected status. You can also click on the Protected Chromatograms tab to view
your newly protected archived chromatogram.
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2.1.5 Display a saved chromatogram
To view a chromatogram that was saved to disk, do the following:

1. Click PC File.

The Open dialog appears.

2. Navigate to the desired .xcgm file or .xcmp comparison file and select it.

To make multiple selections, use the SHIFT or CTRL key.

3. Click OK.

The Select window displays for each chromatogram that contains data for more than
one detector.

The Select windowFigure 2-5:   

4. For each chromatogram, double-click either “Detector 1”, “Detector 2”, or “Both”
from the Select window.

MON2020 plots the archived chromatogram(s) and the corresponding data displays
in the timed event and component data tables.

2.2 Options for displaying chromatograms
Right-clicking on the graph brings up the following commands:

Command Name Shortcut Description

Zoom In “+” (NUMPAD) Zooms in on the entire graph.

Note: Another way to zoom in is by clicking and dragging your mouse to select
the region of the graph that you want to zoom in on.

Zoom Out “-” (NUMPAD) Zooms out from the entire graph.

Zoom X In “6” (NUMPAD) Zooms in on the X axis.

Zoom X Out “4” (NUMPAD) Zooms out from the X axis.

Zoom Y In “8” (NUMPAD) Zooms in on the Y axis.

Zoom Y Out “2” (NUMPAD) Zooms out from the Y axis.
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Command Name Shortcut Description

Save State CTRL + HOME Saves current or archived display settings for the selected chromatogram.

Note: The Save State function is available only when viewing a live or archived
chromatogram.

Restore State HOME Restores the last saved display settings for the selected chromatogram.

Note: Pressing HOME returns the user to the saved state.

Toggle Full Screen F11 Toggles the display of the Chromatogram Viewer’s tables and buttons and
maximizes the chromatogram window.

Cursor to Nearest
Point

F8 Snaps the cursor to the nearest point on the chromatograph in both the X and
Y directions.

Toggle Coarse/Fine
Cursor

F4 Toggles the cursor from coarse and less accurate to fine and more accurate.

Toggle Lines/Dots
Displays

F9 Toggles the chromatographs from lines to dots, or dots to lines.

Toggle Mouse Posi-
tion Tip

CTRL + F4 The graph’s cursor follows the movement of the mouse while a hovering tool-
tip displays the exact coordinates of the current point.

Toggle Nearest Po-
sition Tip

CTRL + F9 The graph’s cursor follows the movement of the mouse cursor.

Print CTRL + P Prints the chromatogram.

Copy to clipboard CTRL + C Copies from the graph the raw detector data that was used to plot the selected
chromatogram. This data can be pasted into another application such as Mi-
crosoft Word or Microsoft Excel.

Paste from clip-
board

CTRL + V Plots a range of points copied from another application such as Microsoft Word
or Microsoft Excel.

2.3 Configure the appearance of the
chromatograph
MON2020 allows you to change the appearance of many of the chromatogram’s
elements, such as its x-axis and y-axis values, the color of the chromatograph’s
background, and the display status of its labels.

2.3.1 The Graph bar
Use the Graph bar buttons to change the display parameters of the chromatogram.

Click Edit from the Graph bar. The Edit Scales window displays.

The following table lists the parameters that can be edited:
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Command Description
Default Val-
ue

X Min Sets the minimum value, in seconds, for the X axis. 0

X Max Sets the maximum value, in seconds, for the X axis. The is value is
determined by the Timed Events table.

100

Y Min Sets the minimum value for the Y axis. -10

Y Max Sets the maximum value for the Y axis. 100

Print Speed Sets the number of inches per second for the x-axis while printing a
chromatogram, similar to an XY plotter.

0

X Intervals Sets the number of intervals to be displayed on the graph for the X
axis.

10

Y Intervals Sets the number of intervals to be displayed on the graph for the Y
axis.

11

Display Op-
tion

Determines whether the chromatograph is displayed as a solid line
or as a dotted line. Lines is checked by default.

Lines

Show labels Toggles the display of the graph labels. Checked

Scroll newest
X

Determines whether the graph’s window moves to focus on the
most recent data point along the x axis. This feature only applies to
live chromatograms.

Unchecked
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A chromatographFigure 2-6:   

To see how your changes affect the graph, click Apply. To accept your changes, click OK.

• Click Cursor to toggle the cursor size from coarse movement (less accurate) to fine
movement (more accurate).

• Click Print to print the chromatogram window.

2.3.2 Additional plot commands
In addition to the Graph bar, there are a few other commands available that allow you to
manipulate the look and feel of the graph. To access the additional plot commands menu,
right-click on the Chromatogram Viewer anywhere except on the graph or the timed event
and component data tables. The additional commands are:

Set Plot
Area Color

Changes the color of the graph’s background. This may be necessary to
make the chromatograms more visible. The default RGB color values are
236, 233, and 216.

Auto Resize
Series

Scales down the X-axis and the Y-axis to fit the entire chromatogram onto
the window.
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Show Mini
Plot

Toggles the display of a smaller version of the chromatogram in a
separate, smaller, and resizable window. This allows you to keep an
overview of the entire graph at all times, especially when zoomed in.
This window automatically displays whenever you zoom in on the original
chromatogram.

Rearrange
Series

Resizes and offsets two or more traces so that they can both be fully
displayed on the graph. To offset a trace means to raise its Y-axis relative
to the Y-axis of the previous trace so that one trace is not drawn over the
other but instead one trace is drawn above the other.

Trace Offset
Settings

Indicates the amount of offset between two or more traces. To offset a
trace means to raise its Y-axis relative to the Y-axis of the previous trace so
that one trace is not drawn over the other but instead one trace is drawn
above the other.
If two detectors are in use, each set of traces can be offset
independently--that is, the traces for one detector can be offset relative
to each other, but independent of the traces from the second detector.

2.4 Change how a chromatogram displays

The Chromatogram barFigure 2-7:   

The Chromatogram bar contains a row of buttons that allows you to manipulate a single
chromatogram. Below the row of buttons is the Chromatogram bar's pull-down menu,
which contains a list of all of the currently displayed chromatograms/traces. Before you
can work with a chromatogram you must first select it from the pull-down menu.

2.4.1 Edit a chromatogram
You can use the Edit function to change the X and Y offset values for a trace, as well as its
color. These changes may be necessary to make the trace more distinguishable from those
that surround it, or to align a trace with a different trace for comparison.

To edit a trace, do the following:

1. Select the trace that you want to edit from the Chromatogram pull-down menu.

2. Click Edit.

The Edit Chromatogram dialog appears.
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X Offset Enter a positive number to move the trace to the right, or a negative
number to move the trace to the left.

Y Offset Enter a positive number to move the trace up, or a negative number to
move the trace down.

# points Number of data points in the trace. This field is read-only.

Color Assigns a color to the trace.

3. To see how your changes affect the trace, click Apply. To accept your changes, click
OK.

2.4.2 Display chromatogram results
To display a table of calculation results for a chromatogram, do the following:

1. From the Chromatogram bar's pull-down menu, select the appropriate trace.

2. Click Results.

A window appears displaying the calculation results for the selected trace.

• Click Save to save these results in one of the following formats: tab-delimited (.txt),
comma-delimited (.csv), Microsoft Excel (.xls), HTM (.htm), or XML (.xml).

• Click Clipboard to copy the data to the Windows® clipboard, where it can be pasted
into another document.

• Click Print to print a tab-delimited version of the results.

2.4.3 Save a chromatogram
To save a chromatogram, do the following:

1. From the Chromatogram bar's pull-down menu, select the trace that you want to
save.

2. Click Save.

The Save As window displays.

For convenience the file is given an auto-generated file name that includes the
trace’s creation date and time; however, you can give the file any name that you
choose.

3. Click Save.

2.4.4 Remove a chromatogram from the Chromatogram
Viewer
To remove a live trace from the chromatogram window, do one of the following:

• If you want to remove all live traces, click the View current CGM check box to uncheck
it.
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• If you want to remove a single live trace, click the appropriate detector checkbox
beside the View current CGM check box.

To remove a saved or an archived chromatogram from the chromatogram window and to
close the file, do the following:

1. From the Chromatogram bar's pull-down menu, select the trace that you want to
remove.

2. Click Remove.

2.4.5 Initiate a forced calibration
The Forced Cal command uses an archived chromatogram’s raw data to calibrate the GC.
The calculation results are stored in the component data table for the corresponding
stream number.

A major benefit of a forced calibration is increased efficiency. Using a previously validated
chromatogram removes the necessity for the GC to perform a calibration and a validation
before performing an analysis.

To perform a forced calibration, do the following:

1. From the Chromatogram bar's pull-down menu, select the trace that you want to
use to calibrate the GC.

2. Click Forced Cal.

2.4.6 Chromatogram Viewer tables
MON2020 can display two levels of information in the Chromatogram Viewer's timed
events and component data tables:

• All timed events and all components for all open chromatograms.

• Timed events and components for the currently selected chromatogram.

By default, the two tables show only the timed events and components for the currently
selected chromatogram.
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Timed events and component data tables showing data for a currently
selected trace

Figure 2-8:   

Timed events and component data tables showing data for all open
traces

Figure 2-9:   

Note
The brackets ([ ]) on the Cur/All button indicate which mode is being displayed in the tables.

1. To view the data for a different chromatogram, select the trace from the
Chromatogram bar's pull-down menu.

2. To view all timed events and all components for all open chromatograms, click Cur/
All.

3. To toggle back to viewing only the timed events and components for the currently
selected chromatogram, click Cur/All again.
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2.4.7 Open a comparison file
A comparison file contains two or more chromatograms and their associated data. To
open a comparison file, do the following:

1. Click PC File. The Open dialog displays.

2. Select XA CMP Files (*.xcmp) from the Files of type drop-down menu.

3. Navigate to the folder that contains the comparison file that you want to open and
select the file.

4. Click Open.

2.4.8 Save a comparison file
A comparison file allows you to save your current view, including all open chromatograms,
for later review and reuse. To save a comparison file, do the following:

1. Click Save Cmp.

The Save As dialog appears.

2. Navigate to the folder in which you want to save the file.

Note
For convenience the file is given an auto-generated file name that includes the current date
and time; however, you can give the file any name that you choose.

3. Click Save.

2.5 Miscellaneous commands
The series of check boxes to the right of the graph have the following functions:

Miscellaneous optionsFigure 2-10:   

Keep last CGM When viewing a live chromatogram, upon starting a new run,
MON2020 keeps the most recently completed chromatogram on the
graph for comparative purposes.
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Print at end of
run

Prints the chromatogram to the PC's default printer at the end of the
run and is unchecked by default.

Save at end of
run

Saves the chromatogram to the GC's Data folder at the end of the run
and is unchecked by default.

Show bunched
data

If this box is unchecked, then all of the raw data points are plotted to
the chromatogram window; if this box is checked, which is the default
option, then each point plotted on the graph represents the average
of a group of raw data values. The size of the data group is determined
by the peak width value listed in the Timed Events table.

2.5.1 The Chromatogram Viewer's Timed Events table

The Chromatogram Viewer displays a compact version of the Timed Events table, located
on the upper right side of the window. The events displayed in the table are sorted by time.
See Section 4.3 for more information.

The Timed Event table displays the following data for each event:

Event Type The type of timed event. These events are mapped to the Time Events
window and include Valve, Integration and Gain events.

Vlv/Det Identifies which valve or detector is involved in the event.

Value Setting of the event; for example, a valve was turned ON, or the gain was
set to 4.

Time (s) The number of seconds into the cycle that the event occurred or will occur.

Timed events from live or archived chromatograms can be edited from the Chromatogram
Viewer by double-clicking on the Timed Events table. The changes will affect the next
analysis run. The following commands are available by right-clicking on the table:

Auto Scroll When checked, if a live trace has been selected from the
Chromatogram bar's pull-down menu, the Timed Event table will keep
its focus on the event closest in time by highlighting that event in dark
blue.

Save Sheet Allows you to save the table to the PC in one of the following formats:
TXT, CSV, XLS, HTM, or XML.

Copy to
Clipboard

Allows you to copy the table to the clipboard.
This data can be pasted into another application such as Microsoft
Word or Microsoft Excel.
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Print Sheet Allows you to print the table to your default printer.

2.5.2 Launch the Timed Events table from the Chromatogram
Viewer
To launch the Timed Events dialog directly, right-click on the Chromatogram Viewer’s
Timed Events table and select Edit Timed Events Table. The Timed Events dialog displays.
See Section 4.3 for more information.

2.5.3 Edit Timed Events from the Chromatogram Viewer
To edit timed events from the Chromatogram Viewer, do the following:

1. From the Chromatogram bar's pull-down menu, select the chromatogram whose
timed events you want to edit.

2. Right-click on the Timed Events table and select Edit.

The cells that can be edited turn white.

3. Edit the appropriate event.

4. Right-click on the Timed Events table and select Save Changes.

The data will be saved and the table's cells will turn blue, indicating that they are
read-only. The changes will affect the next analysis run.

Note
To return to the Timed Events table without saving your changes, select Discard Changes.
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2.5.4 Use the Chromatogram Viewer’s cursor to update a
Timed Event

Chromatograph cursorFigure 2-11:   

The Chromatogram Viewer's cursor (A) can be dragged to any point on the graph, or it can
be relocated by double-clicking within the boundaries of the graph.

As the cursor moves across the chromatogram, the Timed Events table automatically
scrolls to the event that corresponds to the cursor’s coordinates. The cursor’s coordinates
(B) display in the upper left corner of the graph.

The cursor can be useful if you want to change a timed event based on the data displayed
by the chromatogram.

To update a timed event based on the location of the Chromatogram Viewer’s cursor, do
the following:

1. Select the live or archived trace that you want to use as the source for changing the
timed event.

2. Drag the cursor to the desired location.
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You can track the cursor's location by watching the coordinates that display in the
upper left corner (B). The x-coordinate represents the analysis time in seconds.
When you see the desired time displayed, stop dragging the cursor.

Note
To toggle the cursor’s size between coarse movement (less accurate) and fine movement
(more accurate), click the Cursor button on the Graph bar.

3. Go to the Time Events table and right-click on the appropriate event.

4. Select Update Time from Cursor.

The event’s time will be changed to match the cursor’s time (x-coordinate).

5. To save your changes, right-click on the Timed Events table and select Save
Changes.

The changes will affect the next analysis run.

Note
To return to the Timed Events table without saving your changes, select Discard Changes.

2.5.5 The Chromatogram Viewer's Component Data table
The Chromatogram Viewer displays a compact version of the Component Data table
beneath the Timed Events table. See Section 4.2 for more information.

The Component Data table displays the following data for each component:

Component The name of the component.

Det Identifies the detector associated with the component.

Time (s) The retention time for the component.

Retention times for components from live or archived chromatograms can be edited from
the Chromatogram Viewer by double-clicking on the Component Data table. The changes
will affect the next analysis run. The following commands are available by right-clicking on
the table:

Auto Scroll When checked, if a live trace has been selected from the
Chromatogram bar's pull-down menu, the Component Data table will
keep its focus on the component closest in time by highlighting that it
in dark blue.

Save Sheet Allows you to save the table to the PC in one of the following formats:
TXT, CSV, XLS, HTM, or XML.

Copy to
Clipboard

Allows you to copy the table to the clipboard . This data can be pasted
into another application such as Microsoft Word or Microsoft Excel.

Print Sheet Allows you to print the table to your default printer.
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2.5.6 Edit retention times from the Chromatogram Viewer
To edit the retention time for a component, do the following:

1. Double-click on the Component Data table or right-click on the table and select Edit
Retention Times.

The Ret Time column turns white, indicating that its cells are editable.

2. Click on the appropriate cell for the component that you want edit, and enter a new
retention time, in seconds. The value must be less than the analysis time.

3. To save your changes, right-click on the table and select Save Changes.

The changes will affect the next analysis run.

Note
To return to the Component Data table without saving your changes, select Discard
Changes.

2.5.7 Display raw data from the Chromatogram Viewer
Use the Raw Data button to display the Raw Data table for the selected trace.

1. Use the Chromatogram bar's pull-down menu to select a specific trace.

Note
Even though you are selecting a trace, the data that is displayed will be for the chromatogram,
which may include more than one trace.

2. Click Raw Data.

The Raw Data window displays and shows the raw data for the selected
chromatogram. The following data displays for each peak from the trace:

No. Numerical identifier for the peak, listed by the order of
discovery.

Ret Time Time, in seconds, that the component eluted.

Peak Area The area under the peak.

Peak Height The maximum height of the peak.

Det The detector associated with the peak.

Method Method of peak end detection. Options are:

• 1 (Baseline)

• 2 (Fused Peak)

• 3 (Last Fused Peak)

• 4 (Tangent Skim)

• 100 (Inhibit)
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• 300 (Forced Integration)

• 500 (Summation)

Integ. Start Time, in seconds, when integration started.

Integ. Stop Time, in seconds, when integration stopped.

Peak Width Half
Height

The width of the peak taken at half of the peak’s height.

Is Partial Peak If Y, then the Partial Peak value is used in the summation
calculation; if N, then the Partial Peak value is not used in the
summation calculation.

2.6 Set the gas chromatograph’s date and time
When MON2020 connects to a gas chromatograph, the Status Bar displays the gas
chromatograph’s date and time.

Note
The date and time displayed for the GC may be different from the user’s date and time, depending
on the physical location of the GC.

To set the gas chromatograph’s date and time, do the following:

1. Select View/Set Date Time... from the Chromatograph menu.

The View/Set Date Time window displays.

2. Use the drop-down menus to set the date and time.

To enable or adjust daylight savings, see Section 2.6.1.

3. Click OK.

2.6.1 Set daylight savings
Daylight savings time is the practice of temporarily advancing clocks so that afternoons
have more daylight and mornings have less. Typically clocks are adjusted forward one hour
near the start of spring and are adjusted backward in autumn. Since the use of daylight
savings time is not universal, you have the option of enabling or disabling it in MON2020.

To configure MON2020 to use daylight savings time, do the following:

1. Select View/Set Date Time... from the Chromatograph menu.

The View/Set Date Time window displays.

Note
Make sure the GC is set to the current date and time before enabling the daylight savings
feature.
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2. Click the Enable Daylight Savings checkbox.

The Daylight Savings section will be enabled, giving you the following two options for
setting the start and end times for daylight savings:

• Week format. You can specify on which week day, of what week, and of what
month DST to start and end.

• Month/Day format. You can specify the exact day of the month and the month
number for which you want daylight savings to start and end.

Note
These formats can be used interchangeably; for example, the Week format can be used to
specify the start date, and the Month/Day format can be used to specify the end date.

The Daylight Savings optionsFigure 2-12:   

A. Week format
B. Start time
C. Month/day time
D. End time
E. Advance time
F. Set back time

3. Set the start date for daylight savings time.

4. Set the start time and the advance time.

5. Set the end date for daylight savings time.

6. Set the end time and the setback time.

7. Click OK to implement your changes and close the View/Set Date Time window.
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Note
To implement your changes without closing the View/Set Date Time window, click Save.

Note
Daylight savings time should be configured each time the feature is enabled; thereafter, each
year MON2020 will automatically compute the start and end times based on the initial
configuration.
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3 Hardware

Many of a gas chromatograph’s hardware components—such as its heaters, valves, and
discrete outputs—can be easily managed through MON2020.

This chapter shows you how to view and administer each of a gas chromatograph’s major
hardware components.

This chapter also shows you how to view an inventory of all of a gas chromatograph’s
installed hardware components.

3.1 Heater configuration
MON2020 allows you to do the following from the Heaters window:

• Name each heater.

• Monitor the heaters' performance.

• Set a target temperature.

3.1.1 Set the temperature of the gas chromatograph’s heaters
You can set a heater’s desired temperature or fix its power output by selecting Heaters…
from the Hardware menu.

Each heater can be set to one of the following modes:

Auto Allows you to set the desired temperature for the heater.

Fixed On Allows you to set the power output for the heater without regard to
temperature.

Not Used Removes the heater from service.

3.1.2 Rename a heater
To assign an identifying label to a heater, do the following:

1. Select Heaters… from the Hardware menu.

The Heaters window displays.

2. Double-click on the appropriate row under the Label column for the heater that you
want to name.

3. Type in a descriptive name for the heater. This name must be unique; two heaters
cannot share the same label.

4. Click OK.
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3.1.3 Set a heater’s voltage type
To set a heater’s voltage type, do the following:

1. Select Heaters… from the Hardware menu.

2. Click on the appropriate Heater Type cell and select AC or DC from the drop-down
list.

3. Click OK to save the changes and close the window.

Note
To save the changes without closing the window, click Save.

3.1.4 Monitor the temperature of a heater
To check a heater’s temperature, select Heaters… from the Hardware menu.

The current temperature of each heater displays under the Temperature column, and
updates in real time. The percentage of the GC’s power output that is being used by each
heater displays under the Current PWM column.

3.1.5 Monitor the operational status of a heater
To check a heater’s status, select Heaters… from the Hardware menu.

The status of each heater displays under the Status column. There are four possible status
states, and their meanings are as follows:

OK The heater’s control card is installed and is working correctly.

Not Installed The heater’s control card is not installed.

Out of Control The heater is running and is in the process of reaching its temperature
set point.

Error The GC cannot communicate with the heater.

3.1.6 Set the desired temperature
To set the desired temperature for a heater, do the following:

1. Select Heaters… from the Hardware menu.

The Heaters window displays.

2. For each heater that you want to set, select Auto from the appropriate row under
the Switch column.

3. For each heater that you want to set, double-click on the appropriate row under the
Setpoint column, and enter the desired temperature, in degrees Celsius. You can
enter a value between 20 and 500.
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Note
Heaters 1 and 2 should never exceed 150 °C.

4. To exclude a heater from the Warm Start process, select its Ignore Warm Start check
box.

Note
A warm start occurs when the GC restarts after having been shut down during an auto
sequence analysis run. The GC will activate the heaters and wait until they reach their
setpoints and the temperature stabilizes; the GC will then resume the auto sequence run.

5. The appropriate rows under the PID Gain, PID Integral, and PID Derivative columns can
also be edited by double-clicking and entering a new value. The value ranges for
each column is as follows:

PID Gain 0 - 500

PID Integral 0 - 500

PID Derivative 0 - 50000

Note
You should not deviate from the default settings for these variables, which were determined
by experienced personnel.

6. Click OK to save the changes and close the window.

Note
To save the changes and leave the window open so that you can monitor the heaters’ status,
click Save. The current temperature of each heater displays in the Temperature column, and is
updated in real time.

3.1.7 Set PWM Output

Note
Pulse-Width Modulation (PWM) is a technique for providing intermediate amounts of electrical
power between fully on and fully off.

A heater needs voltage to operate. The amount of voltage that is delivered to a heater can
be controlled manually when the heater is set to Fixed On mode. Setting a heater to Fixed
On mode can be useful when troubleshooting heater issues.
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CAUTION!

Fixed On mode is not recommended for general GC operations. Switching a heater to Fixed On
mode removes its ability to maintain a constant temperature because the power delivered to
the heater will not fluctuate based on the temperature setpoint, but will instead remain at the
level set by the user.

To set a heater’s PWM Output, do the following:

1. Select Heaters… from the Hardware menu.

The Heaters window displays.

2. For each heater that you want to set, select Fixed On from the appropriate row
under the Switch column.

3. For each heater that you want to set, double-click on the appropriate row under the
Fixed PWM Output column, and enter the desired percentage of output. You can
enter a decimal value between 0 and 100.

4. Click OK to save the changes and close the window, .

Note
To save the changes and leave the window open so that you can monitor the heaters’ status,
click Save. The current temperature of each heater displays in the Temperature column, and is
updated in real time.

3.1.8 Take a heater out of service
To remove a heater from service, do the following:

1. Select Heaters… from the Hardware menu.

The Heaters window displays.

2. For each heater that you want to set, select Not Used from the appropriate row
under the Switch column.

The row turns turquoise, indicating that it is no longer in service.

3. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.

3.2 Valve configuration
MON2020 allows you to do the following from the Valves window:

• Assign identifying labels to each valve.
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• Monitor valve operation.

• Control the operation modes for each valve.

3.2.1 Rename a valve
Give each valve a descriptive label to avoid confusing one valve for another. To assign an
identifying label, do the following:

1. Select Valves… from the Hardware menu.

The Valves window displays.

2. Double-click on the appropriate row under the Label column for the valve that you
want to name.

Note
The valves are labeled Valve 1 - Valve N by default, where N equals the total number of valves
available to the GC.

3. Type in a new descriptive name for the valve.

4. Click OK.

3.2.2 Set a valve’s operational mode
A valve has three operational modes: Auto, On, and Off.

• Setting the valve to Off means that the valve will turn off and remain off until the
operational mode is changed.

• Setting the valve to Auto means that the valve will turn on and off according to the
Timed Events table.

• Setting the valve to On means that the valve will turn on and remain on until the
operational mode is changed.

Note
The GC’s switch panel or LOI settings override MON2020’s valve settings.

To set a valve’s operational mode, do the following:

1. Select Valves… from the Hardware menu.

The Valves window displays.

2. Select the desired mode from the drop-down menu under the Switch cloumn for the
valve.

3. Click OK to save the changes and close the window.
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Note
To save the changes and leave the window open so that you can monitor the valve’s progress,
click Save. The current state of the valve displays in the State column, and is updated in real
time.

3.2.3 Monitor the operational status of a valve
To check a valve’s status, select Valves… from the Hardware menu.

The status of each valve displays under the Status column. There are five possible status
readings, and their meanings are as follows:

OK The valve is installed and is working correctly.

Not Installed The valve is not installed.

Under/Over
Current Error

Unable to switch the solenoid on or off. There is a potential
problem with the solenoid.

Error The Heater/Solenoid board is installed but the GC cannot
communicate with it.

3.2.4 Invert the polarity of a valve
The Invert Polarity option reverses the effect of switching a valve on or off. By default, the
Invert Polarity option is set to FALSE, which means that switching a valve to ON activates
it, and switching the valve to OFF deactivates it. Setting Invert Polarity to TRUE means
that switching a valve to ON deactivates it, and switching the valve to OFF activates it.

To set the polarity of a valve, do the following:

1. Select Valves… from the Hardware menu.

The Valves window displays.

2. If the Invert Polarity checkbox is selected, it is set to True; to set it to False, uncheck
the box by clicking it. If the Invert Polarity checkbox is not selected, it is set to False;
to set it to True, click the box.

3.2.5 Set the usage mode for a valve
A valve’s usage mode determines its general function, or role, during an analysis run. A
valve can be assigned one of the following usage modes:

• Unused

• DO (700XA and 1500XA only.)

• FID H2 Valve (700XA and 1500XA only.)

• Common Alarm (700XA and 1500XA only.)

• Stream

• Analyzer01

…
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• Analyzer016

The usage mode is set at the factory and under ordinary circumstances it should not be
changed.

To set the usage mode for a valve, do the following:

1. Select Valves… from the Hardware menu.

The Valves window displays.

2. Select the desired mode from the drop-down menu under the Usage column for the
valve.

3. Click OK to save the changes and close the window.

Note
To save the changes and leave the window open so that you can monitor the valve’s progress,
click Save. The current state of the valve displays in the State column, and is updated in real
time.

3.3 Managing the gas chromatograph's pressure
MON2020 allows you to do the following from the EPC window:

• Change the carrier pressure set point.

• Monitor the EPC's status.

• Switch EPC modes.

3.3.1 Change the carrier pressure set point

Note
This feature only works with the 370XA.

1. Select EPC on the Hardware menu.

The EPC window opens.

2. Double-click the Set Point field and enter the desired value.

Note
If the field does not become active after double-clicking it, make sure the Switch field is set to
Auto.

3. Click OK.

The new set point will be accepted and the EPC window will close.
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3.3.2 Check the status of the EPC

Note
This feature only works with the 370XA.

Select EPC on the Hardware menu. The EPC window opens.

Check the Status column to learn the current state of the EPC:

State Description

Ok EPC is working normally and controlling the
pressure to the set point.

Pressure Low The carrier pressure is too low.

Out of range The EPC is not able to control the pressure to
the desired set point.

3.3.3 Switch to a different EPC mode

Note
This feature only works with the 370XA.

1. Select EPC on the Hardware menu.

The EPC window opens.

2. Click the Switch field.

A drop-down listbox opens.

3. Select the appropriate mode.

Option Description

Auto Let's the GC control and maintain its pressure at the desired set point.

Manual Allows you to control the power output for the EPC valve by entering a value, in
the Fixed PWM Output field.

Not Used Shuts off the EPC.

4. Click OK.

The EPC will switch modes and the EPC window will close.

Hardware

54



3.4 Detectors
Use the Detectors window to monitor the activity and status of the GC’s detectors.

To view the Detectors window, select Detectors… from the Hardware menu.

Note
Before making any modifications to this window, halt the analysis. See Section 6.7 for more
information.

Note
Blue cells display read-only data; white cells display editable data.

The following data displays for each detector:

Det # Numerical identifier for the detector to which the following
data applies.

Detector Options, which depend on your GC’s configuration, are TCD,
FPD, or FID.

FID Temp RTD Applies to FIDs only. Select the appropriate RTD from the drop-
down list. The RTD measures the temperature of the FID flame.

FID Ignition Applies to FIDs only. Select Manual if you want to control the
ignition of the FID; select Auto if you want the GC to control the
ignition of the FID.

Ignition Attempts Applies to FIDs only. Indicates the number of times the GC will
try to light the flame. If an 'Auto' FID ignition sequence fails to
light the flame after the specified number of attempts, the GC
will close the hydrogen valve, switch the FID ignition parameter
to Manual, and set an active alarm.

Wait Time Bet Tries Applies to FIDs only. Indicates the amount of time, in seconds,
the GC will wait between ignition attempts.

Igniter On Duration Applies to FIDs only. Indicates the length of time that the igniter
will remain on.

Flame On Sense Temp Applies to FIDs only. The flame ignites when the FID internal
temperature exceeds the value set in this field.

Flame Out Sense
Temp

Applies to FIDs only. The flame is extinguished when the FID
internal temperature falls below the value set in this field.

FPD Flame Status DI Applies to FPDs only. Allows you to select from a list of available
digital inputs. The digital input that is selected will receive the
FPD’s flame status value.

Preamp Val FID count. Read-only. See Section 3.4.3 for more information.

FID Flame Temp Temperature of the FID flame as read by the RTD. Read-only.

Flame Status Options are: Off, On, and Over Temperature. Read-only.

H2 Valve Cur State Options are: Open and Closed. Read-only.

Scaling Factor Preamp calibration factor.
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Igniter Status Options are: Off and On. Read-only.

Electrometer Voltage Output at first stage of FID preamp. Read-only.

Pre Amplifier Voltage Output at second stage of FID preamp. Read-only.

Polarizing Voltage Igniter voltage. Read-only.

FID Gain Status Options are: Low and High.

Status Options are: Ok, Not Installed and Internal Error. Read-only.

3.4.1 Offset the baseline
In some situations that involve TCD detectors the baseline may be displayed either too
high on the graph, in which case the tops of the peaks are cut off, or too low on the graph,
so that the bases of the peaks are cut off. If this occurs it is possible to offset the baseline
either up or down so that the entire peak can be displayed on the graph. This offset will be
applied to all traces—live, archived and saved—that are displayed thereafter.

To offset the baseline, do the following:

1. Select Detectors… from the Hardware menu.

The Detectors window displays.

2. Select the appropriate detector. It may be necessary to return to the Chromatogram
Viewer to learn which detector is the source of the trace that needs to be offset.

3. To lower the baseline, click Lower Baseline(N). Each time this button is clicked, N is
incremented by -1. For example, is this is the first time the button has been clicked,
Lower Baseline(0) will be increment to Lower Baseline(-1) and the baseline will be
lowered one step. If Raise Baseline(N) was clicked previously, then that button will
be incremented by -1 first, until it reached Raise Baseline(0); at the point, Lower
Baseline(N) will be incremented by -1.

Note
To reset the baseline to its default setting, click Raise Baseline(N) and Lower Baseline(N) until
they read Raise Baseline(0) and Lower Baseline(0).

4. To raise the baseline, click Raise Baseline(N).

5. After the baseline has been raised or lowered to your satisfaction, click OK.

3.4.2 Ignite the FID flame
If the FID Ignition field on the Detectors window is set to “Manual” and if the Flame status
field is set to “Off”, do the following to restart the flame:

1. Click Open H2 Valve.

The H2 Valve Cur State field changes to “Open”.

2. Click Ignite.
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The Flame Status field changes to “On” when the FID internal temperature exceeds
the value set in the Flame On Sense Temp field.

Note
If the FID Ignition field is set to “Auto”, the GC will automatically restart the flame if it goes out.

3.4.3 Reset the preamp value
To reset the Preamp Val field on the Detectors window to 0, click Auto-Zero.

3.4.4 Balance the preamp
In some situations that involve TCD detectors the baseline may be displayed either too
high on the graph, in which case the tops of the peaks are cut off, or too low on the graph,
so that the bases of the peaks are cut off. If this occurs it is possible to offset the baseline
either up or down so that the entire peak can be displayed on the graph. This offset will be
applied to all traces—live, archived and saved—that are displayed thereafter.

To offset the baseline, do the following:

1. Select Detectors… from the Hardware menu.

The Detectors window displays.

2. Select the appropriate detector.

It may be necessary to return to the Chromatogram Viewer to learn which detector
is the source of the trace that needs to be offset.

3. Balance the preamp:

• To lower the baseline, click Left(N). Each time this button is clicked, N is
incremented by -1. For example, is this is the first time the button has been
clicked, Left(0) will be increment to Left(-1) and the baseline will be lowered one
step. If Right(N) was clicked previously, then that button will be incremented by
-1 first, until it reached Right(0); at the point, Left(N) will be incremented by -1.

Note
To reset the baseline to its original setting, click Right(N) and Left(N) until they read
Right(0) and Left(0).

• To raise the baseline, click Right(N). Each time this button is clicked, N is
incremented by 1. For example, is this is the first time the button has been
clicked, Right(0) will be increment to Right(1) and the baseline will be raised one
step. If Left(N) was clicked previously, then that button will be incremented by 1
first, until it reaches Left(0); at the point, Right(N) will be incremented by 1.

Note
To reset the baseline to its original setting, click Right(N) and Left(N) until they read
Right(0) and Left(0).
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3.5 Discrete inputs
You can use MON2020 to assign labels to the GC’s discrete inputs and to control the
discrete inputs’ operational modes. The number of discrete inputs available depends on
the GC.

3.5.1 Rename a discrete input
Give each discrete input a descriptive label to avoid confusing one unit for another. To
assign an identifying label, do the following:

1. Select Discrete Inputs… from the Hardware menu.

The Discrete Inputs window displays.

2. Double-click on the appropriate row under the Label column for the discrete input
that you want to rename.

Note
The discrete inputs are labeled Discrete Input 1 - Discrete Input N by default, where N equals
the total number of discrete inputs available to the GC.

3. Type in a new descriptive name for the discrete input.

4. Click OK.

3.5.2 Set a discrete input’s operational mode
A discrete input has three operational modes: Auto, On, and Off.

• Setting the discrete input to Off means that it will interpret all incoming signals as
OFF, despite the true nature of the signal.

• Setting the discrete input to Auto means that it will analyze the incoming signal to
determine whether it is ON or OFF.

• Setting the discrete input to On means that it will interpret all incoming signals as
ON, despite the true nature of the signal.

Note
The GC’s switch panel settings override MON2020’s settings.

To set a discrete input’s operational mode, do the following:

1. Select Discrete Input… from the Hardware menu.

The Discrete Input window displays.

2. Select the desired mode from the drop-down menu under the Switch column for the
discrete input.
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3. To save the changes and leave the window open so that you can monitor the
discrete input’s progress, click Save. The current state of the discrete input displays
in the State column, and is updated in real time.

4. To save the changes and close the window, click OK.

3.5.3 Monitor the operational status of a discrete input
To check a valve’s status, select Discrete Input… from the Hardware menu.

The status of each discrete input displays under the Status column. There are three
possible status readings, and their meanings are as follows:

OK The discrete input is installed and is working correctly.

Not Installed The discrete input is not installed.

Error The Heater/Solenoid board is installed but the GC cannot communicate
with it.

3.5.4 Invert the polarity of a discrete input
The Invert Polarity option reverses the way a voltage signal is interpreted by the discrete
input. By default, the Invert Polarity option is set to Normally Open, which means that a
low voltage signal is interpreted by the discrete input as ON, and a high voltage signal is
interpreted by the discrete input as OFF. Setting Invert Polarity to Normally Closed means
that a low voltage signal is interpreted by the discrete input as OFF, and a high voltage
signal is interpreted by the discrete input as ON.

To set the polarity of a discrete input, do the following:

1. Select Discrete Input… from the Hardware menu.

The Discrete Inputs window displays.

2. Select Normally Open or Normally Closed from the drop-down menu under the
Invert Polarity column.

3.6 Discrete outputs
You can use MON2020 to assign labels to the GC’s discrete outputs and to control the
discrete outputs’ operational modes. The number of discrete outputs available depends
on the GC.

3.6.1 Rename a discrete output
Give each discrete output a descriptive label to avoid confusing one unit for another. To
assign an identifying label, do the following:

1. Select Discrete Outputs… from the Hardware menu.

The Discrete Outputs window displays.
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2. Double-click on the appropriate row under the Label column for the discrete output
that you want to rename.

Note
The discrete outputs are labeled Discrete Output 1 - Discrete Output N by default, where N
equals the total number of discrete outputs available to the GC.

3. Type in a new descriptive name for the discrete output.

4. Click OK.

3.6.2 Set a discrete output’s operational mode
A discrete output has three operational modes: Auto, On, and Off.

• Setting the discrete output to Off means that the discrete output will turn off and
remain off until the operational mode is changed.

• Setting the discrete output to Auto means that the discrete output will turn on and
off according to the Timed Events table or the Discrete Outputs table.

• Setting the discrete output to On means that the discrete output will turn on and
remain on until the operational mode is changed.

To set a discrete output’s operational mode, do the following:

1. Select Discrete Output… from the Hardware menu.

The Discrete Output window displays.

2. Select the desired mode from the drop-down menu under the Switch cloumn for the
discrete output.

3. Click OK to save the changes and close the window.

Note
To save the changes and leave the window open so that you can monitor the discrete
output’s progress, click Save. The current state of the discrete output displays in the State
column, and is updated in real time.

3.6.3 Monitor the operational status of a discrete output
To check a discrete output’s status, select Discrete Output… from the Hardware menu.

The status of each discrete output displays under the Status column. There are three
possible status readings, and their meanings are as follows:

OK The discrete output is installed and is working correctly.

Not Installed The discrete output is not installed.

Error The Heater/Solenoid board is installed but the GC cannot communicate
with it.
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3.6.4 Set the usage mode for a discrete output
A discrete output’s usage mode determines which signals are routed to it via the Limited
Alarm and Discrete Alarm functions. A discrete output can be assigned one of the
following usage modes:

• DO

• Common Alarm

• Stream

• Analyzer01

…

• Analyzer016

• Calibration

• Maintenance

• Calibration or Maintenance

• Validation

• Calibration or Validation or Maintenance

To set the usage mode for a discrete output, do the following:

1. Select Discrete Output… from the Hardware menu.

The Discrete Output window displays.

2. Select the desired mode from the drop-down menu under the Usage column for the
discrete output.

3. If you select DO for Usage, then you must also set the Start Time and Duration.

a. Click on the appropriate row under the Start Time column and enter the time that
the digital output should be turned on.

b. Click on the appropriate row under the Duration column and enter the amount of
time, in seconds, that the digital output should remain on.

c. Click on the appropriate row under the Interval column and enter the amount of
time, in hours, that should pass before the digital output turns on again.

4. Click OK to save the changes and close the window.

Note
To save the changes and leave the window open so that you can monitor the discrete
output’s progress, click Save. The current state of the discrete output displays in the State
column, and is updated in real time.
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3.7 Manage your gas chromatograph’s analog
inputs
With MON2020 you can control analog inputs in the following ways:

• Assign identifying labels.

• Assign scale ranges.

• Calibrate analog inputs for zero and full scale values.

Note
Electrical current signals ranging from 4 to 20 mA (±10%) are accepted as analog inputs.

3.7.1 Rename an analog input
Give each analog input a descriptive label to avoid confusing one unit for another. To
assign an identifying label, do the following:

1. Select Analog Inputs… from the Hardware menu.

The Analog Inputs window displays.

2. Double-click on the appropriate row under the Label column for the analog input
that you want to rename.

Note
The analog input devices are labeled Analog Input 1 and Analog Input N by default, where N
equals the total number of analog inputs available to the GC.

3. Type in a new descriptive name for the analog input.

4. Click OK.

3.7.2 Set an analog input’s operational mode
An analog input has two operational modes: Variable and Fixed.

• Var_Normal: The analog input will be set automatically, based on the signal it
receives. This is the default setting.

• Var_Namur_NE43: Namur_NE43 uses the 3.8 to 20.5 mA signal range for
measurement information, with ≥21 mA or ≤3.6 mA to indicate diagnostic failures.

• Setting the switch to Fixed means that the analog input will be set to the value that
you enter in the appropriate row under the Fixed Value column.

To set an analog input’s operational mode, do the following:

1. Select Analog Input… from the Hardware menu.

The Analog Input window displays.
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2. Select the desired mode from the drop-down menu under the Switch cloumn for the
analog input.

3. Click OK to save the changes and close the window.

Note
To save the changes and leave the window open so that you can monitor the analog input,
click Save. The current value of the analog input signal displays in the Current Value column,
and is updated in real time.

3.7.3 Set the scale values for an analog input device
To set the zero scale and full scale, which are used when converting the analog input value,
do the following:

1. Select Analog Input… from the Hardware menu.

The Analog Input window displays.

2. Double-click on appropriate row under the Zero Scale column and enter a zero scale
value.

3. Double-click on appropriate row under the Full Scale column and enter a full scale
value.

4. Click OK to save the changes and close the window.

Note
To save the changes and leave the window open so that you can monitor the analog input,
click Save.

3.7.4 Set the type of analog input signal
The GC’s analog inputs can receive two types of signal: a 0 - 10 V current or the industry
standard, which is a 4-20 mA current. To set the type of signal generated by the analog
input device, do the following:

1. Select Analog Input… from the Hardware menu.

The Analog Input window displays.

2. Select the signal type from the appropriate row under the mA/Volt column.

3. Click OK to save the changes and close the window.

Note
To save the changes and leave the window open so that you can monitor the analog input’s
progress, click Save. The type of signal being generated displays in the mA/Volts column, and
is updated in real time.
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3.7.5 Monitor the status of an analog input
To check an analog input’s status, select Analog Input… from the Hardware menu.

The operational status of each analog input displays under the Status column. There are
three possible status readings, and their meanings are as follows:

OK The analog input is installed and is working correctly.

Not Installed The analog input is not installed.

Error The analog input is installed but the GC cannot communicate with it.

This window also displays other types of data, such as the following:

mA/Volts The type of analog input signal being received.

mA If mA displays in the mA/Volts column, then this column displays the amount
of current being received, in milliamperes.

Volts If Volts displays in the mA/Volts column, then this column displays the
amount of current being received, in volts.

Cur Val The current value of the analog input signal.

3.7.6 Calibrate an analog input
To calibrate an analog input, do the following:

1. Select Analog Input… from the Hardware menu.

The Analog Input window displays.

2. Click on the analog input that you want to calibrate.

3. Set the analog input’s Zero Scale by entering its minimum anticipated value.

4. Set the analog input’s Full Scale by entering your maximum anticipated value.

5. Click AutoCal…(F4) or press F4.

The Analog Input Calibration Wizard runs.

6. Click Next.

Step 2 of the Analog Input Calibration Wizard displays.

7. 7. Click Next.

Step 3 of the Analog Input Calibration Wizard displays.

8. 8. Click Next.

Step 4 of the Analog Input Calibration Wizard displays.

9. 9. Click Finish.

The calibration is complete.
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3.8 Analog outputs
With MON2020 you can control the analog outputs in the following ways:

• Assign identifying labels.

• Assign scale ranges.

• Calibrate analog outputs for zero and full scale values.

3.8.1 Rename an analog output
Give each analog output a descriptive label to avoid confusing one unit for another. To
assign an identifying label, do the following:

1. Select Analog Outputs… from the Hardware menu.

The Analog Outputs window displays.

2. Double-click on the appropriate row under the Label column for the analog output
that you want to rename.

Note
The analog output devices are labeled Analog Output 1 - Analog Output N by default, where
N equals the total number of analog outputs available to the GC.

3. Type in a new descriptive name for the analog output.

4. Click OK.

3.8.2 Set an analog output’s operational mode
An analog output has two operational modes: Variable and Fixed.

• Setting the switch to Var_Standard means that the analog output will be
proportional to the variable selected in from the Variables column. This is the default
setting.

• Var_Namur_NE43: Namur_NE43 uses the 3.8 to 20.5 mA signal range for
measurement information, with ≥21 mA or ≤3.6 mA to indicate diagnostic failures.

• Setting the switch to Fixed means that the analog output will be set to the value
that is entered in the appropriate row under the Fixed Value column.

To set an analog output’s operational mode, do the following:

1. Select Analog Output… from the Hardware menu.

The Analog Output window displays.

2. Select the desired mode from the drop-down menu under the Switch column for the
analog output.

3. Click Save to save the changes and leave the window open so that you can monitor
the analog output.
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Note
To save the changes and close the window, click OK. The current value of the analog output
displays in the Cur Val column, and is updated in real time.

3.8.3 Set the scale values for an analog output device
To set the zero scale and full scale, which are used when converting the analog output
value, do the following:

1. Select Analog Output… from the Hardware menu.

The Analog Output window displays.

2. Click on appropriate row under the Zero Scale column and enter a zero scale value.

3. Click on appropriate row under the Full Scale column and enter a full scale value.

4. Click OK to save the changes and close the window.

To save the changes and leave the window open so that you can monitor the analog
output’s progress, click Save.

3.8.4 Map a system variable to an analog output
To select the system variable on which to base the signal level of the analog output, do the
following:

1. Select Analog Output… from the Hardware menu.

The Analog Output window displays.

2. Select a new variable by clicking on the appropriate drop-down list under the
Variable column.

For a demonstration of how to use the context-sensitive variable selector, see 
Section 1.11.

3. Click OK to save the changes and close the window.

Note
To save the changes and leave the window open so that you can monitor the analog output’s
progress, click Save.

3.8.5 Monitor the status of an analog output
To check an analog output device’s status, select Analog Output… from the Hardware
menu.

The operational status of each analog output displays under the Status column. There are
three possible status readings, and their meanings are as follows:

OK The analog output device is installed and is working correctly.
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Not Installed The analog output device is not installed.

Error The Heater/Solenoid board is installed but the GC cannot communicate
with it.

This window also displays other types of data, such as the following:

mA The amount of current being generated in milliamperes.

Cur Val The current scaled value of the analog output signal.

3.8.6 Calibrate an analog output
To automatically calibrate an analog output, do the following:

1. Select Analog Output… from the Hardware menu.

The Analog Outputs window displays.

2. Click on the analog output that you want to calibrate.

3. Click AutoCal…(F4) or press F4.

The Analog Output Calibration Wizard runs.

4. Select the check box for the unit of measure you want to use for the calibration and
then click Next.

Step 2 of the Analog Output Calibration Wizard displays.

5. Enter the Zero Scale Adjustment value and then click Next.

If the value entered is within tolerance, it is accepted and Step 3 of the Analog
Output Calibration Wizard displays. If the value is not within tolerance, an error icon

( ) appears beside the field. Tolerance is set to ±1 mA of the analog output’s
default zero adjustment setting, which is 4 mA. Enter a different value and try again.

6. Enter the Full Scale Adjustment value and then click Next.

If the value entered is within tolerance, it is accepted and Step 4 of the Analog
Output Calibration Wizard displays. If the value is not within tolerance, an error icon

( ) appears beside the field. Tolerance is set to ±1 mA of the analog output’s
default full adjustment setting, which is 20 mA. Enter a different value and try again.

7. Click Finish.

The calibration is complete.

3.9 The Hardware Inventory List
MON2020 can compile an inventory table of all hardware that is installed on the GC. To
view this table, select Installed Hardware… from the Hardware menu.
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The type of hardware installed is listed under the Device Description column. The other
types of information available on this screen are the following:

IO Function Describes the function of the device.

Slot Number Describes the location of the hardware in the GC. The slot number refers
to the card cage assembly, which is located in the GC’s lower enclosure
and which has eight slots. For the 700XA and 1500XA, the slots are
labeled:

• Expansion Slot 1-2

• LOI

• Expansion Slot 1-4

• Base IO

• Foundation Field Bus

There are no slots in the 370XA, therefore this column will display
"Analyzer" for all hardware.

Revision The revision number of the backplane.
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4 Application

Many of the variables that a gas chromatograph uses during an analysis run—such as timed
events, stream sequence, and calculation types—can be easily managed through
MON2020.

This chapter explains how to do the following:

• View and edit general information about the GC to which MON2020 is connected,
such as name, model, and default stream sequence.

• View and edit component data, validation data, and timed event tables.

• View and change control, average, and user-defined calculations.

• View and edit limit alarm data.

• View and change stream data.

• View and edit the stream sequence.

• View and edit communication and ethernet port data.

• View and map LOI status variables.

• View and map the FOUNDATION fieldbus process variables.

4.1 Configure the system
To view the System window, select System on the Application menu.

Use this window to select the default GC stream sequence and to set or edit system-wide
variables such as the GC’s name, serial number, and system description.

Analyzer Name Defines the GC name that appears in the Status Bar on the main
window when MON2020 is connected to the GC. Can contain up
to 12 characters.

System Description A field to record miscellaneous reference information to further
identify the currently connected system. Can contain up to 28
characters.

Site Id Holds customer-defined site identification information.

Company Name The name of the company that operates the GC.

Location The physical location of the GC to which MON2020 is connected.

Model The model number of the GC to which MON2020 is connected.

Serial No Serial number of the GC to which MON2020 is connected.

Firmware Version Revision level of firmware of the GC to which MON2020 is
connected.

Standard
Component Table
Version for GPA

Indicates which version of the GPA’s standard component table is
being used.
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Standard
Component Table
Version for ISO

Indicates which version of the ISO’s standard component table is
being used.

CGM FCAL Archive Sets the storage behavior for final calibration chromatograms. The
options are:

• Keep Last FCAL Per Day - Saves only the last final calibration
chromatogram of the day.

• Keep All FCAL Per Day - Saves all final calibration
chromatograms.

CGM FVAL Archive Sets the storage behavior for final validation chromatograms. The
options are:

• Keep Last FVAL Per Day - Saves only the last final validation
chromatogram of the day.

• Keep All FVAL Per Day - Saves all final validation
chromatograms.

Date Format Defines how the date will be displayed. The options are:

• MM$$DD$$YYYY

• MM$DD$YY

• DD$MM$YYYY

• DD$MM$YY

• YYYY$MM$DD

• YY$MM$DD

$ is the Date Field Separator.

Date Field
Separator

Defines the text symbol that will be used as the separator when
displaying the date. The options are:

• /

• -

• .

Time Format Defines how the time will be displayed. The options are:

• HH:MM:SS

• HH:MM

Time Notation Defines the cycle of time to use when displaying the time. The
options are:

• 12 Hr

• 24 Hr

Show Advanced
System Variables

Determines whether advanced system variables will be displayed
along with basic system variables.

Allow Multiple
Writers

Determines whether more than one user can connect to the GC.
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Maintenance Mode Switches the GC to maintenance mode and triggers an alarm that
the GC is down for maintenance.

Ideal RF Order/
Limit Check

Applies to the 370XA only. If enabled the GC will verify the
following during a calibration:

• The order of magnitude of the response factors for all the
components should be in a particular order. The GC will
verify that the response factors follow this pattern.

• The response factor ratio for each component with respect
to a reference component should be within a pre-defined
range. The GC will verify that the ratio is within acceptable
limits.

Max Warmstart
Delay

Applies to the 370XA only. This is the maximum time, after a GC
recovers from a power failure during normal operation, that the
GC will wait for the heaters and electronic pressure controller to
reach their respective set points and stabilize before triggering the
Warmstart Failure alarm.

EV Check Applies to the 370XA only. If enabled, the GC analyzes the
calibration gas as an unknown stream and computes its energy
value. The GC then compares this value to the Cal Gas Cert CV and
determines if the calibration gas' energy value is within the CV
Check Allowed Deviation. If it isn't, the GC triggers the Energy Value
Invalid alarm.
The following conditions must be met before the GC can perform
a EV Check:

• The EV Check flag in the System window must be enabled.

• At least one stream must be set up in the Streams window as
a calibration stream and the Auto flag for this stream must
be enabled.

The EV Check is performed under any of the following
circumstances:

• During a warm start that follows a power failure during
normal operation. The GC waits for the heater and
electronic pressure controller to reach their respective set
points and stabilize. It then analyzes the calibration gas as
an unknown stream and identifies the peaks. If all the
component peaks are identified, the GC computes the
calibration gas' energy value and performs the EV Check.

• After a successful calibration, the GC computes the gas'
energy value with the new response factors and performs
the EV Check.

GC Sales Serial
Number

The sales order number for the GC. When contacting Customer
Support, the customer should provide this number to the
Customer Support agent.

Calibration Retry
on Failure

If a calibration fails, the GC will re-run the calibration sequence.
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Calibration
Repeatability
Check

If enabled, the GC will perform a check of the repeatability of
calibration runs to the limits specified in ISO6974-1984(E) 8.2.1
Table 6. If the calibration fails to meet the conditions set forth in
the table, then the calibration is deemed to have failed and the GC
will rerun the calibration sequence.

Metrology Type Shows the metrology type that the GC is configured for.

GC Id

Identification
Number

Configuration
Checksum at
Lockout

The checksum of the configuration fields that is calculated when
the security switch is locked.

Current
Configuration
Checksum

The GC will periodically recalculate and update the configuration
checksum. This ‘current’ value will be the latest calculated value.

Checksum Update
Time

The time that the configuration checksum was last updated.

GC Mode Allows you to select an operating mode for the GC. See Section 1.8 for
more information.

Default Stream
Sequence

Sets the default sequence to be used by the indicated detector during
auto-sequencing. To create a new stream sequence or to edit an
already-created sequence, click Stream Sequence....
See Section 4.10 for more information.

After making changes, click Save to save the changes without closing the window. To save
the changes and close the window, click OK.

4.2 The Component Data Tables
MON2020 allows you to view and edit the component data tables. The number of available
component data tables depends on the GC unit configuration.

To assign a component data table to a stream, see Section 4.9.2.

1. To view a component data table, select Component Data... from the Application
menu.

The Component Data Tables window appears, displaying a list of available
component data tables.

Note

Other ways of accessing the component data tables are by pressing F6 or by clicking 
from the Toolbar.

2. Select the table that you want to view.
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The selected component data table displays.

Note
To see a different table, select it from the Choose table drown-down list.

Note
To sort the list of components by detector, and then by retention time, click Sort RT.

4.2.1 Edit a Component Data Table

Note
Table cells with a white background are editable; table cells with a turquoise background are not
editable.

To edit a cell, do the following:

1. Click on the cell.

Depending on the cell type, you will either be required to select a value from a drop-
down list, or you will be able to type in the value directly.

2. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.

The following table lists all of the editable parameters available on the Component
Data Table window. The standard values for these parameters were taken from the
second editions of the Orifice Metering of Natural Gas and Other Related Hydrocarbon
Fluids and the Compressibility Factors of Natural Gas and Other Related Hydrocarbon
Gases.

Component This drop-down list contains the complete catalog of
available components for the selected stream.

Usr Std Indicates the source of the component:

• Usr - The component was edited or defined by the user.

• Std - The component was selected from the standard list
of components and no changes were made to its standard
data.

Det # The component’s detector number.

Ret Time Time in seconds before the apex of the component’s peak will
appear. The rentention time can be set from 0 to 3600
seconds.
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CAUTION!
Ensure that the component retention times do not exceed the
analysis time, as defined by the Timed Events table. MON2020
does not automatically prevent the user from defining excessive
component retention times.

Resp Fact A component’s response factor is equal to the raw data of the
component’s peak divided by the component’s
concentration. The maximum value is 1.0E+38.

Calib Type MON2020 can perform four types of calibrations:

• Single-Level - Uses the standard calibration in which the
response factor is needed to determine the mole
percentage during the calibration.

• Fixed - During the calibration, the response factor is not
updated.

• Relative - Calibration in which a reference component is
used to compute the mole percentage.

• Multi-Level - Uses a polynomial equation to compute the
mole percentage during the calibration. Values must be
entered in the Mult-level Calib ‘a’, Mult-level Calib ‘b’,
Mult-level Calib ‘c’, and Mult-level Calib ‘d’ cells.

Calib Conc The amount, in mole percent, parts per million (ppm) or parts
per billion (ppb), of the component that is present in the
calibration gas.

Unit Indicates the unit of measure used when calculating and
displaying the component’s calibration concentration.
Options are Mole%, ppm and ppb.

Anly Meth Defines how the component concentration is computed. The
analysis method can take one of the following values:

• Area - Calculates the component concentration by
dividing the peak area by the response factor.

• Height - Calculates the component concentration by
dividing the peak height by the response factor.

• Fixed - The component concentration equals the
component's calibration concentration displayed in the
Calib Conc column of the component data table. No
calculation is performed using the response factor.

• Analog Input - The GC reads the analog input channel,
scales the raw milliampere value to engineering values
that were set in the Analog Inputs window, and uses this
value as the component concentration. No calculation is
performed using the response factor.

RT Secs Dev The maximum acceptable deviation time, in seconds, of the
new retention time from the current retention time.
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RT Upd Meth Determines when the retention time will be updated. Options
are:

• Cal - Updates the retention time only during the final
calibration run.

• Anly - Updates after each analysis.

Resp Fact % The maximum acceptable percent of deviation between the
new response factor and the current response factor.

Gross Dry BTU Gross energy content per cubic foot (ft3), assuming no water
is present.

Net Dry BTU Net energy content per cubic foot, assuming no water is
present.

Gross Dry BTU per
lb

Gross energy content per pound, assuming no water is
present.

HV Sup MJ/m3 Gross heating value in megajoules per cubic meter.

HV Inf MJ/m3 Net heating value in megajoules per cubic meter.

HV Sup MJ/kg Gross heating value in megajoules per kilogram.

HV Inf MJ/kg Net heating value in megajoules per kilogram.

Sum Factor Pri Used to calculate the compressibility factor.

Sum Factor Sec Used to calculate the compressibility factor.

CV Superior Pri Gross caloric value per kilojoule (kJ).

CV Inferior Pri Net caloric value per kilojoule (kJ).

CV Superior Sec Gross caloric value per kilojoule (kJ).

CV Inferior Sec Net caloric value per kilojoule (kJ).

Gals/1000 SCF Liquid equivalent volume in gallons/1000ft3.

Reid Vapor The component’s vapor pressure in pounds per square inch
(psia) at 100.0 °F

LBs/Gallon Liquid density for the component at base conditions.

Rel Dens Gas The relative density of the gas phase for the component at
base conditions.

Rel Dens Liquid The relative density of the liquid phase for the component at
base conditions.

Molecular Weight The molecular weight of the component, which is used to
calculate the weight percent of each component in the
sample.

Carbon Weight The molecular weight of the carbon atoms in the component.

AGA 8
Component

The name of the component according to the American Gas
Association, which is used in the AGA 8 compressibility
calculation.

Ref Comp The component not found in the calibration gas but in the
sample gas for indirect calibration. If ‘none’, normal (direct)
calibration is used.
Not editable unless the calibration type is set to Relative.
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Rel Resp Fact A fixed multiple of the response factor of the component
found in the sample gas for indirect calibration.
Not editable unless the calibration type is set to Relative.

Rel Dens Liquid
15C

The relative density in kilograms per cubic meter (kg/m3) of
the liquid phase for the component at 15 °C.

Molar Mass The mass of one mole of the component.

Mult-level Calib
‘a’

Third-order polynomial coefficient for multi-level calibrations.
Not editable unless the calibration type is set to Multi-Level.

Mult-level Calib
‘b’

Second-order polynomial coefficient for multi-level
calibrations.
Not editable unless the calibration type is set to Multi-Level.

Mult-level Calib
‘c’

First-order polynomial coefficient for multi-level calibrations.
Not editable unless the calibration type is set to Multi-Level.

Mult-level Calib
‘d’

Zero-order polynomial coefficient for multi-level calibrations.
Not editable unless the calibration type is set to Multi-Level.

Component Code An index number that corresponds to the standard
component numbers taken from the American Gas
Association. Up to 20 components can be defined per data
table.

4.2.2 Add a component to a Component Data Table
To add a component to a component data table, do the following:

1. Select Component Data... from the Application menu.

The Component Data Tables window appears, displaying a list of available
component data tables.

Note

Other ways of accessing the component data tables are by pressing F6 or by clicking 
from the Toolbar.

2. Select the table that you want to view.

The selected component data table displays.

Note
To sort the list of components by detector, and then by retention time, click Sort RT.

3. If you want to add the component above the currently selected component, click
Insert before. If you want to add the component below the currently selected
component, select Insert after from the Insert arrow.

Application

76



4. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.

4.2.3 Remove a component from a Component Data Table
To remove a component from a component data table, do the following:

1. Select Component Data... from the Application menu.

The Component Data Tables window appears, displaying a list of available
component data tables.

Note

Other ways of accessing the component data tables are by pressing F6 or by clicking 
from the Toolbar.

2. Select the table that you want to view.

The selected component data table displays.

Note
To sort the list of components by detector, and then by retention time, click Sort RT.

3. Select the component that you want to remove.

4. Click Delete.

5. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.

4.2.4 View the standard values for a component
If a component’s values have been changed by the user, it is still possible to view the
standard values for that particular component. To view the standard values for a
component, do the following:

1. Select Component Data... from the Application menu.

The Component Data Tables window appears, displaying a list of available
component data tables.
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Note

Other ways of accessing the component data tables are by pressing F6 or by clicking 
from the Toolbar.

2. Select the table that you want to view.

The selected component data table displays.

Note
To sort the list of components by detector, and then by retention time, click Sort RT.

3. Click Std Values (F3).

The Standard Component Values window displays.

4. When you are finished viewing the window, click Close.

4.2.5 Display raw data from the Component Data table
To view the raw data for the displayed component data table, do the following:

1. Select Component Data... from the Application menu.

The Component Data window displays.

2. Click Raw Data (F4) or press F4.

The Select dialog displays, listing the streams that are associated with the
component data table.

3. Double-click the desired stream.

The Raw Data window appears, listing the peak raw data from the last run of the
stream represented by the component data table.

The following data displays for each peak:

Peak No. Numerical identifier for the peak, listed by the order of
discovery.

Ret Time Time, in seconds, that the component eluted.

Peak Area The area under the peak.

Peak Height The maximum height of the peak.

Det The detector associated with the peak.

Method Method of peak end detection. Options are:

• 1 (Baseline). Baseline termination occurs when the absolute
values of twelve successive slope calculations are less than
the slope sensitivity.
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• 2 (Fused Peak). A fused peak is found if a peak onset is
detected subsequent to the discovery of a peak crest and
before the baseline termination is detected.

• 3 (Last Fused Peak). The last peak in a group of fused peaks.

• 4 (Tangent Skim). Baseline termination occurs when the
current level is lower than the Start Baseline value and the
slope at the point is negative and smaller in magnitude than
the average slope from the beginning of the peak.

• 100 (Inhibit). An Inhibit On event in the Timed Events table
caused the peak to be terminated.

• 300 (Forced Integration). An Integration Off event in the
Timed Events table caused the peak to be terminated.

• 500 (Summation). A Summation Off event in the Timed
Events table caused the peak detection logic to sum
together the peak areas under multiple peaks between the
Summation On and Summation Off events and to add an
entry for an artificial peak with its area set to the composite
area under the constituent peaks.

Baseline Start The raw detector counts at the start of an integration. For
example, if the peak starts at 10 seconds, then the raw detector
counts at 10 seconds becomes the Baseline Start value.

Baseline End The raw detector counts at the end of an integration. For
example, if the peak ends at 35 seconds, then the raw detector
counts at 35 seconds becomes the Baseline End value.

Integration
Start

Time, in seconds, when integration started.

Integration
Stop

Time, in seconds, when integration stopped.

Peak Width @
Half Height

The width of the peak taken at half of the peak’s height.

Partial Peak If Yes, then the Partial Peak value is used in the summation
calculation; if No, then the Partial Peak value is not used in the
summation calculation.

4. Click Close to return to the Component Data window.

4.2.6 Change the default C6+ mixture ratio
The C6+ component that is detected by the GC is actually a mixture of up to four heavy
hydrocarbons -- from hexane and above. When the energy value and other physical
properties are calculated for the mixture, the GC assumes a ratio of heavy hydrocarbon
components is used for the C6+ value. By default, there are four pre-defined ratios:

Component C6/C7/C8 percentages

C6+ 47/35/17 47.466/35.34/17.194
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Component C6/C7/C8 percentages

C6+ GPA 2261-99 60.0/30.0/10.0

C6+ 57/28/14 57.143/28.572/14.285

C6+ 50/50/0 50.0/50.0/0

To define a different ratio, do the following:

1. Select Component Data on the Application menu.

The Component Data window opens.

Note
You can also click F6 to open the Component Data window.

2. Click the first field in the Component column. This is the C6+ component field and it
will display one of the four ratios described above.

A drop-down list opens.

3. Select C6+ (User Def.) from the drop-down list.

4. Click Edit Percentage.

The C6+ User Def. window opens.

5. Enter a composition percentage for each component.

The Total Percentage, which must equal 100 and is displayed on the window's title
bar, will update with the sum of the four ratios.

6. Click OK.

The Component Data window closes. The C6+ row on the Component Data table
will be updated based on the new ratio.

7. Click Save to accept the changes without closing the window; click OK to accept the
changes and to close the window.

4.3 The Timed Events tables
Use this function to view and/or edit the timed events tables assigned to and used by
particular gas streams. The number of available timed events depends on the GC unit
configuration. The standard GC application contains four timed events tables.

Note
See Section 2.5.2 for more information about editing timed events from the Chromatogram Viewer.
To assign a timed events table to a stream, see Section 4.9.2.
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1. Select Timed Events... from the Application menu. The Timed Events Tables selector
window appears, displaying a list of available timed events tables.

Note

Other ways of accessing the timed event tables are by pressing F5 or by clicking  from
the Toolbar.

Note
If only one timed events table is available, it will display immediately, bypassing the Timed
Events Tables selector window.

2. Select the table that you want to view.

The selected timed events table displays.

Note
To sort events by time, click the appropriate Sort button.

3. To see a different timed events table, select it from the Choose table drop-down list.

4.3.1 Configure valve events
Valve-related events are grouped on the upper left side of the Timed Events window. To
edit valve-related events, do the following:

1. Select Timed Events... from the Application menu.

The Timed Events Tables selector window appears, displaying a list of available timed
events tables.

Note

Other ways of accessing the timed event tables are by pressing F5 or by clicking  from
the Toolbar.

Note
If only one timed events table is available, it will display immediately, bypassing the Timed
Events Tables selector window.

2. Select the table that you want to view.

The selected timed events table displays.

Note
To sort events by time, click the appropriate Sort button.

3. Click on the cell that you want to edit.
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Depending on the cell type, you will either be required to select a value from a drop-
down list, or you will be able to type in the value directly. The following list describes
the valve-related parameters that are available on the Timed Events window.

TEV Type The type of device associated with the event. You have the following
choices:

• Valve #

• DO # - A discrete output.

• Strm Sw - Switches to the next stream in the sequence.

• Cal Gas Save - Sets the start or end time for the Cal-Gas SaverTM

feature.

Valve/
DO #

Use the drop-down menu to select the specific valve or discrete output
that should be used for the event.
This column does not apply if Strm Sw was selected from the TEV Type
column.

State Turns the valve or discrete output on or off, or sets the FID to high or
low.
This column does not apply if Strm Sw was selected from the TEV Type
column.

Time Indicates the time, in seconds, that the event should occur during the
analysis. Enter a value between 0.0 and 3600.0.

Note
Event times must be less than the analysis time.

4. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.

4.3.2 Configure integration events
Integration-related events are grouped on the upper right side of the Timed Events
window. To edit integration-related events, do the following:

1. Select Timed Events... from the Application menu.

The Timed Events Tables selector window appears, displaying a list of available timed
events tables.

Note

Other ways of accessing the timed event tables are by pressing F5 or by clicking  from
the Toolbar.
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Note
If only one timed events table is available, it will display immediately, bypassing the Timed
Events Tables selector window.

2. Select the table that you want to view.

The selected timed events table displays.

Note
To sort events by time, click the appropriate Sort button.

3. Double-click on the cell that you want to edit.

Depending on the cell type, you will either be required to select a value from a drop-
down list, or you will be able to type in the value directly. The following list describes
the integration-related parameters that are available on the timed events window.

TEV
Type

The type of integration event. You have the following options:

• Inhibit: Set to Off to start look for a peak; set to On to stop looking for
a peak.

• Integrate: Set to On and Off to set a region in which the area under
the trace is computed as a peak regardless of peak onset discovery.
The resulting area is added to the raw data as a peak with the
retention time set to the Integration Off time.

• Summation: Set to On and Off to set a region in which the area of all
peaks found will be added together to create a single summed value.
The peaks that contribute to the summation are marked as partial
peaks in the raw data table, and the summation total is added to the
raw data as a new peak with the retention time set to the Summation
OFF time.

• Slope Sens: The peak starts when the slope of six consecutive points is
greater than the slope sensitivity value that is displayed in the Value
column; the peak ends when the slope of six consecutive points is less
than the slope sensitivity value that is displayed in the Value column.

• Peak Width: Each point displayed on the graph represents the
average of N raw data points, where N is the value displayed in the
corresponding Value column.

• Single Base: Determines how the baseline is drawn under a peak.

- Off: The baseline is drawn from the point of peak onset to the
point of peak termination. This is not necessarily horizontal and if
fact usually has a slight slope. (Default)

- Bgn: Draws a horizontal baseline from the point of peak onset to a
point above or below the peak termination.

- End: Draws a horizontal baseline from a point above or below the
peak onset to the point of peak termination.

• Fused Ovrrd: Determines how the baseline is drawn when two or
more peaks are ‘fused’ together.
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- Off: A single baseline is drawn from the onset of the first peak of
the fused group to the termination of the last peak of the group.
(Default)

- On: Causes a separate baseline to be drawn for each peak in the
fused group.

• Negative Peak: Determines whether peak detection will detect
inverted peaks, which are peaks that point downward from the
baseline. At any given moment we can detect positive or negative
peaks but not both at once.

- Off: Detect positive peaks. (Default)

- On: Detective negative peaks.

TEV
Type

SW Auto Zero: Re-zeros the baseline of the trace at the specified time for
the specified detector. Used after a FID gain change event or a spectrum
gain change event.

Note
The Single Base and Fused Override events can act together to produce
multiple horizontal baselines, at different heights, for a fused peak group.

Value The values available depend on the integration type selected from the
TEV Type column.

• Slope Sensitivity and Peak Width: Enter the number of points,
between 1 and 99, to be used.

• Single Baseline: Select Off, End, Bgn.

• SW Auto Zero: No options.

• All other integration types: Select On or Off.

Det # The ID number of the detector that will be affected by the event. Valid
values are 1 and 2.

Time Indicates the time, in seconds, that the event should occur during the
analysis. Enter a value between 0.0 and 3600.0.

Note
Event times must be less than the analysis time.

4. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.
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4.3.3 Configure spectrum gain events
The spectrum gain feature graphically magnifies the size of a chromatogram’s peaks. The
data itself is not affected; only the presentation of the data. This feature can be useful for
viewing peaks that are otherwise too small to examine or so large that the top of the peak
can not be seen.

Spectrum gain-related events are grouped on the lower left side of the Timed Events
window. To edit spectrum gain-related events, do the following:

1. Select Timed Events... from the Application menu.

The Timed Events Tables selector window appears, displaying a list of available timed
events tables.

Note

Other ways of accessing the timed event tables are by pressing F5 or by clicking  from
the Toolbar.

Note
If only one timed events table is available, it will display immediately, bypassing the Timed
Events Tables selector window.

2. Select the table that you want to view.

The selected timed events table displays.

Note
To sort events by time, click the appropriate Sort button.

3. Click on the cell that you want to edit.

Depending on the cell type, you will either be required to select a value from a drop-
down list, or you will be able to type in the value directly. The following list describes
the spectrum gain-related parameters that are available on the timed events
window.

Det # The ID number of the detector that will be affected by the event. Select 1 or
2.

Gain Enter a value between 0 and 64. This is the exponent value in the following
expression: 2gain value. For example, a value of 0 means no gain is applied; a
value of 5 means the gain is increased to 32 times it’s original value.

Time Indicates the time, in seconds, that the event should occur during the
analysis. Enter a value between 0.0 and 3600.0.

Note
Event times must be less than the analysis time.
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4. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.

4.3.4 Set the cycle and analysis time
To set the cycle and analysis time, do the following:

1. Select Timed Events... from the Application menu.

The Timed Events Tables selector window appears, displaying a list of available timed
events tables.

Note

Other ways of accessing the timed event tables are by pressing F5 or by clicking  from
the Toolbar.

Note
If only one timed events table is available, it will display immediately, bypassing the Timed
Evetns Tables selector window.

2. Select the table that you want to view. The selected timed events table displays.

The Analysis Time section is located on the lower right side of the Timed Events
window.

Note
To sort events by time, click the appropriate Sort button.

3. Click on the Analysis Time cell and enter a value, in seconds, between 0 and 3600.

4. Click on the Cycle Time cell and enter a value, in seconds, between 0 and 3620.

Note
The Cycle Time must be at least 10 seconds greater than the Analysis Time.

5. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.

4.3.5 Remove an event from the Timed Event Table
To remove an event from one of the Valve Events, Integrate Events, or Spectrum Gain
Events tables on the Timed Events window, do the following:
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1. Select Timed Events... from the Application menu.

The Timed Events Tables selector window appears, displaying a list of available timed
events tables.

Note

Other ways of accessing the timed event tables are by pressing F5 or by clicking  from
the Toolbar.

Note
If only one timed events table is available, it will display immediately, bypassing the Timed
Events Tables selector window.

2. Select the table that you want to view.

The selected timed events table displays.

Note
To sort events by time, click the appropriate Sort button.

3. Select the event that you want to delete.

4. Click the appropriate Delete button.

4.3.6 Add an event to the Timed Event Table
To add an event to one of the Valve Events, Integrate Events, or Spectrum Gain Events
tables on the Timed Events window, do the following:

1. Select Timed Events... from the Application menu.

The Timed Events Tables selector window appears, displaying a list of available timed
events tables.

Note

Other ways of accessing the timed event tables are by pressing F5 or by clicking  from
the Toolbar.

Note
If only one timed events table is available, it will display immediately, bypassing the Timed
Events Tables selector window.

2. Select the table that you want to view.

The selected timed events table displays.
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Note
To sort events by time, click the appropriate Sort button.

3. If you want to add the event above the currently selected event, click the
appropriate Insert before button. If you want to add the event below the currently
selected event, select Insert after from the Insert arrow and then click the button.

The new event will be added to the table.

4. Select a Type, Valve/DO#, and State for the event, if necessary, and enter a new Time
for the event also.

5. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.

4.4 The Validation Data Tables
Use the validation data table to hold information about the composition of the gas that is
used in the validation run. During a validation run, the GC performs a test analysis of a gas
with a known component composition to verify that the GC is working properly.

To add a component to the validation data table, do the following:

1. Select Validation Data from the Application menu.

The Validation Data window displays.

2. If the appropriate table is not displayed, select it from the Choose Table drop-down
list.

3. Select a new variable by clicking on the appropriate drop-down list under the
Variable column.

For a demonstration of how to use the context-sensitive variable selector, see 
Section 1.11.

4. Enter the component’s concentration percentage in the appropriate cell under the
Nominal Value column.

To ensure accuracy, this value, which is compared to the GC’s analysis results at the
end of the validation run, should be taken from the documentation provided with
the gas cylinder.

5. Enter a value in the appropriate Percent Deviation cell.

Example: If you enter 10 in this field, and the GC’s analysis result for the component
differs from the component’s Nominal Value by ±10% or more, then an alarm is
generated.

6. To copy a component variable to the next empty row, click C + Copy.
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The component will be increment to the next available component—for example,
from Ammonia to Benzene. The Nominal Value and Percent Deviation values will also
be copied.

Note
You can select and copy more than one component at a time.

If there are no components available, instead of copying the component, MON2020
will display the following message:

7. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.

4.5 Calculations
MON2020’s Calculations submenu allows you to activate and define how the output of
standard or user-defined chromatograph analysis data is used in various calculations.

You can configure the following types of calculations:

• Control - Allows you to designate, by streams, the standard calculations that should
be performed from the analysis data.

• Averages - Allows you to designate, by streams and components, averages of
standard calculations MON2020 should perform.

• User Defined - Allows you to create and edit customized calculations using analysis
data. See Appendix A for more information.

• Dewpoint - This optional feature allows you to calculate dewpoint temperatures
and to estimate the cricondentherm, which is the temperature above which no
liquid will form at any pressure.

4.5.1 Set standard calculations by stream
To designate, by streams, the standard calculations—for example, mole percent, liquid
volume, gas density, Wobbe index, etc.—that should be performed from the analysis data,
do the following:

1. Select Applications → Calculations → Control....
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The Control Calculations window appears.

2. Select a check box for a given stream to turn the calculation ON for that stream; click
to clear the check box for a given stream to turn the calculation OFF for that stream.

You can use the arrow keys to move from one stream cell to another, and you can
press the space bar to toggle the calculation on or off.

3. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.

Note
To save the information on this screen to a tab-delimited text file, right-click on the table and
select Save Sheet from the right-click menu.

Note
To copy the information on this screen to the clipboard so that it can be pasted into another
application such Microsoft Word or Excel, right-click on the table and select Copy to clipboard
from the right-click menu.

Note
To print the information on this screen, right-click on the table and select Print Sheet from
the right-click menu.

4.5.2 Edit average calculations
To designate, by streams and components, averages of standard calculations the GC
should perform, do the following:

1. Select Applications → Calculations → Averages....

The Averages Calculations window appears.

2. Select a new variable by clicking on the appropriate drop-down list under the
Variable column.

For a demonstration of how to use the context-sensitive variable selector, see 
Section 1.11.

Note
The averages will be assigned in the default Modbus map in the order that they appear in the
table.

3. Select the type of average to be calculated from the Average Type drop-down list.
You have the following options:

Unused An average will not be calculated for the variable.
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Hourly Averages will be calculated at the start and end of every hour.

24 Hour Averages will start and stop once a day at the time displayed in the
Reset Time field from the Averages Reset section.

Weekly Averages will start and stop once a week at the time displayed in the
Reset Time field and on the day entered in the Weekday field, from the
Averages Reset section.

Monthly Averages will start and stop once a month at the time displayed in the
Reset Time field and on the day of the month entered in the Day field,
from the Averages Reset section.

Variable Averages will start and stop for the duration entered in the Hours
column starting from the Reset Time.

Everyrun No average will be stored; instead, the current value at the end of the
run will be stored.

4. To set a custom start and stop time for a particular calculation, set the Average Type
for the calculation to Variable and enter the desired time in the Hours cell.

Note
The custom Hours setting overrides the Reset Time setting.

5. Set the appropriate Restart Flag to one of the following options:

NO The current average will not be reset.

CUR The current average will be cleared and a new average calculation will start.

6. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.

Note
To save the information on this screen to a tab-delimited text file, right-click on the table and
select Save Sheet from the right-click menu.

Note
To copy the information on this screen to the clipboard so that it can be pasted into another
application such Microsoft Word or Excel, right-click on the table and select Copy to
clipboard from the right-click menu.

Note
To print the information on this screen, right-click on the table and select Print Sheet from
the right-click menu.

4.5.3 View an archive of averages for a given variable
To view an archive of averages for a given variable, do the following:
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1. Select Applications → Calculations → Averages....

The Averages Calculations window appears.

2. Click on the desired variable to view its history.

3. Click Archive.

The archive data screen appears.

Note
To copy the information in this table to the clipboard so that it can be pasted into another
application such as Microsoft Word or Excel, select the cells that you want to copy and then
press CTRL + C to copy the information to the clipboard.

4.5.4 Copy an average calculation configuration
To copy the average calculation configuration from a highlighted row and apply them to
the next row, do the following:

1. Select Applications → Calculations → Averages....

The Averages Calculations window appears.

2. Select the row that you want to copy.

3. Click S + Copy.

The stream will be copied to the next row and incremented to the next available
stream—for example, from Stream 2 to Stream 3.

Note
You can select and copy more than one stream at a time.

If there are no streams available, instead of copying the stream, MON2020 will
display the following message:

4. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.
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4.5.5 Copy component settings
To copy the component settings from a highlighted row and apply them to the next row,
do the following:

1. Select Applications → Calculations → Averages....

The Averages Calculations window appears.

2. Select the row that contains the component that you want to copy.

3. Click the arrow beside the S + Copy button to switch it to C + Copy.

4. Click C + Copy. The component will be copied to the next row and incremented to
the next available component—for example, from Ammonia to Benzene.

Note
You can select and copy more than one component at a time.

If there are no components available, instead of copying the component, MON2020
will display the following message:

5. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.

4.6 Set the calculation method to GPA or ISO
MON2020 can be configured to perform GPA calculations, ISO calculations, or both.

To set which type of calculation method MON2020 should use, do the following:

1. Select Applications → Calculations → Configuration....

The Calculations Configuration window displays.

2. Select the method from the Calculation Method drop-down list.

The options are:

• GPA
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• ISO

• GPA & ISO

3. Select a unit of measure from the Base Pressure Units drop-down list.

The options are:

• PSI

• Bar

• kPa

4. If you set the calculation method to GPA or GPA & ISO, you can also set the
following options:

• GPA Calculator Units (U.S. or S.I.)

• GPA Pressure Display (PSI, Bar or kPa)

5. 5. If you set the calculation method to ISO or GPA & ISO, you can also set the
following options:

• ISO Pressure Display (Bar or kPa)

• Pri ReferenceTemperatures

- 0C/0C

- 0C/15C

- 0C/20C

- 15C/0C

- 15C/15C

- 15C/20C

- 20C/0C

- 20C/15C

- 20C/20C

- 25C/0C

- 25C/15C

- 25C/20C

Note
Updating this field also updates the primary values—Sum Factor Pri, CV Superior Pri and CV
Inferior Pri—that display in the Component Data table.

• Sec Reference Temperatures (same options as Pri Reference Temperatures)

Note
Updating this field also updates the secondary values—Sum Factor Sec, CV Superior Sec and
CV Inferior Sec—that display in the Component Data table.

• Primary CV Units

- kilojoules per cubic meter (kJ/m3)
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- kilocalories per cubic meter (kCal/m3)

- kilowatt hours per cubic meter (kWhrs/m3)

- megajoule per cubic meter (MJ/m3)

- megajoule per kilogram (MJ/kg)

- megajoule per mole (MJ/mole)

• Secondary CV Units (same options as Primary CV Units)

6. Click OK to accept the changes and close the window.

Note
Click Save to accept the changes without closing the window.

4.7 Set alarm limits
Use this function to set threshold limits for GC analysis data. When a limit is exceeded, an
alarm is activated and logged. See Section 5.1.3 for information on Alarm Logs.

To set an alarm limit for a variable, do the following:

1. Select Applications → Limit Alarms....

The Limit Alarms window displays.

2. Select a new variable by clicking on the appropriate drop-down list under the
Variable column.

For a demonstration of how to use the context-sensitive variable selector, see 
Section 1.11.

3. To change the alarm type, click the appropriate cell under the Type column.

You have the following the options:

• Off - Turns off the alarm.

• All - Use high and low limits to activate alarms. Enter the lower limit value in the
appropriate cell under the Low Limit column. Enter the upper limit value in the
appropriate cell under the High Limit column.

• High - If the status value of the variable rises above the value set in the
corresponding High Limit column, the high limit alarm is activated.

• Low - If the status value of the variable falls below the value set in the
corresponding Low Limit column, the low limit alarm is activated.

4. If you want a discrete output to activate when the alarm triggers, click on the
appropriate cell under the DO # to Set column and select it from the drop-down list.

5. To prevent or allow averaging when the alarm triggers, double-click on the
appropriate cell under the Inhibit Avg column, and select one of the following
options:

• True - Inhibits averaging when the alarm is active.
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• False - Allows averaging when the alarm is active.

6. To customize the text of the alarm message, enter the new text in the appropriate
cell under the User Alarm Text column.

When the alarm triggers, this text will display under the Alarm Message column on
the Unack/Active Alarms window.

Note
If an alarm message is changed, all affected alarm entries, including those previously
recorded, will include that change.

7. To enable or disable the use of the customized alarm text, select True or False from
the appropriate cell under the Inhibit Alarm Text column.

8. To apply the current limit alarm conditions to the stream, click S + Copy.

The conditions will be applied to the next available stream--for example, from
Stream 2 to Stream 3.

If there are no streams available, instead of copying the stream, MON2020 will
display the following message:

9. Click C + Copy.

The alarm limit conditions will be copied to the next available component--for
example, from Ammonia to Benzene.

If there are no more components available, instead of copying the component,
MON2020 will display the following message:

10. If you want the GC to halt after the current analysis when an alarm is triggered, do
the following:

a. Select the Halt on Alarm? checkbox.
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b. Enter a value in the Delay column for the length of time, in seconds, that the
alarm condition should exist before the Halt command is executed.

You can enter a value between 0 and 1800.

11. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.

4.8 System alarms
To edit system alarms, do the following:

1. Select System Alarms... from the Applications menu.

The System Alarms window displays.

2. If you want a discrete output to activate when the alarm triggers, click on the
appropriate cell under the DO # to Set column and select it from the drop-down list.

3. To prevent or allow averaging when the alarm triggers, double-click on the
appropriate cell under the Inhibit Avg column, and select one of the following
options:

• True - Inhibits averaging when the alarm is active.

• False - Allows averaging when the alarm is active.

4. To enable the alarm check the checkbox under the Is Alarm Enabled? column; to
disable the alarm, uncheck the checkbox under the Is Alarm Enabled? column; to
disable the alarm.

5. To halt the GC after the current analysis when an alarm is triggered, check the Halt
on Alarm? checkbox.

6. To set the amount of time that should pass between the recognition of an alarm
condition and the display of the alarm, enter a value between 0 and 1800 in the
Delay column.

7. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.

4.9 Streams
MON2020 allows you to do the following:

• Assign component data tables, validation data tables, and timed events tables to a
particular stream.

• Designate a stream for analysis, validation, or calibration.
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• Control automatic calibration or validation parameters, such as the total number of
runs, runs to be averaged, starting times, and time between automatic calibrations
and baseline runs.

4.9.1 Designate how a stream will be used
To assign a function to a stream, do the following:

1. Select Streams... from the Application menu.

The Streams window opens.

2. For the appropriate stream, select one of the following options from the Usage
column:

• Unused - Not used

• Cal - Calibration

• Analy - Analysis

• Validate - Validation

3. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.

4.9.2 Link a valve with a stream
Multiple streams can be linked to the same valve to allow for different uses of that
stream—for example, the calibration gas can be assigned to both calibration and validation
runs.

1. Select Streams... from the Application menu.

The Streams window opens.

2. Go to the Stream Valve column for the corresponding stream and select the
appropriate valve from the drop-down list.

Details about the valves in the drop-down list can be viewed from the Valves
window.

3. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.

4. If the sample stream is selected when the valve is on, check the corresponding
Stream Valve On to Select checkbox; if the sample stream is selected when the valve is
off, uncheck the corresponding Stream Valve On to Select checkbox.
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4.9.3 Assign a data table to a particular stream
To assign a component data table, a validation data table, or a timed events table to a
stream, do the following:

1. Select Streams... from the Application menu.

The Streams window opens.

2. For the appropriate stream, if Usage is set to Cal or Analy, select a component data
table from the CDT column and a timed events table from the TEV column.

3. For the appropriate stream, if Usage is set to Validate, select a component data
table from the CDT column, a timed events table from the TEV column, and a
validation data table from the VDT column.

4. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.

4.9.4 Change the base pressure for a stream
Base pressure is used for the GPA/AGA physical properties calculations.

Note
The base pressure for the ISO calculation is always 101.325 kPaA.

To change the base pressure for a stream, do the following:

1. Select Streams... from the Application menu.

The Streams window opens.

2. For the appropriate stream, double-click on the corresponding cell under the Base
Pressure column and enter an new value.

Note
The GPA/AGA calculations can also be done at up to three additional optional pressures. Use
the Optional Pressure 1, Optional Pressure 2, and Optional Pressure 3 columns for this purpose.

3. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.
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4.10 Create a stream sequence for a detector
A stream sequence defines the order of stream analysis for a detector. You can create
three sequences can be configured; each can be activated by a digital input device or via a
Modbus link. To create or edit a stream sequence, do the following:

1. Select Stream Sequence... from the Application menu.

The Stream Sequence window displays.

2. Each stream sequence table can contain up to three sequences--a primary, or
default, sequence, and two auxiliary sequences.

3. Double-click the appropriate cell under the Strm Seq Name column to give your new
sequence a name, or to edit the name of an existing sequence. Type in the new
name.

4. To define which discrete input should activate the sequence, select it from the drop-
down list of the appropriate cell under the Seq Activate DI column.

Note
No two sequences can be activated by the same discrete input.

5. To define the order of analysis, double-click the appropriate cell under the Seq of
Strms column and enter the numbers for the streams, separated by commas, that
should be analyzed.

Example: For example 1,2 would continuously analyze stream 1 followed by stream
2. A sequence of 1,1,1,2 would analyze stream 1 three times and then analyze
stream 2 every fourth time in the sequence.

6. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.

4.11 Communications
Use this window to configure the GC's ports.

The following table lists the Communication window's parameters:

Note
During Modbus serial communications MON2020 can differentiate between RTU or ASCII protocols;
however, the data bit, stop bit, and parity settings still need to be manually configured.

Label The name of the group of settings.

Modbus Id Identification number of the Modbus device.
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Baud Rate The baud rate setting. Options are: 1200, 2400, 9600, 19200, 38400,
and 57600.
For high performing PCs, set the baud rate to 38400. If you experience a
communications failure at this rate, set the baud rate to 9600. Baud rate
settings less than 9600 may result in real-time delivery that is
unacceptably slow.

Data Bits The number of data bits. Options are 7 (ASCII) and 8 (RTU). The default
setting is 8.

Stop Bit The number of stop bits. The only setting is 1.

Parity The parity check method. For use with the ASCII protocol only. Options
are None (default), Even and Odd.

HW Flow
Cntrl

Allows you to enable or disable hardware handshaking signals (RTS/
CTS).

MAP File Points to the file that contains the registers that should be used.

Port Allows you to set the type of protocol to be used for the port: RS232 or
RS485.
If the port is set to RS485, additional configuration steps are required;
see your GC manual for more information.

4.11.1 Create or edit registers
You can map GC data to Modbus registers and generate MAP files, which can then be
associated with communications ports.

For a list of variable assignments made to all registers, consult the "Communication"
section of the GC Config Report, which can be accessed from the Logs/Reports menu.

To map GC data to Modbus registers, do the following:

1. Select Communication... from the Application menu.

The Communication window appears.

2. Click Registers.

The Modbus Map Editor window appears.

3. To view or edit registers that are contained in an existing MAP file, click on the Select
MAP File drop-down list and select the appropriate file.

The registers will load into the table.

Note
Not all parts of a MAP file can be edited. The parts that can be edited are white; the read-only
parts are turquoise.

4. To edit a cell, double-click it.

You can edit the following parameters:
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Register
Number

Displays the number for the Modbus registers that will be polled by
a connected data acquisition system.

Data Type Describes the type of data that is stored in the register.
Options are:

• BOOLEAN. Has two states ON (1) or OFF (0).

• INT. 16-bit unsigned integer.

• LONG. 32-bit signed integer

Note
If the Modbus data type is Usr Modbus, each long value uses two
registers; if the data type is SIM2251, each long value uses a single
register.

• ULONG. 32-bit unsigned integer

• FLOAT. 32-bit floating point.

Note
If the Modbus data type is Usr Modbus, each floating point value uses
two registers; if the data type is SIM2251, each floating point value
uses a single register.

• Bitmap(INT)

• Bitmap(LONG)

• SCALED_FP1
...

• SCALED_FP32

If one of the scaled floating point options is chosen, the Zero Scale
and Full Scale values for that option will display in the appropriate
column cells.
SIM_2251 registers use only the FLOAT data type.

Variable(s) Displays the variable(s) whose value is to be stored in the register.
To change the variable, see Section 4.11.3.

Access Determines whether the register will be read-only (RD_ONLY) or
read/write (RD_WR).

5. To copy the component settings from a highlighted row and apply them to the next
row, click C + Copy.

This feature also increments the Component value to the next available component
(e.g., incrementing from Ammonia to Benzene), per the GC application. An error
message displays when the last available component is reached.

6. To copy the stream settings from a highlighted row and apply them to the next row,
click S + Copy.
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This feature also increments the Stream value to the next available stream (e.g.,
incrementing from Stream 2 to Stream 3), per the GC application. An error message
displays when the last available stream is reached.

7. To delete a row, click Delete.

8. To insert a row, click Insert.

9. To check for conflicting register assignments, click Check.

MON2020 will check the table and if it encounters a conflict it will display the
following message:

Review the table to locate the conflicting registers and change one.

10. To save the MAP file, do the following:

a. Click Export.

MON2020 validates the table for errors—for instance, ensuring that no two
registers share a register number. If any errors are found MON2020 displays the
appropriate error message. When no errors are found, the Save As window
displays.

b. Enter a new name for the file or select the file that you want to overwrite.

c. Click Save.

4.11.2 Create a MAP file
1. Select Communication... from the Application menu.

The Communication window appears.

2. Click Registers.

The Modbus Map Editor window appears.

3. Click New.

A new row will be added to the table and the column headings will be empty.

4. From the Register Type drop-down list, select the type of PLC emulation protocol you
want to use.
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You have two options: User_Modbus, which is a PLC emulation Modbus protocol
that can use scaling to convert floating point numbers to integers; and SIM_2251,
which emulates the Daniel 2500 communication protocol and is a simulation of the
2251 GC controller.

Note
The table’s column headers change based on which protocol is selected.

5. If you want to base the MAP file on an existing MAP file, do the following:

a. Click Import.

The Open window displays.

b. Select the file that you want to import and click Open.

The registers from the selected file will load into the table.

6. To edit a cell, double-click it.

You can edit the following parameters:

Register
Number

Displays the number for the Modbus registers that will be polled by
a connected data acquisition system.

Data Type Describes the type of data that is stored in the register.
Options are:

• BOOLEAN. Has two states ON (1) or OFF (0).

• INT. 16-bit unsigned integer.

• LONG. 32-bit signed integer

Note
If the Modbus data type is Usr Modbus, each long value uses two
registers; if the data type is SIM2251, each long value uses a single
register.

• ULONG. 32-bit unsigned integer

• FLOAT. 32-bit floating point.

Note
If the Modbus data type is Usr Modbus, each floating point value uses
two registers; if the data type is SIM2251, each floating point value
uses a single register.

• Bitmap(INT)

• Bitmap(LONG)

• SCALED_FP1
...
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• SCALED_FP32

If one of the scaled floating point options is chosen, the Zero Scale
and Full Scale values for that option will display in the appropriate
column cells.
SIM_2251 registers use only the FLOAT data type.

Variable(s) Displays the variable(s) whose value is to be stored in the register.
To change the variable, see Section 4.11.3.

Access Determines whether the register will be read-only (RD_ONLY) or
read/write (RD_WR).

7. To copy the component settings from a highlighted row and apply them to the next
row, click C + Copy.

This feature also increments the Component value to the next available component
(e.g., incrementing from Ammonia to Benzene), per the GC application. An error
message displays when the last available component is reached.

8. To copy the stream settings from a highlighted row and apply them to the next row,
click S + Copy.

This feature also increments the Stream value to the next available stream (e.g.,
incrementing from Stream 2 to Stream 3), per the GC application. An error message
displays when the last available stream is reached.

9. To delete a row, click Delete.

10. To insert a row, click Insert.

11. To check for conflicting register assignments, click Check.

MON2020 will check the table and if it encounters a conflict it will display the
following message:

Review the table to locate the conflicting registers and change one.

12. To save the MAP file, do the following:

a. Click Export.

MON2020 validates the table for errors—for instance, ensuring that no two
registers share a register number. If any errors are found MON2020 displays the
appropriate error message. When no errors are found, the Save As window
displays.

b. Enter a new name for the file or select the file that you want to overwrite.
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c. Click Save.

4.11.3 Assign a variable to a register
To assign a variable to a register, from the Modbus Map Editor window, double-click the
appropriate Variable(s) cell and select a new variable.

For a demonstration of how to use the context-sensitive variable selector, see Section 1.11.

4.11.4 View or edit scales
MON2020 uses scales to convert floating point values to integers.

MON2020 supports 32 different scales that are labelled SCALED_FP1 through
SCALED_FP32. The Data Type column on the Modbus Map Editor window displays the type
of scale, if any, that is being used for a particular register. If a scale is being used, the Zero
Scale and Full Scale columns will display the lower and upper values for the chosen scale.

To view the list of scales, select Application → Communication... → Registers and click
Edit Scales from the Modbus Map Editor window. The Edit Scales window displays all of the
scales, along with each scales lower and upper values.

Use the following formula to calculate the variable’s integer value:

where:

RF = Full Scale, range

RZ = Zero Scale, range

SF = Full Scale, scale

SZ = Zero Scale, scale

Dfp = Floating Point value

For example:

RF = 65535

RZ = 0

SF = 100 (from SCALED_FP1)

SZ = 0 (from SCALED_FP1)

Dfp = 97.13 (scaled percent for methane)
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To edit or create your own scale, do the following:

1. Select Application → Communication... → Registers and click Edit Scales from the
Modbus Map Editor window.

The Edit Scales window displays.

2. Double-click on the appropriate cell and enter a new value.

3. Click OK to save the changes and close the window.

4.12 Configure an Ethernet port
To configure an Ethernet port, select Ethernet Ports... from the Application menu. The
Ethernet Ports window displays.

The following list describes the Ethernet ports’ parameters:
Ethernet 1 IP Address IP address to use to connect to the GC's RJ-45 Ethernet port.

Ethernet 1 Subnet Mask Subnet mask for the IP address of the GC's RJ-45 Ethernet
port.

Ethernet 1 Gateway Gateway address for the GC's RJ-45 Ethernet port.

Ethernet 2 IP Address IP address to use to connect to the GC's wired Ethernet port.

Ethernet 2 Subnet Mask Subnet mask for the IP address of the GC's wired Ethernet
port.

Ethernet 2 Gateway Gateway address for the GC's wired Ethernet port.

4.13 Local Operator Interface variables
Use this window to select and configure up to 25 GC parameters that you would like to
monitor using the LOI’s Display mode.

To set an LOI parameter, do the following:

1. Select LOI Status Variables... from the Application menu.

The LOI Status Variables window appears.

2. Select a variable by clicking on the appropriate drop-down list under the Variable
column.

Note
For a demonstration of how to use the context-sensitive variable selector, see Section 1.11.

3. To copy the stream settings from a highlighted row and apply them to the next row,
click S + Copy.

This feature also increments the Stream value to the next available stream—for
instance, incrementing from Stream 2 to Stream 8, per the GC application.
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4. To copy the component settings from a highlighted row and apply them to the next
row, click C + Copy.

This feature also increments the Component value to the next available
component—incrementing from Ammonia to Benzene, per the GC application.

5. Enter a value in the Precision column to indicate the number of decimal places to
display for this particular variable.

The range of possible Precision values is between 0 and 6.

6. Click OK to save the changes and close the window.

Note
To save the changes without closing the window, click Save.

4.14 Map a FOUNDATION fieldbus variable
To map a GC variable to a FOUNDATION fieldbus process variable (PV), do the following:

1. Take the GC out of service from the host.

2. Open MON2020 and select FFB PV Mappings... from the Application menu.

The FFB PV Mappings window displays.

3. Select a new variable by clicking on the appropriate drop-down list under the
Variable column.

Note
For a demonstration of how to use the context-sensitive variable selector, seeSection 1.11.

Note
The PV Value column displays the current value of the GC variable indicated in the Variable
column.

Note
The PV Status column indicates the state of the data displayed in the PV Value column. If the
data was generated under predictable conditions without any alarms, then the status for all
mapped process variables will be Good; if the data was generated under unpredictable
conditions—that is, if any alerts were triggered during the analysis cycle—then the status for
all mapped process variables will be Bad, because the GC cannot guarantee the results of the
analysis.

4. To copy the stream settings from a highlighted row and apply them to the next row,
click S + Copy.

This feature also increments the Stream value to the next available stream—for
instance, incrementing from Stream 2 to Stream 8, per the GC application.

Application

108



5. To copy the component settings from a highlighted row and apply them to the next
row, click C + Copy.

This feature also increments the Component value to the next available
component—incrementing from Ammonia to Benzene, per the GC application.

6. If necessary, enter a date or time format into the Date/Time Format column.

7. Click OK to save the changes and close the window.

Note
To save the changes without closing the window, click Save.
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5 Logs and reports

The options in the Logs/Reports menu allow you to do the following:

• Keep a maintenance record.

• Keep a parameter record.

• View alarm, system and event logs.

• View and print trend data.

• View the GC Configuration report.

• View relevant drawings and diagrams.

• View archived analysis, calibration and averages reports.

• Configure how and when certain reports are printed.

5.1 Alarms
Use this menu to view and/or clear unacknowledged and active alarms, as well as to view
the Alarm Log.

5.1.1 View unacknowledged and active alarms
To view unacknowledged and active alarms, select Logs/Reports → Alarms → Unack/
Active Alarms.... The Unack/Active Alarms window displays.

Note
Double-clicking on the GC Status Bar from the main window also displays the Unack/Active Alarms
window.

There are three display options for viewing alarms on this window:

• To view both unacknowledged alarms and active alarms, check All Alarms. This is
the default display option.

• To view unacknowledged alarms only, check Unacknowledged Alarms.

• To view active alarms only, check Active Alarms.

The Unack/Active Alarms window supplies the following data for each alarm:

Status Indicates whether the alarm has been acknowledged or not.

State Indicates whether the alarm is ACTIVE or INACTIVE.

Date Indicates the date and time at the GC when the alarm condition began.

Alarm Message Describes the alarm condition.

Type Indicates whether a high limit or low limit alarm was triggered:

• HI means a high limit alarm was triggered.
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• LO means a high limit alarm was triggered.

Limit Indicates the value that was set as the trigger for the alarm.

Value Indicates the current status value being output by the device.

Name Indicates the name of the variable that triggered the alarm.

Note
Discrete alarms do not display Type, Limit, or Value data.

5.1.2 Acknowledge and clear alarms
There are three ways to acknowledge and clear alarms:

• To acknowledge and clear alarms without viewing them, select Logs/Reports →
Alarms → Clear/Ack All Active Alarms.

• Another method to acknowledge and clear alarms without viewing them is to click

 from the Toolbar.

• To view the alarms before acknowledging and clearing them, select Logs/Reports →
Alarms → Unack/Active Alarms... . The Unack/Active Alarms window provides
several options:

- To acknowledge an alarm, select it and then click Ack Selected (F2).

Note
An alarm will continue to display as an active alarm until that value is no longer in the
alarm state.

- To acknowledge all the alarms displayed on the window, click Ack All (F3).

- To acknowledge all the alarms displayed on the window and then remove them
from the table, click Clear/Ack All (F4).

Note
If an alarm is cleared before the condition has been resolved, MON2020 redisplays the
alarm entry as an active alarm.

5.1.3 View the alarm log
The Alarm Log records every alarm triggered from the GC. The Alarm Log window gives you
the option of viewing the total list of alarms, or a date-filtered list.

To view the Alarm Log, select Logs/Reports → Alarms → Alarm Log.... The Alarm Log
window displays.

The Alarm Log window supplies the following data for each alarm:

Date Time Indicates the date and time at the GC when the alarm condition began.
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Alarm
Message

Describes the alarm condition.

State Indicates whether the alarm is SET (active) or CLR (inactive).

Type If applicable, indicates whether a high limit or low limit alarm was
triggered:

• High means a high limit alarm was triggered.

• Low means a high limit alarm was triggered.

Limit If applicable, indicates the value that was set as the trigger for the
alarm.

Value If applicable, indicates the current status value being output by the
device.

Unit If applicable, unit of measurement for the displayed values.

Name Indicates the name of the variable that triggered the alarm.

User Indicates which user made the change.

Note
Discrete alarms do not display Type, Limit, or Value data.

To view a list of alarms, do the following:

1. To view all alarms, select the All checkbox. Otherwise, select the Select Range
checkbox and use the Start Date and End Date drop-down boxes to select a date
range.

2. Click Read Records.

The list of alarms display with the most recent alarm at the top and the oldest alarm
at the bottom. The alarms are also sorted and color-coded by time so that alarms
that occurred simultaneously are grouped together.

3. Click Save to save the list.

The list can be saved in the following formats:

• Tab-Delimited (.txt)

• Comma-Delimited (.csv)

• Microsoft Excel (.xls)

• HTML File (.html)

• XML File (.xml)

4. Click Close to close the window.

5.2 The maintenance log
Use this function to manually record and track maintenance activities performed on a
given GC unit.

Logs and reports

5
Lo

g
s 

an
d

 r
ep

o
rt

s

113



To view the maintenance log, select Maintenance Log... from the Log/Reports menu.

5.2.1 Add an Entry to the Maintenance Log
To add an entry to the maintenance log, do the following:

1. Select Maintenance Log... from the Log/Reports menu.

The Maintenance Log window displays.

2. Click Insert At Top.

A new row appears on the maintenance log table. The Date field contains the GC’s
current date and time, and is editable.

3. Double-click the Message cell and enter the relevant information for the log entry.

Note
To edit an old log entry, click on it and the cell will become editable.

4. Click OK to save the changes and close the window.

Note
To save the changes and keep the window open, click Save.

5.2.2 Delete an entry from the maintenance log
To delete an entry from the maintenance log, do the following:

1. Select Maintenance Log... from the Log/Reports menu.

The Maintenance Log window displays.

2. Select the entry that you want to delete.

3. Click Delete.

The entry is removed from the maintenance log.

4. Click OK to save the changes and close the window, .

Note
To save the changes and keep the window open, click Save.

5.3 The parameter list
Use this feature to keep a record of the hardware components and associated parameters
for a given GC.
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The Parameter List is a Microsoft® Excel document that can be viewed and edited from
MON2020. Before attempting to edit the document, be sure to review it first to get an idea
of what sorts of data it contains.

The Parameter List may contain one or all of the following pages:

• Cover Sheet

• TE Rework

• pp Data

• Programming

• Strm Data

• Col Data

• Cal Std Data

5.3.1 View and edit the parameter list
To view and edit the Parameter List, do the following:

1. Select Parameter List... from the Logs/Reports menu.

The Parameter List window displays.

2. Make your changes to the Parameter List.

3. Click OK to save the changes and close the window.

Note
To save the changes and keep the window open, click Save.

5.3.2 Import the Parameter List
The Parameter List is a Microsoft® Excel document and is therefore saved with the .xls
extension.

To import a Parameter List, do the following:

1. Select Parameter List... from the Logs/Reports menu.

The Parameter List window displays.

2. Click Import....

The Open dialog displays.

3. Locate and select the Parameter List that you want to import.

4. Click Open and the document will be imported and displayed in the Parameter List
window.

5. Click OK to save the changes and close the window.

This version of the Parameter List will now be displayed by default.
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Note
To save the changes and keep the window open, click Save.

5.4 Drawings and documents
Use this feature to access GC-related drawings and documents such as flow diagrams, the
GC's sales order, assembly drawings, and electrical diagrams. These items can be stored on
the GC in the following formats:

• PDF

• TIFF

• GC Trend file (.xtrd)

• XA CGM file (.xcgm)

• XA Comparison file (.xcpm)

• GC Configuration file (.xcfg)

To find out which documents are available on the GC, select Drawings/Documents...
from the Logs/Reports menu. The Drawings/Documents window displays. If the list of
available documents does not display under Drawings/Documents label, click the “+”
beside the label.

Note
If no list displays under the Drawings/Documents label, and there is no “+” beside the label, then this
GC does not contain any documents.

5.4.1 View drawings or documents
To view a drawing, do the following:

1. Select Drawings/Documents... from the Logs/Reports menu.

The Drawings/Documents window displays.

2. Select the drawing to view from the drop-down list.

Note
If no list displays under the Drawings/Documents label, and there is no “+” beside the label,
then this GC does not contain any documents.

3. Click File Viewer (F3).

The drawing displays.

4. Click Close to exit the window and to return to the Drawings/Documents window.
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5.4.2 Add files to the GC
To add files, such as new or updated drawings, to the GC, do the following:

1. Select Drawings/Documents... from the Logs/Reports menu.

The Drawings/Documents window displays.

2. Click Add File(s) to GC.

The Open dialog displays.

3. Locate and select the file to add to the GC.

4. Click Open.

The file will be saved to the GC and the Drawings/Documents list will be updated.

5.4.3 Delete files from the GC
To delete drawings from the GC, do the following:

1. Select Drawings/Documents... from the Logs/Reports menu.

The Drawings/Documents window displays.

2. Select the file to delete from the GC.

3. Click Delete File from GC.

The Confirm message displays.

4. Click Yes.

The file will be deleted from the GC and the Drawings/Documents list will be updated.

5.5 The event log
Use this function to track the changes that are made to the various tables within the GC.

To view the Event Log, select Logs/Reports → Event Log.... The Event Log window displays.

The Event Log window gives you the option of viewing the total list of change events, or a
date-filtered list of events. The Event Log window supplies the following data for each
event:

User ID Indicates which user made the change.

Date Indicates the date at the GC when the event occurred.

Time Indicates the time at the GC when the event occurred.

Event Message Provides a description of the event.

Old Value If applicable, indicates the value in the cell before the change.
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New Value If applicable, indicates the value in the cell after change.

To view the list of change events, do the following:

1. To view all events, select the All checkbox. Otherwise, select the Select Range
checkbox and use the Start Date and End Date drop-down boxes to select a date
range.

2. Click Read Records.

The list of events display with the most recent event at the top and the oldest event
at the bottom. The events are also sorted and color-coded by time so that events
that occurred simultaneously are grouped together.

3. To save the list, click Save.

The list can be saved in the following formats:

• Tab-Delimited (.txt)

• Comma-Delimited (.csv)

• Microsoft Excel (.xls)

• HTML File (.html)

• XML File (.xml)

5.6 Reports
This function allows you to immediately display, print, or store pre-configured reports of
GC analysis data. Data is reported in real-time from the GC or from saved files.

5.6.1 Report types
MON2020 can generate the following types of reports:

Analysis Displays a list of the components that were detected, based on raw
data. Displays a list of calculations for each component, based on the
table located at Application → Calculations → Control.... See 
Section 4.5.1 for more information.
There are two types of analysis reports: Analysis (GPA) and Analysis (ISO).
See Figure 5-1 for an example Analysis (GPA) report. See Figure 5-2 for an
example Analysis (ISO) report.

Calibration Displays a list of the components that were detected, along with each
component’s calibration concentration, raw data value, new response
factor, and new retention time. See Figure 5-3 for an example report.

Final
Calibration

The Final Calibration report displays the list of components along with
each component’s old and new response factors, and each
component’s old and new retention times, based on the averaged data.
See Figure 5-4 for an example report.
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Validation For the most recent validation cycle, displays the Nominal Value,
Allowed Percent Deviation, and the Measured Value of each variable in
the Validation Data table. See Figure 5-5 for an example report.

Note
If the actual deviation is beyond the allowed amount, then the row will be
flagged with an asterisk (*).

Final
Validation

For the most recent validation run, shows the Nominal Value, Allowed
Percent Deviation, and the Average Value of each variable in the
Validation Data table. See Figure 5-6 for an example report.

Note
If the actual deviation is beyond the allowed amount, then the row will be
flagged with an asterisk (*).

Raw Data Displays a list of data for each peak that was detected during the run,
including the retention time, peak area, and peak height. See Figure 5-7
for an example report.

Every Run Displays a configurable list of calculations after each run. See 
Section 4.5.2 for more information.

Hourly Displays a configurable list of average calculations each hour, beginning
at the time set in the Average Calculations window at Application →
Calculations → Averages... . See Section 4.5.2 for more information.

24 Hour Displays a configurable list of average calculations each day, beginning
at the time set in the Average Calculations window at Application →
Calculations → Averages... . See Section 4.5.2 for more information.

Weekly Displays a configurable list of average calculations each week, beginning
on the day set in the Average Calculations window at Application →
Calculations → Averages... . See Section 4.5.2 for more information.

Monthly Displays a configurable list of average calculations each month,
beginning on the day of the month set in the Average Calculations
window at Application → Calculations → Averages... . See Section 4.5.2
for more information.

Variable Displays a configurable list of average calculations every hour at the
time entered in the Hours column in the Average Calculations window at
Application → Calculations → Averages... . See Section 4.5.2 for more
information.

Auto Valve
Timing

Displays a Auto valve Timing report.

Module
Validation

Displays a Module Validation report.

Each report begins with the following header information:

Date-Time The GC’s date and time when the report was generated.
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Analysis Time The duration, in seconds, of the analysis. Can be configured at
Application → Timed Events.... See Section 4.3.4 for more
information.

Cycle Time The duration, in seconds, between two consecutive analyses. Can be
configured at Application → Timed Events.... See Section 4.3.4 for
more information.

Stream The stream that was analyzed. Selected as part of the report
generation process. See Section 5.6.3 for more information.

Mode Displays the operational status of the detector.

Cycle Start Time The date and time that the cycle started.

Analyzer Name of the GC that generated the data used for the report.

Stream
Sequence

The identification and order of the streams that were analyzed. Can
be configured at Applications → Stream Sequence.... See 
Section 4.10 for more information.
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Analysis (GPA) sample reportFigure 5-1:   
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Analysis (ISO) sample reportFigure 5-2:   
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Calibration sample reportFigure 5-3:   
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Final Calibration sample reportFigure 5-4:   
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Validation sample reportFigure 5-5:   
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Final Validation sample reportFigure 5-6:   
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Raw Data sample reportFigure 5-7:   

5.6.2 View reports from live data
To view a report created from the most recent data, do the following:

1. Select Report Displays... from the Log/Reports menu.

The Report Display window appears.
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Note
By default, the Update automatically checkbox is selected. This means that when viewing a
report based on the most recent data, the report will refresh as new data is created, based on
the type of report that you select. For example, in the Report Display window, if you select
Analysis (GPA), the report display will refresh each time the GC finishes an analysis of the
selected stream. The refresh function displays the newly generated report and deletes the
previous report (unless already saved to disk).

2. Select the type of report to generate and display.

For explanations of each report type, see Section 5.6.1.

3. Select the appropriate stream.

4. Click Start (F2).

The report is generated and displayed.

Note
If the report doesn’t appear right away, check the status of the report generation process in
the status bar, which is below the row of buttons on the report window.

Note
To change the font size, click Font +/-. There are five preset font sizes available. Continue to
click Font +/- to cycle through the sizes until you are satisfied with the report’s readability.

5. To save the file, click Save.

The report can be saved in the following file formats: TXT, HTM, HTML, and MHT.

5.6.3 View a saved report
To view a saved report, do the following:

1. Select Report Displays... from the Log/Reports menu.

The Report Display window appears.

2. Click File Viewer (F3).

The Report file viewer window displays.

3. Click Open.

The Open dialog displays.

4. Locate and select the report that you want to view.

Reports may be found in the following file formats: TXT, RPT, HTM, HTML, and MHT.

5. Click Open.

The report displays.
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Note
To change the font size, click Font +/-. There are five preset font sizes available. Continue to
click Font +/- to cycle through the sizes until you are satisfied with the report’s readability.

Note
To print the report, click Print.

5.7 Generate reports from archived data
Use the Archive Report commands to generate analysis, calibration, and average reports
from archived GC runs.

5.7.1 Generate analysis and calibration reports from archived
data
To generate and view an analysis or calibration report from archived data, do the
following:

1. Select Logs/Reports → Archive Report → Analysis/Calibration/Validation....

The Analysis/Calibration/Validation Archive Report window displays.

2. Select a report type from the Report drop-down list.

For an explanation of each report type, see Section 5.6.1.

3. Select a stream from the Stream drop-down list.

By default, the Archive Records table displays all records for the selected report type
and stream.

Note
To date-filter the list of records, select the Time Period checkbox and use the Start Date and
End Date drop-down boxes to select a date range.

4. Select the record(s) that you want to view.

To select several records, hold down CTRL and select each record. To select several
records in a row, select the first record and then hold down SHIFT and select the last
record in the series.

5. Click Start (F2).

The report displays. If more than one record was selected, each report displays after
that previous report on the same page.

Note
To change the font size, click Font +/-. There are five preset font sizes available. Continue to
click Font +/- to cycle through the sizes until you are satisfied with the report’s readability.
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Note
To print the report, click Print.

6. To save the file, click Save.

The report can be saved in the following file formats: TXT, HTM, HTML, and MHT.

5.7.2 Generate an Average report from archived data
To generate and view an average report from archived data, do the following:

1. Select Logs/Reports → Archive Report → Average....

The Average Archive Report window displays.

2. Select a report type from the Report drop-down list.

For an explanation of each report type, see Section 5.6.1.

3. Select a stream from the Stream drop-down list.

By default, the List of Averages table displays all records for the selected report type
and stream.

Note
To date-filter the list of records, select the Time Period checkbox and use the Start Date and
End Date drop-down boxes to select a date range.

4. Select the record(s) that you want to view.

To select several records, hold down CTRL and select each record. To select several
records in a row, select the first record and then hold down SHIFT and select the last
record in the series.

5. 6. Click Start (F2).

The report displays. If more than one record was selected, each report displays after
that previous report on the same page.

Note
To change the font size, click Font+/-. There are five preset font sizes available. Continue to
click Font +/- to cycle through the sizes until you are satisfied with the report’s readability.

Note
To print the report, click Print.

6. To save the file, click Save.

The report can be saved in the following file formats: TXT, HTM, HTML, and MHT.
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5.7.3 Schedule the generation of reports
MON2020 can automatically generate and print each report according to the following
schedule:

Analysis (GPA) An analysis report will print after an analysis run is completed.

Note
If ISO is set in the Calculations Configuration screen, Analysis (ISO) will be listed
under the Report Name column instead of Analysis (GPA); if GPA & ISO is set in
the Calculations Configuration screen, the both Analysis (ISO) and Analysis
(GPA) will be listed under the Report Name column.

Calibration A calibration report will print after a calibration run is completed.

Final Calibration A final calibration report will print after a final calibration run is
completed.

Validation A validation report will print after a validation run is completed.

Final Validation A final validation report will print after a final validation run is
completed.

Every Run A report will be generated each time an Every Run average calculation
is run.

Hourly A report will be generated each time an Hourly average calculation is
run.

24 Hour A report will be generated each time a 24 Hour average calculation is
run.

Weekly A report will be generated each time a Weekly average calculation is
run.

Monthly A report will be generated each time a Monthly average calculation is
run.

Variable A report will be generated each time a Variable average calculation is
run.

Raw Data Each time raw data is generated, a report will be printed.

To configure MON2020 to generate and print a report of your choosing based on that
report’s schedule of availability, do the following:

1. Select Printer Control... from the Logs/Reports menu.

The Printer Control window displays.

Note
MON2020 must be connected to the GC for the report to be printed.

2. To print a report after a run, check the appropriate checkbox from the Print After
Completion? column.

3. To print a report at a fixed interval, check the appropriate checkbox from the Print At
Fixed Interval? column.
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a. Enter a start time in the Start Time column.

b. Enter an interval, in hours, in the Interval column.

4. Use the columns numbered 1 through 20 to select the streams that you want to use
for data collection.

5. Click OK to save the changes and close the window.

Note
To save the changes without closing the window, click Save.

5.8 Trend data
This function allows you to view, print, or save graphical representations, or trend lines, of
accumulated analysis data from the GC.

5.8.1 View live trend data

Note
You cannot view a live trend if the corresponding analysis record does not exist in the GC’s memory.

To view live trend data, do the following:

1. Select Trend Data... from the Logs/Reports menu.

The Trend Data window displays.

2. Click Trend.

The Select records for Trending window displays.

3. Select the analysis or calibration records that you want to trend from the Select
Analysis/Calibration Records selection menu. Click > to move your selection to the
Selected Records queue.

4. If applicable, select the type of average record that you want to trend from the
Select Average Records section. Click > to move your selection to the Selected
Records queue.

Note
To remove a selection from the Selected Records queue, click Remove. To remove all
selections from the Selected Records queue, click Remove All.

5. Click the All Records checkbox from the Trend Record Selection section to use all
data for the trend report, or click the Time Period checkbox and select a Start Date
and End Date for the data to be used.

6. Click Trend.
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MON2020 reads the data from the GC and then closes the Select records for Trending
window and plots the trend data on the graph section of the Trend Data window.

Each trend record is color-coded; use the Trend pull-down menu to select a specific
trend record.

5.8.2 View saved trend data
Trend data files are saved with the XTRD file extension. To view a saved trend file, do the
following:

1. Select Trend Data... from the Logs/Reports menu.

The Trend Data window displays.

2. Click PC File.

The Open Trend File window displays.

3. Select the file that you want to view and click Open.

The trend graph displays.

5.9 Trend Graph options
Right-clicking with the mouse on the graph brings up the following commands and
keyboard shortcuts:

Zoom In Numpad Shortcut: “+”
Zooms in on the entire graph.

Note
Another way to zoom in is by clicking and dragging your mouse to select
the region of the graph that you want to zoom in on.

Zoom Out Numpad Shortcut: “-”
Zooms out from the entire graph.

Zoom X In Numpad Shortcut: “6”
Zooms in on the X axis.

Zoom X Out Numpad Shortcut: “4”
Zooms out from the X axis.

Zoom Y In Numpad Shortcut: “8”
Zooms in on the Y axis.

Zoom Y Out Numpad Shortcut: “2”
Zooms out from the Y axis.
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Note
When the Selected Data checkbox is selected, the small table to the right
of the graph displays the trend data for the visible area of the graph when
zooming in and out.

Save State Shortcut: CTRL + HOME
Saves current or archived display settings for the selected trend
graph.

Note
The Save State function is available only when viewing a live or archived
trend graph.

Restore State Shortcut: HOME
Restores the last saved display settings for the selected trend graph.

Note
Pressing HOME returns the user to the saved state.

Toggle Full
Screen

Shortcut: F11
Maximizes the display of the graph in the Trend Data window.

Cursor to Nearest
Point

Shortcut: F8
Snaps the cursor to the nearest point on the trend graph in both the
X and Y directions.

Toggle Coarse/
Fine Cursor

Shortcut: F4
Toggles the cursor from coarse and less accurate to fine and more
accurate.

Toggle Lines/Dots
Displays

Shortcut: F9
Toggles the trend graph from lines to dots, or dots to lines.

Toggle Mouse
Position Tip

Shortcut: CTRL + F4
The graph’s cursor follows the movement of the mouse while a
hovering Tooltip displays the exact coordinates of the current point.

Toggle Nearest
Position Tip

Shortcut: CTRL + F9
The graph’s cursor follows the movement of the mouse cursor.

Print Shortcut: CTRL + P
Prints the trend graph.

Copy to clipboard Shortcut: CTRL + C
Copies from the graph the raw detector data that was used to plot
the selected trend graph. This data can be pasted into another
application such as Microsoft Word® or Microsoft Excel®.

Paste from
clipboard

Shortcut: CTRL + V
Plots a range of points copied from another application such as
Microsoft Word® or Microsoft Excel®.
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5.10 Properties of the trend graph

5.10.1 The trend graph bar
Use the graph bar buttons to change the display parameters of the graph.

The graphFigure 5-8:   

Click Edit to view or change the display properties of the X and Y axes. The Edit Graph
window displays.

The following list defines the parameters that can be edited:

Point Sets the X-axis values to points. For the purposes of this graph, each sample run
is considered a data point. Therefore, if 2500 sample runs were used to generate
the trend graph, then there are 2500 data points.

• X Min - Sets the minimum value for the X axis to the point number of the
first sample you want to use in the plot. Default value is 0.
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• X Max - Sets the maximum value for the X axis to the point number of the
last sample you want to use in the plot. Default value is N - 1, where N is
the total number of points in the graph. Therefore, if there are 2500
points, then the X Max would be 2499.

Note
The X-axis value for the first sample, or point, in the trend graph is 0, not 1. The X-axis
value for the final point in the trend graph is N - 1, where N is the total number of points in
the graph.

Date
Time

Sets the X-axis values to the particular GC dates and times of each sample runs.

• From - Sets the minimum value for the X axis to the date of the first
sample you want to use in the plot.

• To - Sets the maximum value for the X axis to the date of the last sample
you want to use in the plot.

• Date Format - Options are MM-DD-YYYY or DD-MM-YYYY.

The primary Y axis, which is on the left side of the graph, is the default axis for displaying
trend graphs. The secondary Y axis, which is on the right side of the graph, can be used to
display a second graph whose minimum and maximum values are different than the
minimum and maximum values of the first graph.

Note
If three or more graphs are displayed, only the second graph will be plotted using the secondary Y
axis; all other graphs will be plotted with the primary Y axis.

Y axis Display
Format

• Percent - Sets the Y-axis values to a percentage of the Y Max
value.

• Value - Sets the Y-axis values to the sample run values.

The default value is 0.

Y Min Sets the minimum value for the Y axis.

Y Max Sets the maximum value for the Y axis.

Y Intervals Sets the number of intervals to be displayed on the graph for the Y
axis.

Print Speed Sets the number of inches per second for the x-axis while printing a
chromatogram, similar to an XY plotter.

X Intervals Sets the number of intervals to be displayed on the graph for the X
axis.
The default value is 10.

Display Option Determines whether the chromatograph is displayed as a solid line or
as a dotted line.
The default value is Lines.

Show labels Determines whether each axis is labeled.
The default value is Checked.
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Scroll newest X Determined whether the graph’s window moves to focus on the most
recent data point along the X-axis.
The default value is Checked.

To accept your changes, click OK.

Click Cursor to toggle the cursor size from coarse movement (less accurate) to fine
movement (more accurate).

Click Print to print the graph window.

5.11 The Trend bar
The Trend bar contains a row of buttons that allows you to manipulate a single trend trace.
Below the row of buttons is the trace pull-down menu, which contains a list of all of the
currently displayed traces that make up the trend graph. Before you can work with a trend
trace you must first select it from the pull-down menu.

5.11.1 Edit a trend graph
You can use the Edit window to change the X and Y offset values for a graph, change its
color, and also set which Y axis should be used when plotting it. These changes may be
necessary to make the trend more distinguishable from those that surround it, or to
position a graph in relation to a different graph for comparison.

To edit a trend trace, do the following:

1. From the Trend pull-down menu, select the graph that you want to edit.

2. Click Edit.

The Edit Trend dialog displays.

X Offset Enter a positive number to move the trend to the right, or a
negative number to move the trend to the left.

Y Offset Enter a positive number to move the trend up, or a negative
number to move the trend down.

Color Assigns a color to the trend.

Add Trace to Sets which Y axis should be used when plotting the graph. See 
Section 5.10.1 for more information.

3. Click OK to accept your changes.

5.11.2 Enter a description for a trend graph
To add or change description text for a trend graph, do the following:

1. From the Trend bar, click Desc.

The Edit Description window displays.
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2. Type or edit a description and then close the window.

5.11.3 Save a trend
To save a trend, do the following:

1. From the Trend pull-down menu, select the trace that you want to save.

2. Click Save.

The Save Trend File window displays.

Note
To save all currently displayed trend traces into one file, click Save All.

Note
For convenience the file is given an auto-generated file name that includes the current date
and time; however, you can give the file any name that you choose.

3. Click Save.

5.11.4 View associated trend data
For each data point in a trend graph, it may be possible to view the associated report or
chromatograph.

Note
The associate report will most likely exist, but the existence of the associated chromatogram
depends on the age of the trend. If the trend is more than a few days old it is likely that its associated
chromatogram has been deleted to make space for newer chromatograms.

1. Move the cursor to the desired trend point on the graph.

2. To view the associate report, click Archive Report.

If the report exists, it will be displayed. If the report does not exist, the Archive records
information is not available!! error message displays.

3. To view the associate chromatogram, click Archive Chromatogram.

If the chromatogram exists, it will be displayed. If the it does not exist, the Archive
chromatogram information is not available!! error message displays.

5.11.5 Remove a trend graph from view
To remove a trend graph from the graph display, do the following:

1. From the Trend pull-down menu, select the graph that you want to remove.

2. Click Remove.
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5.11.6 Refresh a trend graph
1. From the Trend pull-down menu, select the trace that you want to refresh.

2. Click Refresh.

The trend graph will be updated with any new data that was compiled since the
most recent refresh.

5.11.7 Display trend data
The data used to plot the trend graphs displays in the table to the right of the graph display
area.

The trend data table contains the following columns:

TRD Indicates the identification number of the trend graph. Useful if more than one
trend is being displayed. The first trend that is displayed is #1, and so on.

Pt # For the purposes of trend graphs, each sample run is considered a data point.
Therefore, if 2500 sample runs were used to generate the trend graph, then
there are 2500 data points.

Note
The first sample, or point, is counted as 0, not 1. The final point is counted as N - 1, where
N is the total number of points in the graph.

Value The data point’s value.

Data The GC’s date when the sample was run and the value was calculated.

Time The GC’s time when the sample was run and the value was calculated.

To view all trend data, click Cur/All. To view trend data for the trend graph selected from
the Trend drop-down list, click Cur/All again.

The second trend data table is useful when zooming in to or out of the graph. When the
Selected Data checkbox is selected, this table displays the trend data for the visible area of
the graph. As the example shows, the table indicates that the trend data for five samples
are visible after zooming in to the graph.
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The Trend Data windowFigure 5-9:   

The table contains the following columns:

TRD Indicates the identification number of the trend graph. Useful if more than
one trend is being displayed. The first trend that is displayed is #1, and so on.

Average Indicates the average data point value of the selected samples.

Minimum The lowest data point value of the selected samples.

Maximum The highest data point value of the selected samples.

Samples The number of samples that were selected and that are displayed in the
graph window.

5.12 Generate a repeatability certificate
• The report will be generated as a PDF so if your computer does not have the Adobe

Reader installed, MON2020 will prompt you to install it.

• A Read-only user can generate a Repeatability Certificate Report but can't modify
any of the fields that are used to generate the report. A Regular user or higher can
generate a Repeatability Certificate Report and can modify the fields that are used
to generate the report.

1. Select Repeatability Certificate from the Log/Reports menu.

The Repeatability Certificate window opens.

2. Click Insert After.

A row will be added to the Select Variables table.
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3. Select a variable from the Variable column.

You can select an unlimited number of variables.

Name Description

Plot If selected, a graph will be added to the re-
port.

Description The name that will be used to denote the se-
lected variable on the report.

Limit The maximum allowed variation of the selec-
ted variable. If the variation of the selected
variable is greater than the Limit, the varia-
ble will fail the repeatability test.

Units Unit of measure for the associated Limit val-
ue.

Calculation Method Determines how the Limit will be treated
when calculating the data.

Absolute: The Limit will be subtracted from
the average value to determine the mini-
mum value and the Limit will be added to
the average value to determine the maxi-
mum value.

% of Avg: The Limit will be divide by 100 to
create a percentage value that will be ap-
plied to the average value to calculate the
minimum and maximum values.

Note
To copy a variable and increment the stream by one, select the variable and press S + Copy. For
example, if you select Stream 1_Mole%_Propane and press S + Copy, Stream 2_Mole%_Propane will
be added to the table.

Note
To copy a variable and increment the component by one, based on the list of components in
the component data table, select the variable and press C + Copy. For example, if you select
Stream 1_Mole%_Propane and press C + Copy, Stream 1_Mole%_ iButane will be added to the table.

4. To include all data in the report, select the All Records check box; to include a limited
set of data in the report, select the Time Period check box and then select a Start Date
and an End Date.

5. Use the Test Information fields to track data related to the generation of the certificate.

This information will be displayed on the report beneath a Test Notes heading.

6. Click Create Report (F2).
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The data in the Select Variables table will be saved and the certificate will be
generated and displayed in Acrobat Reader. A table of repeatability values will be
displayed first and then each variable that you selected to be plotted will have its
own graph.

Name Description

Repeat. Limit This value will be taken from the Limit value
that you entered on the Repeatability Certifi-
cate window.

Average Value The average of all the data collected during
the test.

Min Value Based on the Average Value and the Limit,
this is the lowest valid value that can be gen-
erated. If a value lower than this is gener-
ated, the result of the repeatability test for
this variable is FAIL.

Max Value Based on the Average Value and the Limit,
this is the highest valid value that can be
generated. If a value higher than this is gen-
erated, the result of the repeatability test for
this variable is FAIL.

Tested Repeat (+/-)

Std. Dev.

PASS/FAIL The result of the repeatability test for this
variable.

Note
To save the data in the Select Variables table without generating the report, click OK. The next
time you open the Repeatability Certificate window, the table will be populated with the
saved data.

5.13 Generate a GC Configuration report
A GC Configuration report displays the current settings for the GC. This section explains
how to produce a GC Configuration report and provides an example for reference.

To generate a GC Configuration report, do the following:

1. Select GC Config Report... from the Logs/Reports menu.

The GC Config Report window displays.

2. Select the checkbox for each option that you want to include in the report.
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Note
To select all the options, click Select All (F2). To clear all options, click Clear All (F3).

3. Select the type of output you want for the report.

Note
When choosing a Printer option, if you want to use a printer different from the one that you
usually use, deselect the Use default printer checkbox and when the report is ready, the printer
configuration window will display.

Note
When choosing the File option, the Save window will display, allowing you to name the text
file and choose a location in which to save it.

4. Click Start (F4).

MON2020 will generate the customized report and print or save it, according to the
output option you selected.

Note
A GC Configuration report that includes all options can take several minutes to generate and
save. If you press Esc, MON2020 will stop generating the report after the current option is
completed.
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Example: First page from a sample GC Configuration report

5.14 Delete archived data from the gas
chromatograph
To delete archived data and reset the GC memory, do the following:

1. Select Reset Archive Data... from the Logs/Reports menu.
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The Reset Archive Data window displays.

2. Select the types of data that you want to delete.

Note
To select all the options, click Select All. To clear all options, click Deselect All.

3. Click Reset.

MON2020 displays a confirmation dialog.

4. Click Yes.

MON2020 clears the GC’s memory. New archived records will begin accumulating
again as analysis and calibration runs occur.

5.15 The molecular weight vs. response factor
graph
The Molecular Weight Vs. Response Factor window generates a graph according to Appendix
B in GPA 2198-03 Selection, Preparation, Validation, Care and Storage of Natural Gas and
Natural Gas Liquids Reference Standard Blends. This graph can be useful in checking valve
function, and consists of the following information:

• Log (Molecular Weight) vs. Log (Response Factor)plots the values for the selected
calibration.

• A trend line (best fit straight line);

Note
The ideal trend line would be linear.

• R-squared correlation coefficient.

Note
The closer RSq is to 1, the better.

This graph is only available for calibration streams, which can be selected from the Stream
drop-down list. By default, the newest final calibration data is used to generate the graph,
but any archived final calibration file can be used by selecting it from the Final Calibration
Record drop-down list.
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To print the graph, click Print.
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6 Analysis

The options in the Control pull-down menu allow you to manage analysis runs as well as
calibration, validation and baseline runs. Control menu commands also allow you to stop
an analysis run immediately or at the end of the run.

6.1 Auto sequencing
This is the normal mode for an online GC. Use this function to start continuous GC analysis
runs that follow a predefined stream sequence. See Section 4.10 for detailed instructions
on configuring the predefined sequence.

Note
If an analysis run is in progress, it must be stopped before auto sequencing can be started. See 
Section 6.8 for more information.

Note
If auto calibration or auto validation is enabled then they will be performed as part of the auto
sequence.

To initiate auto-sequencing, do the following:

1. There are three ways of initiating auto sequencing:

a. Select Auto Sequence… from the Control menu.

b. Press F2.

c.
Click  on the Toolbar.

The Start Auto Sequence dialog displays.

2. Decide whether to enable purging, then select or unselect the Purge stream for 60
seconds check box as necessary.

Purging allows sample gas to flow through the sample loop for 60 seconds prior to
beginning the first analysis. The checkbox is selected by default.

3. Click OK and auto sequencing starts.

Use the Mode column on the GC Status Bar to monitor the status of the analysis run.

6.2 Analyze a single stream
If an analysis run is in progress, it must be stopped before single stream analysis can be
started. See Section 6.8 for more information.
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Note
If auto calibration or auto validation is enabled then they will be performed as part of the auto
sequence.

To start an analysis run on a single calibration or sample stream, do the following:

1. Select Single Stream… from the Control menu.

The Start Single Stream Analysis dialog displays.

2. Select a stream from the Stream menu.

3. Decide whether to enable purging, then select or unselect the Purge stream for 60
seconds check box as necessary.

Purging allows sample gas to flow through the sample loop for 60 seconds prior to
beginning the first analysis. The checkbox is selected by default.

4. Check the Continuous operation check box to set or disable repetitive analysis. The
checkbox is selected by default.

5. Click OK.

The analysis starts. Use the Mode column on the GC Status Bar to monitor the status
of the analysis run.

6.3 Calibrate the gas chromatograph
Calibration runs are determined by the CDT and Streams settings. See Section 4.2 and 
Section 4.10 for detailed instructions on how to edit these settings.

To calibrate a GC, do the following:

1. Select Calibration… from the Control menu.

The Start Calibration dialog displays.

Note
If the GC is in Auto Sequence mode, calibration will not start until two or more analysis runs
have been completed. This delay is required to complete the current analysis and the analysis
of the stream currently purging through the valve.

2. Select a stream from the Stream menu.

3. Decide whether to enable purging, then select or unselect the Purge stream for 60
seconds check box as necessary.

Purging allows sample gas to flow through the sample loop for 60 seconds prior to
beginning the first analysis. The checkbox is selected by default.

4. Select the desired calibration type.
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• Select Normal to perform a manual calibration in which the component data
table for the selected stream(s) will be updated with calibration data unless the
data is outside the acceptable deviations, as listed on the component data table.
For more information, see Section 4.2.

• Select Forced to perform a manual calibration in which the component data
table for the selected stream(s) will be updated with calibration data even if that
data is outside the acceptable deviations, as listed on the component data table.
For more information, see Section 4.2.

Note
A forced calibration will update the component data table's response factors even if there
are no issues with the analysis; therefore, manually check the results of the calibration
before returning the unit to service.

5. Click OK.

The calibration starts. Use the Mode column on the GC Status Bar to monitor the
status of the operation.

6.4 Validate the gas chromatograph
During a validation run, the GC performs a test analysis to verify that it is working properly.
The test analysis is performed on a gas whose component concentrations are already
known; if the GC’s results deviate significantly from the predetermined data, an alarm is
generated. Validation runs are determined by the validation data table and streams
settings. See Section 4.4 and Section 4.10 for detailed instructions on how to edit these
settings.

To validate the GC, do the following:

1. Select Validation… from the Control menu.

The Start Validation window displays.

Note
If the GC is in Auto Sequence mode, validation will not start until two or more analysis runs
have been completed. This delay is required to complete the current analysis and the analysis
of the stream currently purging through the valve.

2. Decide whether to enable purging, then select or unselect the Purge stream for 60
seconds check box as necessary.

Purging allows sample gas to flow through the sample loop for 60 seconds prior to
beginning the first analysis. The checkbox is selected by default.

3. Click OK.

The validation starts. Use the Mode column on the GC Status Bar to monitor the
status of the operation.
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6.5 Configure the valve timing
The function of valve timing is to switch the analytical flow path after all the peak of a
“lighter” component has left a column, but before the next component comes out. The
first image below shows the valve timing occurring in-between the C6+ and n-Pentane
peaks correctly on a standard 4-minute C6+ application. The second image shows what
happens when the valve timing is too early, and cuts off some of the first peak. The third
image shows what happens when the valve timing is too late and cuts of some of the
second peak. In the last two examples, not all of the component will reach the detector at
the expected time, and therefore will not be measured correctly.

The effect of valve timing on component leaks.Figure 6-1:   

Historically, a technician will monitor the peak areas of the two affected peaks while
making changes to the valve timing, and determine the correct timing using personal
judgement. The intention of the auto valve timing (AVT) process is to automatically make
the adjustments and monitor the peak areas to determine the correct valve timing
automatically, reducing the load on the technician to just selecting when to initiate the
AVT process.

The AVT is a process that runs on the calibration gas stream. The process consists of the
following activities:

• Correctly identify all the component peaks.

• Adjust the timed events based on peak retention times.

• Automatically adjust the valve time.

• Run a calibration cycle after the adjustments have been made.

• Check the range and order of response factors.

1. Select Auto Valve Timing on the Control menu.

The Start Auto Valve Timing window opens.

2. If you are installing a new module, select the Use module default check box; otherwise,
select the Use Current check box.

3. Click OK.

The AVT process will run. When it completes, it will generate and display an Auto
Valve Timing report.

Analysis

150



Auto Valve Timing sample reportFigure 6-2:   

6.6 Auto valve timing alarms

Alarm Name Description Example

Excessive AVT Adjustment If the valve timing adjustment
exceeds the limit set in the con-
figuration dialog this alarm will
be triggered and the retention
times and timed events will be
set back to their pre-adjust-
ment settings. The valve num-
ber(s) that did not find an ideal
time will be reported with the
alarm.

Exc AVT Adj: 2,3

AVT Timed Event Adjustment If an adjustment of a timed
event by the AVT process re-
sults in a timed event being
within 0.5 seconds of another
timed event, this alarm will be
triggered and the retention
times and timed events will be
set back to their pre-adjust-
ment values. The timed event
and the time of the event will
be reported with the alarm.

AVT Timed Evnt Adj: 32sec

AVT Missing Peak If all of the component peaks
can not be found during any of
the calibration gas analysis
runs, this alarm will be trig-
gered and the retention times
and timed events will be set
back to their pre-adjustment
values. The peak that could not
be identified will be reported
with the alarm.

AVT Missing Peak: Nitrogen

6.7 Halt an analysis
To stop the current analysis at the end of its cycle, do the following:

1. There are three ways to halt an analysis run:
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a. Select Halt… from the Control menu.

b. Press F3.

c.
Click  on the Toolbar.

A confirmation message displays.

Confirmation messageFigure 6-3:   

2. Click Yes.

The analysis will stop at the end of the current cycle. Use the Mode column on the GC
Status Bar to monitor the status of the operation. When the analysis has halted, the
Mode value will be “Idle”.

6.8 Stop an analysis
This function forces the system into Idle mode. If Stop Now is performed while an analysis
is in progress, the components may continue to elute from the columns during. No
analysis data will be generated.

Do not perform a Stop Now unless absolutely necessary. Whenever possible, use the Halt
function.

To immediately stop an analysis run, do the following:

1. Select Stop Now… from the Control menu.

A confirmation message displays.

Confirmation messageFigure 6-4:   
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2. Click Yes and the current analysis stops.
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7 Tools

The options in the Tools pull-down menu allow you to do the following:

• Use the Modbus Test program to confirm that data is being accurately relayed from
the gas chromatograph to the PC.

• Manage users.

• Adjust the sensitivity of the LOI keys.

• Install upgrades to the GC.

7.1 The Modbus Test program
Use the Modbus program to poll the GC’s Modbus registers (or registers from another
device) to confirm that data is accurately relayed from the gas chromatograph to the PC.
Then, as necessary, assign data types to the returned data. See Section 7.1.9 for more
information. You can save all settings to a file for future reference.

You can use this program to facilitate software debugging or for special installations. With
this program, you can troubleshoot any device that employs registers including the GC, an
ultrasonic meter, or a flow computer.

Traditionally, Modbus registers are polled by using a data collection system. To facilitate
installation and debugging, the Modbus program emulates a Modbus master.

CAUTION!

Only one Modbus master should be connected to a single serial link at a time.

This section provides detailed instructions for using the Modbus program. Use this
program only if you are familiar with Modbus communication protocol and the operation
of MON2020.

7.1.1 Modbus protocol comparison
The GC and the Modbus test program can accommodate two different Modbus protocols:
SIM_2251 and User_Modbus. Some settings depend on which Modbus protocol is used.

The protocol you need depends, ultimately, on the hardware used for data acquisition
from the GC Modbus register contents.

The following comparison should help clarify the differences between the two protocols as
well as the utility of each.
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Comparing SIM_2251 and User_Modbus ProtocolsTable 7-1:   

SIM_2251 User_Modbus

A modified protocol that allows a floating point
number to be assigned to a single register so
that it can be transmitted over Modbus via 2251
emulation slave type.

Standard Gould protocol that accommodates
PLC Emulation LO-HI or HI-LO word order for 32-
bit values.

The GC uses the LO-HI order.

Most register contents are predefined.

The pre-configured maps conform to the SIM_
2251 register designations that are the de facto
standard for GC communications in custody
transfer applications.

Predefined Boolean (coils)

User-defined Numeric (registers)

Data types are predefined for the following reg-
ister ranges:

1001-2999 discrete, coils

3001-4999 16-bit integers

5001-6999 32-bit integers

7001-8999 IEEE 32-bit floats

Data types are user-defined

When using the Modbus test program, set Regis-
ter Mode to “DANIEL” to view register contents.

When using the Modbus test program, set Regis-
ter Mode to “PLC- LH” or “PLC-HL” to view regis-
ter contents.

It is not necessary to assign scales to registers. It may be necessary to assign scales to registers,
to convert floating point values to whole integer
representations.

7.1.2 Set communication parameters
To determine or reset the communications parameters used by the Modbus program, do
the following:

1. Select Modbus Test... from the Tools menu.

The Modbus Test Program window displays. The current port settings display in the
window’s title bar.

2. Click Port Setup.

The Port Setup window appears.

3. Make the appropriate configuration changes to match the settings for the link you
are trying to test. The following table lists the typical setting for each parameter:

Parameter RTU ASCII

Port COM1 or COM2 COM1 or COM2

Baud Rate 9600 9600
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Parameter RTU ASCII

Data Bits 8 7

Parity None Even

Stop Bits 1 1

Flow Control None None

Read Timeout 500 ms 500 ms

Try 2 2

Register Mode Daniel (SIM_2251) or PLC-LH
(User_Modbus)

Daniel (SIM_2251) or PLC-LH
(User_Modbus)

4. 4. Click OK.

7.1.3 Obtain Modbus Data
To read or write register contents to the GC, or any other device, do the following:

Note
To learn the variable names that are assigned to the Modbus registers before retrieving the data,
generate a GC Config Report and review the Communication section.

1. In the Slave Addr field, type the COM ID of the GC. The Modbus program will accept a
slave address value of 1 to 247.

To use Broadcast Mode, which directs the Modbus program to poll all known
devices, enter 0 in the Slave Addr field. Each device interprets this poll attempt as an
instruction to read and take action; however, a response message may not be
received by the Modbus program.

2. Select the desired read or write option from the Function pull down menu.

Function Code Description Broadcast

1 (Read Coil) Reads one or more coil values.

2 (Read Input Status) Reads one or more input status values.

3 (Read Multiple Regs) Reads one or more register values.

4 (Read Input Regs) Reads one or more input register values.

5 (Set Single Coil) Set (write) one coil value

6 (Set Single Reg) Set (write) one register value

15 (Set Multiple Coils) Set (write) multiple coil values

16 (Set Multiple Regs) Set (write) multiple register values

3. Type the starting register value in the Data Addr field.
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Note
When the register mode is set to SIM_2251, the data type is set automatically by the Modbus
program, based on the specified data address.

4. In the Quantity field, type the number of registers to be retrieved.

The Modbus test program will accept a quantity value of 1 to 2016. The requested
number of registers cannot exceed the amount contained by the selected message
block but you can retrieve a partial block. You cannot cross a message block
boundary.

Also, in Standard Modbus mode each register is 16 bits. Therefore, integers (SHORT)
consist of 1 register while floats (FLOAT) and long integers (LONG) consist of 2
registers.

Note
Boolean registers are not user-defined (for either SIM_2251 or User_Modbus) and primarily
contain alarm flags useful for debugging. To view the contents of Boolean registers, select the
1 (Read Coil) function code.

Numeric registers for User_Modbus can be user-defined. To view the contents of Numeric
registers, select the 3 (Read Regs) function code.

5. Type the desired repeat count, which is the number of times the Modbus program
should read or set the specified registers before ceasing transmission, in the Repeat
field.

The Modbus program will accept a repeat value of 1 to 9999. A value of –1 produces
an infinite polling loop that can be terminated by clicking Stop.

7.1.4 Transmit a single data type
To assign a data type to a group of registers you will read or edit, do the following:

Note
To learn the variable names that are assigned to the Modbus registers before retrieving the data,
generate a GC Config Report and review the Communication section.

1. In the Slave Addr field, type the COM ID of the GC.

The Modbus test program will accept a slave address value of 1 to 247.

To use Broadcast Mode, which directs the Modbus test program to poll all known
devices, enter 0 in the Slave Addr field. Each device interprets this poll attempt as an
instruction to read and take action; however, a response message may not be
received by the Modbus test program.

Note
Changes are applied to the corresponding register value at each device.
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2. Select the desired read or write option from the Function pull down menu.

Function Code Description Broadcast

1 (Read Coil) Reads one or more coil values.

2 (Read Input Status) Reads one or more input status values.

3 (Read Multiple Regs) Reads one or more register values.

4 (Read Input Regs) Reads one or more input register values.

5 (Set Single Coil) Set (write) one coil value

6 (Set Single Reg) Set (write) one register value

15 (Set Multiple Coils) Set (write) multiple coil values

16 (Set Multiple Regs) Set (write) multiple register values

3. Type the starting register value in the Data Addr field.

Note
The data type is set automatically by the Modbus test program, based on the specified data
address.

4. In the Quantity field, type the number of registers to be retrieved.

The Modbus test program will accept a quantity value of 1 to 2016. The requested
number of registers cannot exceed the amount contained by the selected message
block but you can retrieve a partial block. You cannot cross a message block
boundary.

Also, in Standard Modbus mode each register is 16 bits. Therefore, integers (SHORT)
consist of 1 register while floats (FLOAT) and long integers (LONG) consist of 2
registers.

Note
Boolean registers are not user-defined (for either SIM_2251 or User_Modbus) and primarily
contain alarm flags useful for debugging. To view the contents of Boolean registers, select the
1 (Read Coil) function code.

Numeric registers for User_Modbus can be user-defined. To view the contents of Numeric
registers, select the 3 (Read Regs) function code.

5. Type the desired repeat count, which is the number of times the Modbus program
should read or set the specified registers before ceasing transmission, in the Repeat
field.

The Modbus test program will accept a repeat value of 1 to 9999. A value of –1
produces an infinite polling loop that can be terminated by clicking Stop.

6. Select the Use <data type> to decode registers check box.

7. Select a data type from the pull-down menu.
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The following list displays the default data types for each block of SIM_2251
registers:

1000 – 2999 Boolean

3000 – 4999 Integer

5000 – 6900 Long

7000 – 8999 Float

Note
To ensure the best data type assignments, review a GC Config Report.

8. Click Transmit to retrieve the selected registers (i.e., the specified data addresses)
from the GC.

The transmitted/received packet data displays in the Packet Input-Output window.

9. Click Stop to end the transmission of the data and to return to the Modbus
Function Selection options.

7.1.5 Transmit data using a template
Templates are best used when decoding mixed data types because the template contains
data that the Modbus program can use to determine which data type should be assigned
to which register.

To create a new template or to use an existing template, do the following:

Note
To learn the variable names that are assigned to the Modbus registers before retrieving data,
generate a GC Config Report and review the Communication section.

1. In the Slave Addr field, type the COM ID of the GC.

The Modbus program will accept a slave address value of 1 to 247.

To use Broadcast Mode, which directs the Modbus program to poll all known
devices, enter 0 in the Slave Addr field. Each device interprets this poll attempt as an
instruction to read and take action; however, a response message may not be
received by the Modbus program.

Note
Changes are applied to the corresponding register value at each device.

2. Select the desired read or write option from the Function pull down menu.

Function Code Description Broadcast

1 (Read Coil) Reads one or more coil values.

2 (Read Input Status) Reads one or more input status values.
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Function Code Description Broadcast

3 (Read Multiple Regs) Reads one or more register values.

4 (Read Input Regs) Reads one or more input register values.

5 (Set Single Coil) set (write) one coil value

6 (Set Single Reg) set (write) one register value

15 (Set Multiple Coils) set (write) multiple coil values

16 (Set Multiple Regs) set (write) multiple register values

3. Type the starting register value in the Data Addr field.

Note
The data type is set automatically by the Modbus program, based on the specified data
address.

4. In the Quantity field, type the number of registers to be retrieved.

The Modbus program will accept a quantity value of 1 to 2016. The requested
number of registers cannot exceed the amount contained by the selected message
block but you can retrieve a partial block. You cannot cross a message block
boundary.

Also, in Standard Modbus mode each register is 16 bits. Therefore, integers (SHORT)
consist of 1 register while floats (FLOAT) and long integers (LONG) consist of 2
registers.

Note
Boolean registers are not user-defined (for either SIM_2251 or User_Modbus) and primarily
contain alarm flags useful for debugging. To view the contents of Boolean registers, select the
1 (Read Coil) function code.

Numeric registers for User_Modbus can be user-defined. To view the contents of Numeric
registers, select the 3 (Read Regs) function code.

5. Type the desired repeat count, which is the number of times the Modbus program
should read or set the specified registers before ceasing transmission, in the Repeat
field. The Modbus program will accept a repeat value of 1 to 9999. A value of –1
produces an infinite polling loop that can be terminated by clicking Stop.

6. Depending on your intent, select Use template to decode registers or Use template to
decode logs.

The Record No field becomes active.

7. Enter the desired record number in the Record No field.

To verify which record number should be entered, consult the Modbus
specifications for your device.
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The following table describes the relationship between templates and record
numbers:

Data Type Set-
ting

Other Setting(s) Result

Register tem-
plate

• Enter Data Addr val-
ue.

• Enter Record No. val-
ue.

• Enter Quantity value.

Read Quantity fields (i.e., the number of fields
specified by the Quantity setting) from the
specified Record No. of the register (Data
Addr).

Log template Enter Record No. value. Read all fields associated with the Record No.

• Enter Data Addr val-
ue.

• Enter “0” for the Re-
cord No. value.

Read all fields in all records for the specified log
register (Data Addr).

8. Click Edit Template.

The Template File window displays with a new template.

9. To open an existing template file, click Open.

The Select Template Configuration File dialog displays.

10. Locate and select the template file, and then click Open.

Template files are saved with the .cfg extension.

11. To edit the template, select a data type for each desired offset.

12. To change all offsets to the same data type, change the first offset to the desired
data type, and then click Auto Reset.

The data type for the remainder of the offsets switch to the data type of the first
offset.

13. To save the displayed file to disk, click Save As....

The Select Template Configuration File dialog appears. Type in a filename and click
Save.

14. 14. Click OK to apply your selections and return to the main window.

7.1.6 Set the log parameters
The Log Data window allows you to log the polled data to a specified file.

Note
The Log Data function is not necessary to transmit Modbus data. To disable this function, clear the
Enable Logging ‘Data’ Registers and Values check box on the Log Data window.
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To set the log parameters for the Modbus program, do the following:

1. Click Log Data.

The Log Data window displays.

2. Select the Enable Logging ‘Data’ Registers and Values check box to enable data
logging and to activate the Log Data Parameters section.

3. Select a Logging Mode from the pull-down menu.

You have the following options:

• Continuous mode records the polled data continuously until the connection is
terminated or data logging is disabled by clearing the Enable Logging ‘Data’
Registers and Values check box.

• Sampling mode records the polled data based on the time interval that you set
in the Time Interval between consecutive logs text box. Time intervals can be set in
seconds, minutes, or hours.

4. Select a type of logging.

You have the following options:

• Append adds this log to the file specified, preserving previously logged data.

• Reset deletes the previously-logged data and saves only this new log.

5. Click Save As....

The Save As window displays. The file can be saved as a tab-delimited text file or a
Microsoft Excel file. Type in a filename and click Save.

7.1.7 Save Modbus data
To save the data table to a separate file, do the following:

1. Click Save Data.

The Save ‘Data’ Displayed As dialog appears. The file can be saved as a tab-delimited
text file, an HTML file or a Microsoft Excel file.

2. Type in a filename and click Save.

7.1.8 Print Modbus data
To print Modbus data, click Print Data. The standard print dialog displays.

MON2020 prints the report to your previously configured printer. See Section 1.6 for more
information about changing printers.

7.1.9 Assign scale ranges to User_Modbus registers
By assigning scale ranges, floating point data can be converted to integer values. This is an
optional task that applies to applications using the User_Modbus protocol.
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Use the Register command described in Section 4.11.4 to assign scale ranges.

7.2 Communication errors
The Modbus program’s Error Log is maintained in a circular buffer that holds up to 512
entries.

The Modbus program tracks the errors for a given session but does not store them. When
you exit the Modbus program, all errors are cleared.

To view any communication errors that occurred during the data transfer, do the
following:

1. Click Error....

The Error window appears.

Note
Double-click a Description cell to “scroll through” the displayed text.

2. To view all errors that have occurred in this session, click Update.

3. To delete all entries to date, click Clear.

7.3 Users
Utilize the User Administration commands to create or delete users, change passwords,
and to monitor PC-to-GC connections.

Login security is at the gas chromatograph level instead of at the software level. This
means that you have to log in to the gas chromatograph to which you are trying to
connect. This also means that if you create a new user, that user is only valid for the GC to
which you are connected. You cannot connect to any other GC unless you create the same user
on it first.

MON2020 recognizes the following four user types, or roles, each with an increasing level
of access to functionality:

Read-only A read-only user has the lowest level of access and can view data but
cannot make any changes. A read-only user can change his or her
password only.

Regular A regular user has all of the privileges of a read-only user, as well as the
ability to acknowledge and clear alarms. A regular user can also control
the GC through MON2020’s Control menus. A regular user can change
his or her password only and cannot create or delete other users.

Super User A super user has all of the privileges of a regular user, as well as the
ability to manage and control the GC through MON2020’s Application
and Hardware menus. A super user can change his or her password only
and cannot create or delete other users.
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Administrator An administrator has complete access to all of MON2020’s commands
and functions, as well as the ability to manage all other users by creating
or deleting user accounts, and changing passwords.

Note
Each GC ships with one administrator account: emerson. By default, this account does not require a
password, but a password can be added, if desired.

The following table lists in detail the functions and commands that are available to each
user role:

Menu Commands
Admin

User
Super
User

Regular
User

Read-Only
User

File Connection Directory Y Y Y Y

Program Settings Y Y Y Y

Print Setup Y Y Y Y

Chromato-
graph

Connect Y Y Y Y

Disconnect Y Y Y Y

Chromatogram Viewer Y Y Y Y

Chromatogram - Forced
Cal

Y Y N N

GC Time Y Y read-only read-only

Hardware Heaters Y Y read-only read-only

Valves Y Y read-only read-only

Detectors Y Y read-only read-only

Discrete Inputs Y Y read-only read-only

Discrete Outputs Y Y read-only read-only

Analog Inputs Y Y read-only read-only

Analog Outputs Y Y read-only read-only

Installed Hardware read-only read-only read-only read-only

Application System Y Y read-only read-only

Component Data Y Y read-only read-only

Timed Events Y Y read-only read-only

Calculations - Control Y Y read-only read-only

Calculations - Averages Y Y read-only read-only

Calculations - User De-
fined

Y Y read-only read-only

Limit Alarms Y Y read-only read-only

System Alarms Y Y read-only read-only
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Menu Commands
Admin

User
Super
User

Regular
User

Read-Only
User

Streams Y Y read-only read-only

Stream Sequence Y Y read-only read-only

Communication Y Y read-only read-only

Logs/Reports Unack/Active Alarms Y Y Y read-only

Alarm Logs read-only read-only read-only read-only

Ack/Clear Alarms Y Y Y N

Maintenance Log Y Y Y read-only

Event Log read-only read-only read-only read-only

Report Display read-only read-only read-only read-only

Archive Report read-only read-only read-only read-only

Printer Control Y Y Y read-only

Trend Data read-only read-only read-only read-only

Reset Archive Data Y N N N

Control Start Auto Seq Y Y Y N

Start Single Stream Y Y Y N

Halt Y Y Y N

Calibration Y Y Y N

Stop Y Y Y N

Tools User Administration Y N N N

Change User Password Any Own Own Own

7.3.1 Create a user

Note
You must be logged in as an administrator.

To create a user, do the following:

1. Select Tools → Users → User Administration....

The User Administration window appears, displaying a list of current users and their
role levels.

2. To add a user, click Add User.

The Add User window displays.

3. Enter the appropriate information into the text fields.

4. Click OK.
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MON2020 creates the new user and adds it to the User table on the User
Administration window.

7.3.2 Export a list of user profiles
To save a list of users, along with their role levels and passwords, do the following:

1. Select Tools → Users → User Administration....

The User Administration window appears, displaying a list of current users and their
role levels.

2. Click Export File.

The Export User File window displays.

3. Navigate to where you want to save the file, if necessary.

4. Type in a file name or use the pre-generated name provided.

5. Click Save.

7.3.3 Import a list of user profiles
To load a list of users, along with their role levels and passwords, do the following:

1. Select Tools → Users → User Administration....

The User Administration window appears, displaying a list of current users and their
role levels.

2. Click Import File.

The Import User File window displays.

3. Navigate to where the file is located, if necessary.

Note
User files have the .xusr extension.

4. Click on the file to be loaded.

5. Click Open. The users will be added to the User Administration window.

7.3.4 Edit a user profile

Note
You must be logged in as an administrator.

To edit a user’s name, role level, or password, do the following:

1. Select Tools → Users → User Administration....
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The User Administration window appears, displaying a list of current users and their
role levels.

2. Select the user whose role you want to edit and click Edit User.

The Edit User window displays.

3. Change the appropriate information as required.

4. Click OK.

MON2020 makes the requested changes and returns to the User Administration
window.

7.3.5 Remove a user
To remove a user, do the following:

1. Select Tools → Users → User Administration....

The User Administration window appears, displaying a list of current users and their
role levels.

2. Select the user you want to delete and click Remove User.

A confirmation message displays.

3. Click Yes.

MON2020 deletes the user and returns to the User Administration window.

7.3.6 Change a user’s password
A user without administrator-level access can only change his or her own password.

1. Select Tools → Users → Change User Password....

The Change User Password window displays.

2. Enter the appropriate information in the text fields and click OK.

7.3.7 Reset the administrator password
To reset an administrator password, do the following:

1. Start MON2020 and select Users → Reset Administrator User / Password.
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Note
If MON2020 was already started, be sure to disconnect from all GCs before attempting to
reset the administrator password.

The following warning displays:

Password reset warning messageFigure 7-1:   

2. Click Yes.

The Connect to GC window displays.

3. Click the Ethernet button that corresponds to the GC whose password you want to
reset.

MON2020 will connect to the GC and generate a Password Reset Request ID. The
MON2020 - Password Reset window displays.

4. Click Copy to Clipboard and email the Password Reset Request ID to
GC.CSC@emerson.com. You will be sent a Password Reset Key.

5. After you receive the Password Reset Key, return to the Connect to GC window and
again click the Ethernet button that corresponds to the GC whose password you
want to reset.

The Login window displays.

6. Enter the User Name and the Password Reset Key and click OK.

MON2020 will connect to the GC. To change the Password Reset Key, see 
Section 7.3.6.

7.3.8 Find out who is connected to the gas chromatograph
To ascertain which users are connect to the GC, select Tools → Users → Logged on
Users.... The Logged on Users window displays with a list of the users who are currently
logged on to the GC, along with each user’s IP address.

7.4 Upgrade the firmware
This command allows you to download upgrades to the GC’s firmware.
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To upgrade the firmware, do the following:

1. Select Upgrade Firmware... from the Tools menu.

The Upgrade Firmware window displays. The Currently Install Versions section details
the status of the currently-installed applications.

2. Click Open.

The Open File dialog displays.

3. Locate and select the desired .zip file and click Open.

The .zip file’s content information displays in the Upgrade section of the Upgrade
Firmware window. The Information column will alert you to the new files that should
be selected and downloaded to the GC.

Note
If the upgrade file contains a program that is newer than what is currently installed on the GC,
it will automatically be selected to download.

4. Select the check boxes for the files that you want and click Upgrade.

While the files are transferring, you can monitor their status in the Upgrade
Progress section.

Note
If you want to halt the upgrade, click Cancel Upgrade.

When the upgrade completes successfully, a confirmation message displays.

5. Click OK.

MON2020 disconnects from the GC and the GC reboots.

7.5 Cold booting
Cold booting the GC clears all its stored analysis files and logs and resets all the tables to
the default settings. Take this step only after consulting the appropriate Rosemount
Analytical, Inc. personnel. An entry will be made to the event log noting that the unit was
cold booted.

7.6 View diagnostics
MON2020 provides a diagnostics window that displays diagnostic information about the
following software boards’ revision and voltage levels:

• Preamp board
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• Heater/Solenoid board

• Base IO board

This information can be useful when troubleshooting maintenance issues and in deciding if
further action is required.

To view the Diagnostics window, select Diagnostics... from the Tools menu.

7.7 Adjust the sensitivity of the LOI Keys

Note
This feature is not available for the 370XA gas chromatograph.

To adjust the sensitivity of the LOI keys, do the following:

1. Select LOI Key Sensitivity from the Tools menu.

The LOI Key Sensitivity window displays.

2. Adjust the sensitivity for a key by sliding the bar up or down.

Raising the bar increases the sensitivity or the key; lowering the bar decreases the
sensitivity.

Note
To manipulate all of the sliders together, select the Apply same key sensitivity to all keys
check box.

Note
Click Restore Factory Defaults to return the sliders to their original settings.

3. Click OK to save the changes and close the window.

Note
To save the changes without closing the window, click Save.

7.8 Set the I/O card type
To set the card type for a ROC card, do the following:

1. Select I/O Cards... from the Tools menu.

The I/O Cards window displays.

2. Select the card type for the I/O card from the drop-down list.

3. Click OK to save the changes and close the window.
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Note
To save the changes without closing the window, click Save.
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Appendix A
Custom calculations

To create or edit a customized calculation using GC analysis data, do the following:

1. Select Applications → Calculations → User Defined....

The User Defined Calculations window appears, containing a list of all the user-
defined calculations that are available to the GC.

2. Click Insert before to add a row to the User Defined Calculations table.

Note
To delete this--or any--row from the table, click Delete.

3. Double-click the Label cell and enter a name for the calculation you are about to
create.

Note
If you want to enter a short description for the new calculation, double-click the Comment cell
and enter it there.

4. Click Edit.

The Edit User-defined Calculation window appears.
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The Edit User-defined Calculation windowFigure A-1:   

In MON2020, building a calculation is similar to building a simple program. You have
constants and two types of variables available, as well as two calculation-building
commands. You can also add comments that will be ignored by the application but
that can help you explain the logic and structure of the calculation you are
designing.

The following is a description of the design elements of the Edit User-defined
Calculation window:

Calculation
Steps Viewer
(A)

This element displays the line-by-line construction of the
calculation as it is being built. The following commands allow you
to interact with this area:

• Click Clear All to clear the content of the Calculation Steps
Viewer.

• Click Clear Line to clear the content of the selected line.
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Note
If the selected line is an "If-Then" statement, then the entire condition
is cleared. This button is disabled when the cursor is on an "else" or
"endif" condition.

• Click Delete Line to delete the selected line.

Note
If the selected line is the beginning of a conditional statement, then
the entire "If-Then" block will be deleted along with the expressions
that constitute the "If-Then" construct. If the selected line is part of the
conditional "If-Then" construct—that is, the line only has "Else" or "Endif"
in it—then the entire "If-Then" construct will be deleted.

• Click Copy to copy the selected line to the clipboard. You
cannot copy keywords such as “else” or “endif.”

• Click Paste to paste the content of the clipboard into a selected
line. If the line already has a calculation in it, it is cleared before
the content of the clipboard is pasted into it.

Commands
list (B)

A drop-down list with the following three commands:

• Insert Comment - Adds a comment to the calculation. Each
comment is preceded by “//.”

• Insert Condition - Adds an “If-Then” statement to the
calculation.

• Insert Expression - Adds a mathematical expression to the
calculation.

Expression
Editor (C)

This section is the work area where the comment, condition or
expression is built before being added to the Calculation Steps
Viewer. There are four modes of the Expression Editor, depending
upon what action is being performed: No Action mode, Insert
Comment mode, Insert Condition mode, and Insert Expression
mode.
The following commands allow you to interact with the Expression
Editor:

• Click Clear to clear the content of the entire line. The line itself
is not deleted.

• Click Delete Item to delete the currently active token. Each
mathematical function, numeric data, and mathematical
operation is treated as a token. The token to the right of the
current cursor location is treated as the currently active token.

• Click Evaluate Exp to check the validity of the expression. If any
errors are detected in the syntax, then an error will be reported
in the Output window.
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Note
This button is only active when the line being edited is an expression.

• Click Done to evaluate the expression and copy it to the
Calculations Steps Viewer. If there are any errors in the
expression, they are reported in the Output window.

Calculator
(D)

This section contains calculator functions that can be used to build
a mathematical expression. This section can be divided into two
parts:

Calculator functionsFigure A-2:   

• Section 1 - This section contains the following keys:

x^y x to the power of y

SQRT Square Root

abs Absolute Value

sin Sine

cos Cosine

tan Tangent

log10 Logarithm to the base 10

log2 Logarithm to the base 2

ln Logarithm to the base e

and Logical AND

or Logical OR

xor Logical XOR

( Open bracket

) Close bracket
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• Section 2 - This section contains the traditional calculator keys
and can be used with your keyboard’s Numpad, if it has one.

Note
Make sure to engage your keyboard’s Numlock before using the
Numpad.

Constants
and
Variables
Creator (E)

This section contains drop-down menus and buttons that allow
you to create and select constants and variables that can be added
to your mathematical expressions.

• Constants - Allows you to select constants from a drop-down
list.

• Temporary Variables - Allows you to select temporary, user-
created variables from a drop-down list.

• System Variables - Allows you to select system variables.

• Edit Temporary Variables - Allows you to create variables.

• Edit Constants - Allows you to create system-wide constants
that can be used in user-defined calculations.

Output
Display (F)

Displays status information.

5. Use the following procedures to build your calculation:

• Section A.1

• Section A.2

• Section A.3

• Section A.4

• Section A.5

• Section A.6

6. To see the result of the calculation, click Calculate.

The results display in the Output window.

7. To validate the calculation for errors, click Evaluate.

The results of the validation check display in the Output window.

8. To save the calculation and close the Edit User-defined Calculation window, click OK.

You will be returned to the User Defined Calculations window.

9. To save the changes on the User Defined Calculations window and close it, click OK.

Note
To save the changes on the User Defined Calculations window without closing it, click Save.
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A.1 Insert a comment
To add a comment to the calculation, do the following:

1. Click on the Insert drop-down list and select Insert Comment.

A new line will be added to the Calculation Steps Viewer and the Expression Editor
will switch to Edit Comment mode.

2. Enter the comment into the Edit Comment text box and then click Done.

The comment will be added to the Calculation Steps Viewer.

A.2 Insert a conditional statement

An example of a conditional statementFigure A-3:   

The Expression Editor in Edit Condition mode allows you to build a conditional statement:

The Expression Editor in Edit Condition modeFigure A-4:   

Expressions are built using the Expression Editor in Edit Expression mode.

To add a conditional statement, do the following:
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1. Click on the Insert drop-down list and select Insert Condition.

A new line is added to the Calculation Steps Viewer and the Expression Editor
switches to Edit Condition mode.

2. Add an expression.

You can use constants, temporary variables, system variables, and the calculator
functions to build the expression. For information on inserting system variables, see 
Section A.6. For information on creating variables, see Section A.5. For information on
creating constants, see Section A.4.

Edit Expression areaFigure A-5:   

3. Select a relational operator from the drop-down list.

You have the following options:

< Less than

<= Less than or equal

> Greater than

>= Greater than or equal

== Equal

!= Not equal

4. To add a variable or constant to the expression, click the Variable/Constant drop-
down list and select the appropriate item.
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The Variable/Constant drop-down listFigure A-6:   

For information on creating variables, see Section A.5. For information on creating
constants, see Section A.4.

5. Click Done.

MON2020 validates the statement and if there are no errors, it adds it to the
Calculation Steps Viewer.

To complete the conditional statement, use the Expression Editor in Edit Expression mode
to add the necessary mathematical expressions.

A.3 Insert an expression
A mathematical expression has the following structure:

Variable = Regular expression

Edit Expression areaFigure A-7:   

To add an expression to a conditional statement or calculation, do the following:

1. Click on the Insert drop-down list and select Insert Expression.

A new line is added to the Calculation Steps Viewer and the Expression Editor
switches to Edit Expression mode.

2. Select a variable from the Variable drop-down tree view.
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You can select either a temporary variable or you can set the expression you are
building as the final result of your new user-defined calculation. For instance, if the
user-defined calculation you are building is called ‘User Calc 1,’ then you can select
User Calc 1 from the Final Result tree view. For information on creating variables,
see Section A.5.

3. Add a regular expression.

You can use constants, temporary variables, system variables, and the calculator
functions to build the expression. For information on inserting system variables, see 
Section A.6. For information on creating variables, see Section A.5. For information on
creating constants, see Section A.4.

4. Click Done.

MON2020 validates the statement and if there are no errors, it adds it to the
Calculation Steps Viewer.

A.4 Create a constant
To create a constant that you can use in building a calculation, do the following:

1. From the Edit User-defined Calculation window, click Edit Constants.

The Edit Constants window displays, showing all the constants that have been
created so far for the GC.

2. Click Insert before.

A new row will be added to the USER_CALC_CONSTANTS table.

Note
To delete a constant, select it in the USER_CALC_CONSTANTS table and click Delete.

3. Double-click the Label cell and enter a name for the constant.

Note
To edit any cell, double-click it.

4. Double-click the Value cell and enter a value for the constant.

5. Use the Comment cell to store information that is relevant for the constant.

6. Click OK to save the changes and close the window.

Note
To save the changes without closing the window, click Save.
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A.5 Create a temporary variable
To create a temporary variable that you can use in building a calculation, do the following:

1. From the Edit User-defined Calculation window, click Edit Temporary Variables.

The Edit Temporary Variables window displays, showing all the temporary variables
that have been created so far for the user-defined calculation.

2. Click Insert.

A new row will be added to the table.

Note
To delete a variable from this window, select it in the table and click Delete.

3. Double-click the Name cell and enter a name for the variable.

4. Use the Comment cell to store information that is relevant for the variable.

5. Click OK to save the changes and close the window.

To save the changes without closing the window, click Save.

A.6 Insert a system variable
To insert a system variable into the Expression Editor, do the following:

From the Edit User-defined Calculation window, click on the System Variables drop-down
arrow.

For a demonstration of how to use the context-sensitive variable selector, see Section 1.11.

The selected system variable displays in the System Variables drop-down box and in the
Expression Editor.
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The Expression EditorFigure A-8:   

Custom calculations

A
C

u
st

o
m

 c
al

cu
la

ti
o

n
s

183



Custom calculations

184



Custom calculations

185



3-9000-745

Rev F

2014

AMERICAS
Emerson Process Management
Rosemount Analytical Gas Chromatograph Center of Excellence
10241 West Little York, Suite 200
Houston, TX 77040 USA
Toll Free 866 422 3683
T +1 713 396 8880 (North America)
T +1 713 396 8759 (Latin America)
F +1 713 466 8175
gc.csc@emerson.com

EUROPE
Emerson Process Management
Bond Street, Dumyat Business Park
Tullibody FK10 2PB UK
T +44 1259 727220
F +44 1259 727727
sales.gcema@emersonprocess.com

MIDDLE EAST AND AFRICA
Emerson Process Management
Emerson FZE
Jebel Ali Free Zone
Dubai, United Arab Emirates, P.O. Box 17033
T +971 4 811 8100
F +971 4 886 5465
sales.gcema@emersonprocess.com

ASIA-PACIFIC
Emerson Process Management
Asia Pacific Pivate Limited
1 Pandan Crescent
Singapore 128461
Republic of Singapore
T +65 6 777 8211
F +65 6 777 0947
analytical@ap.emersonprocess.com

©2013 Rosemount Analytical, Inc. All rights reserved.

The Emerson logo is a trademark and service mark of Emerson
Electric Co. Rosemount Analytical and Danalyzer are marks of one
of the Emerson Process Management family of companies. All
other marks are the property of their respective owners.


	Home
	NOTICE
	Warranty

	Contents
	Getting started
	MON2000 and MON2020
	Getting started with MON2020
	System requirements
	Install MON2020
	Start MON2020
	Register MON2020
	Set up the data folder
	Set up MON2020 to connect to a gas chromatograph
	Export a GC directory
	Import a GC Directory file
	Launch MON2020 from the SNAP-ON for DeltaV
	Launch MON2020 from the AMS Device Manager
	The MON2020 user interface
	The main user interface
	The GC Status Bar

	Connect to a gas chromatograph
	Disconnect from a gas chromatograph

	Keyboard commands
	Procedures guide
	Configuration files
	Edit a configuration file
	Save the current configuration
	Import a configuration file
	Restore the GC's factory settings

	Configure your printer
	Online help
	Operating modes for MON2020
	The Physical Name column
	Select the GC’s networking protocol
	The context-sensitive variable selector

	Chromatograph
	The Chromatogram Viewer
	Data displayed in the chromatogram window
	Display a live chromatogram
	Display an archived chromatogram
	Protected chromatograms
	Display a saved chromatogram

	Options for displaying chromatograms
	Configure the appearance of the chromatograph
	The Graph bar
	Additional plot commands

	Change how a chromatogram displays
	Edit a chromatogram
	Display chromatogram results
	Save a chromatogram
	Remove a chromatogram from the Chromatogram Viewer
	Initiate a forced calibration
	Chromatogram Viewer tables
	Open a comparison file
	Save a comparison file

	Miscellaneous commands
	The Chromatogram Viewer's Timed Events table
	Launch the Timed Events table from the Chromatogram Viewer
	Edit Timed Events from the Chromatogram Viewer
	Use the Chromatogram Viewer’s cursor to update a Timed Event
	The Chromatogram Viewer's Component Data table
	Edit retention times from the Chromatogram Viewer
	Display raw data from the Chromatogram Viewer

	Set the gas chromatograph’s date and time
	Set daylight savings


	Hardware
	Heater configuration
	Set the temperature of the gas chromatograph’s heaters
	Rename a heater
	Set a heater’s voltage type
	Monitor the temperature of a heater
	Monitor the operational status of a heater
	Set the desired temperature
	Set PWM Output
	Take a heater out of service

	Valve configuration
	Rename a valve
	Set a valve’s operational mode
	Monitor the operational status of a valve
	Invert the polarity of a valve
	Set the usage mode for a valve

	Managing the gas chromatograph's pressure
	Change the carrier pressure set point
	Check the status of the EPC
	Switch to a different EPC mode

	Detectors
	Offset the baseline
	Ignite the FID flame
	Reset the preamp value
	Balance the preamp

	Discrete inputs
	Rename a discrete input
	Set a discrete input’s operational mode
	Monitor the operational status of a discrete input
	Invert the polarity of a discrete input

	Discrete outputs
	Rename a discrete output
	Set a discrete output’s operational mode
	Monitor the operational status of a discrete output
	Set the usage mode for a discrete output

	Manage your gas chromatograph’s analog inputs
	Rename an analog input
	Set an analog input’s operational mode
	Set the scale values for an analog input device
	Set the type of analog input signal
	Monitor the status of an analog input
	Calibrate an analog input

	Analog outputs
	Rename an analog output
	Set an analog output’s operational mode
	Set the scale values for an analog output device
	Map a system variable to an analog output
	Monitor the status of an analog output
	Calibrate an analog output

	The Hardware Inventory List

	Application
	Configure the system
	The Component Data Tables
	Edit a Component Data Table
	Add a component to a Component Data Table
	Remove a component from a Component Data Table
	View the standard values for a component
	Display raw data from the Component Data table
	Change the default C6+ mixture ratio

	The Timed Events tables
	Configure valve events
	Configure integration events
	Configure spectrum gain events
	Set the cycle and analysis time
	Remove an event from the Timed Event Table
	Add an event to the Timed Event Table

	The Validation Data Tables
	Calculations
	Set standard calculations by stream
	Edit average calculations
	View an archive of averages for a given variable
	Copy an average calculation configuration
	Copy component settings

	Set the calculation method to GPA or ISO
	Set alarm limits
	System alarms
	Streams
	Designate how a stream will be used
	Link a valve with a stream
	Assign a data table to a particular stream
	Change the base pressure for a stream

	Create a stream sequence for a detector
	Communications
	Create or edit registers
	Create a MAP file
	Assign a variable to a register
	View or edit scales

	Configure an Ethernet port
	Local Operator Interface variables
	Map a FOUNDATION fieldbus variable

	Logs and reports
	Alarms
	View unacknowledged and active alarms
	Acknowledge and clear alarms
	View the alarm log

	The maintenance log
	Add an Entry to the Maintenance Log
	Delete an entry from the maintenance log

	The parameter list
	View and edit the parameter list
	Import the Parameter List

	Drawings and documents
	View drawings or documents
	Add files to the GC
	Delete files from the GC

	The event log
	Reports
	Report types
	View reports from live data
	View a saved report

	Generate reports from archived data
	Generate analysis and calibration reports from archived data
	Generate an Average report from archived data
	Schedule the generation of reports

	Trend data
	View live trend data
	View saved trend data

	Trend Graph options
	Properties of the trend graph
	The trend graph bar

	The Trend bar
	Edit a trend graph
	Enter a description for a trend graph
	Save a trend
	View associated trend data
	Remove a trend graph from view
	Refresh a trend graph
	Display trend data

	Generate a repeatability certificate
	Generate a GC Configuration report
	Delete archived data from the gas chromatograph
	The molecular weight vs. response factor graph

	Analysis
	Auto sequencing
	Analyze a single stream
	Calibrate the gas chromatograph
	Validate the gas chromatograph
	Configure the valve timing
	Auto valve timing alarms
	Halt an analysis
	Stop an analysis

	Tools
	The Modbus Test program
	Modbus protocol comparison
	Set communication parameters
	Obtain Modbus Data
	Transmit a single data type
	Transmit data using a template
	Set the log parameters
	Save Modbus data
	Print Modbus data
	Assign scale ranges to User_Modbus registers

	Communication errors
	Users
	Create a user
	Export a list of user profiles
	Import a list of user profiles
	Edit a user profile
	Remove a user
	Change a user’s password
	Reset the administrator password
	Find out who is connected to the gas chromatograph

	Upgrade the firmware
	Cold booting
	View diagnostics
	Adjust the sensitivity of the LOI Keys
	Set the I/O card type

	Custom calculations
	Insert a comment
	Insert a conditional statement
	Insert an expression
	Create a constant
	Create a temporary variable
	Insert a system variable


